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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 
 WARNING 

indicates that death or severe personal injury may result if proper precautions are not taken. 
 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 
 NOTICE 

indicates that property damage can result if proper precautions are not taken. 
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Introduction 
Use this chapter as a quick reference. It provides links to the steps required for startup.  

Before you begin, read the following safety information: 

• General safety information (Page 17) 

• Basic safety information: Installing/mounting (Page 23) 

• Basic safety information: Connecting (Page 29) 

• Basic safety information: Commissioning (Page 35) 

Read the entire Operating Instructions to achieve optimum device performance. 

Procedure 
1. Install/mount the device. 

Installation location requirements (Page 24) 

2. Connect the device. 

Connecting SITRANS Probe LU240 (Page 29) 

3. Install (optional) display 

Install a new display (Page 152) 

4. Power up the device. 

Activating SITRANS Probe LU240 (Page 36) 

5. Commission the device via quick commissioning wizard: 

Quick commissioning: Level/Space/Distance/Custom (Page 45) 

Quick commissioning: Volume (Page 50) 

Quick commissioning: Volume flow (Page 55) 

Startup is complete. 
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 Introduction 2 
2.1 Purpose of this documentation 

These instructions contain all information required to commission and use the device. Read 
the instructions carefully prior to installation and commissioning. In order to use the device 
correctly, first review its principle of operation. 

The instructions are aimed at persons mechanically installing the device, connecting it 
electronically, configuring the parameters and commissioning it, as well as service and 
maintenance engineers. 

2.2 Document history 
The following table shows major changes in the documentation compared to the previous 
edition.  
 
Edition Note 
03/2021 Added remote operation information 
10/2020 Updated accuracy specification 
08/2019 3 m version, additional approvals 
10/2018 First edition 

2.3 FW revision history 

Sensor 
 
Firmware revi-
sion 

PDM EDD revision Date Changes 

1.01.02 1.01.00 August 1, 2019 • Trend log functionality 
• 3 m version 

1.00.00 1.00.00 October 1, 2018 • Initial release 

HMI 
 
Firmware revi-
sion 

Date Changes 

1.00.00 October 1, 2018 • Initial release 
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2.4 Designated use 
Use the device to measure process media in accordance with the Technical data (Page 172). 

 

 NOTICE 
Use in a domestic environment 

This Class A Group 1 equipment is intended for use in industrial areas. 

In a domestic environment this device may cause radio interference. 
 

2.5 Product compatibility 
The following table describes compatibility between document edition, device revision, 
engineering system and associated Electronic Device Description (EDD). 

 
Manual 
edition 

Remarks Device revision Compatible version of device integration package 

10/2020 Updated accura-
cy specification 

HART 
FW: 1.01.02 or later 
HW: 1.00.00 or later  
Device revision 1 or later 

SIMATIC PDM V9.1 EDD: 1.01.00 or later 
AMS Device Manager V13.5 EDD: 1.01.00 or later 
SITRANS DTM V4.1 SP4 EDD: 1.01.00 or later 
Field communicator (FC) 375/475 V3.8 EDD: 1.01.00 or later 
SITRANS library EDD: 1.01.00 or later 

mA 
FW: 1.01.02 or later 
HW: 1.00.00 or later  
Device revision 1 or later 

SIMATIC PDM V9.1  
 
 
 
Not applicable 

AMS Device Manager V13.5 
SITRANS DTM V4.1 SP4 
Field communicator (FC) 375/475 V3.8 
SITRANS library 

08/2019 
 

New device 
features 

HART 
FW: 1.01.02 or later 
HW: 1.00.00 or later  
Device revision 1 or later 

SIMATIC PDM V9.1 EDD: 1.01.00 or later 
AMS Device Manager V13.5 EDD: 1.01.00 or later 
SITRANS DTM V4.1 SP4 EDD: 1.01.00 or later 
Field communicator (FC) 375/475 V3.8 EDD: 1.01.00 or later 
SITRANS library EDD: 1.01.00 or later 

mA 
FW: 1.01.02 or later 
HW: 1.00.00 or later  
Device revision 1 or later 

SIMATIC PDM V9.1  
 
 
Not applicable 

AMS Device Manager V13.5 
SITRANS DTM V4.1 SP4 
Field communicator (FC) 375/475 V3.8 
SITRANS library 

10/2018 
 

First edition HART 
FW: 1.00.00 or later 
HW: 1.00.00 or later  
Device revision 1 or later 

SIMATIC PDM V9.1 EDD: 1.00.00 or later 
AMS Device Manager V13.5 EDD: 1.00.00 or later 
SITRANS DTM V4.1 SP4 EDD: 1.00.00 or later 
Field communicator (FC) 375/475 V3.8 EDD: 1.00.00 or later 
SITRANS library EDD: 1.00.00 or later 
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2.6 Items supplied 
 
• SITRANS Probe LU240 ultrasonic level 

transmitter 
 

 

• Display (optional)  

 

• Siemens Process Instrumentation 
documentation disk containing certificates, 
and manuals for ATEX approved devices 

  

 
 

 

 Note 

Scope of delivery may vary, depending on version and add-ons. Make sure the scope of 
delivery and the information on the nameplate correspond to your order and the delivery 
note. 

 

2.7 Checking the consignment 
1. Check the packaging and the delivered items for visible damages. 

2. Report any claims for damages immediately to the shipping company. 

3. Retain damaged parts for clarification. 

4. Check the scope of delivery by comparing your order to the shipping documents for 
correctness and completeness.  

 

 
 WARNING 

Using a damaged or incomplete device 

Risk of explosion in hazardous areas. 
• Do not use damaged or incomplete devices. 

 

2.8 Security information 
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 
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In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions constitute one element of such a concept. 

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the internet if and to the extent such a connection is necessary 
and only when appropriate security measures (e.g. firewalls and/or network segmentation) 
are in place. 

For additional information on industrial security measures that may be implemented, please 
visit  
https://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends that product updates are applied as soon as they are 
available and that the latest product versions are used. Use of product versions that are no 
longer supported, and failure to apply the latest updates may increase customer’s exposure to 
cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under  
https://www.siemens.com/industrialsecurity. 

2.9 Transportation and storage 
To guarantee sufficient protection during transport and storage, observe the following: 

• Keep the original packaging for subsequent transportation. 

• Devices/replacement parts should be returned in their original packaging. 

• If the original packaging is no longer available, ensure that all shipments are properly 
packaged to provide sufficient protection during transport. Siemens cannot assume 
liability for any costs associated with transportation damages. 

 

 
 NOTICE 

Insufficient protection during storage 

The packaging only provides limited protection against moisture and infiltration. 
• Provide additional packaging as necessary. 

 

Special conditions for storage and transportation of the device are listed in Operating 
conditions (Page 175). 
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2.10 Notes on warranty 
The contents of this manual shall not become part of or modify any prior or existing 
agreement, commitment or legal relationship. The sales contract contains all obligations on 
the part of Siemens as well as the complete and solely applicable warranty conditions. Any 
statements regarding device versions described in the manual do not create new warranties 
or modify the existing warranty. 

The content reflects the technical status at the time of publishing. Siemens reserves the right 
to make technical changes in the course of further development. 
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 Safety notes 3 
3.1 Preconditions for use 

This device left the factory in good working condition. In order to maintain this status and to 
ensure safe operation of the device, observe these instructions and all the specifications 
relevant to safety. 

Observe the information and symbols on the device. Do not remove any information or 
symbols from the device. Always keep the information and symbols in a completely legible 
state. 

 

 WARNING 

Improper device modifications  

Risk to personnel, system and environment can result from modifications to the device, 
particularly in hazardous areas. 
• Only carry out modifications that are described in the instructions for the device. Failure 

to observe this requirement cancels the manufacturer's warranty and the product 
approvals. 

 

 
In manual On product Description 

  
WARNING: refer to accompanying documents (manual) for details. 

 

 Dispose of in an environmentally safe manner, and according to local 
regulations. 

3.2 Laws and directives 
Observe the test certification, provisions and laws applicable in your country during 
connection, assembly and operation. These include, for example:  

• National Electrical Code (NEC - NFPA 70) (USA) 

• Canadian Electrical Code (CEC) (Canada) 

Further provisions for hazardous area applications are for example:  

• IEC 60079-14 (international) 

• EN 60079-14 (EU) 

• For Korea only: 
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The CE marking on the device symbolizes the conformity with the following European 
directives: 
 
Electromagnetic compatibil-
ity EMC  
2014/30/EU 

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to elec-
tromagnetic compatibility 

Low voltage directive LVD  
2014/35/EU 

Directive of the European Parliament and of the Council on the 
harmonisation of the laws of the Member States relating to the 
making available on the market of electrical equipment de-
signed for use within certain voltage limits 

Atmosphère explosible ATEX  
2014/34/EU 

Directive of the European Parliament and the Council on the 
harmonisation of the laws of the Member States relating to 
equipment and protective systems intended for use in potential-
ly explosive atmospheres 

2011/65/EU RoHS Directive of the European Parliament and the Council on the 
restriction of the use of certain hazardous substances in electri-
cal and electronic equipment 

The applicable directives can be found in the EU declaration of conformity of the specific 
device. 

3.3 Requirements for special applications 
Due to the large number of possible applications, each detail of the described device versions 
for each possible scenario during commissioning, operation, maintenance or operation in 
systems cannot be considered in the instructions. If you need additional information not 
covered by these instructions, contact your local Siemens office or company representative.  

 

 Note 
Operation under special ambient conditions 

We highly recommend that you contact your Siemens representative or our application 
department before you operate the device under special ambient conditions as can be 
encountered in nuclear power plants or when the device is used for research and 
development purposes. 

 

 

 Note 
Operation under special atmospheric conditions 

Ultrasonic measurement requires that the sound wave travel through the atmosphere in a 
consistent manner.  Applications with atmospheric conditions different from air (including, 
but not limited to, gas layer stratification, very high methane or CO2 concentrations), should 
be properly assessed to ensure safe, reliable use in the event of measurement errors due to 
sound wave velocity changes. 
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3.4 Use in hazardous areas 

Qualified personnel for hazardous area applications 

Persons who install, connect, commission, operate, and service the device in a hazardous 
area must have the following specific qualifications:  

• They are authorized, trained or instructed in operating and maintaining devices and 
systems according to the safety regulations for electrical circuits, high pressures, 
aggressive, and hazardous media. 

• They are authorized, trained, or instructed in carrying out work on electrical circuits for 
hazardous systems. 

• They are trained or instructed in maintenance and use of appropriate safety equipment 
according to the pertinent safety regulations. 

 

 WARNING 
Use in hazardous area 

Risk of explosion. 
• Only use equipment that is approved for use in the intended hazardous area and labeled 

accordingly. 
• Do not use devices that have been operated outside the conditions specified for 

hazardous areas. If you have used the device outside the conditions for hazardous areas, 
make all Ex markings unrecognizable on the nameplate. 

 

 

 WARNING 
Loss of safety of device with type of protection "Intrinsic safety Ex i" 

If the device or its components have already been operated in non-intrinsically safe circuits 
or the electrical specifications have not been observed, the safety of the device is no longer 
ensured for use in hazardous areas. There is a risk of explosion. 
• Connect the device with type of protection "Intrinsic safety" solely to an intrinsically safe 

circuit. 
• Observe the specifications for the electrical data on the certificate and/or in Technical 

data (Page 172). 
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 Description 4 
4.1 Overview SITRANS Probe LU240 

SITRANS Probe LU240 ultrasonic level transmitter with HART, 4 to 20 mA is ideal for level, 
volume, and volume flow measurements. It works with liquids, slurries, and bulk materials up 
to 12 meters (40 feet). 

 

4.2 Features 
The transducer is available as ETFE (ethylene-tetrafluoroethylene) or PVDF (polyvinylidene 
fluoride) to suit the chemical conditions of your application. For applications with varying 
temperatures, the SITRANS Probe LU240 incorporates an internal temperature sensor to 
compensate for temperature changes. 

The self-cleaning face of SITRANS Probe LU240 is resistant to build-up and condensation and 
has field-proven Process Intelligence signal processing. Together, they provide long term, low 
maintenance level, volume, and volume flow measurement in difficult applications.  
 
Features 6 m, 12 m version 3 m version 
HART ✓  
mA ✓ ✓ 
Applications: Level/Space/Distance ✓ ✓ 
Applications: Volume/Volume flow/Custom ✓  
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Features 6 m, 12 m version 3 m version 
Accuracy +/- 6 mm +/- 10 mm 
Remote operation via engineering system, 
such as SIMATIC PDM: 
• View echo profile 
• Trend log 
• Extended diagnostics 
• Limit monitoring (includes over-

run/underrun counters) 

✓  

4.3 Applications 
SITRANS Probe LU240 is designed to measure Level, Volume, or Volume flow in a variety of 
applications: 

Level 

• Storage type vessels 

• Simple process vessels with some surface agitation 

• Liquids 

• Slurries 

• Bulk solids 

• Open channels 

Volume 

Pre-defined vessel shapes can be used to convert level measurements to volume. 

Volume flow  

For an open channel system (such as a Parshall flume, V-notch weir, or other open channel 
device), volume flow can be measured by using integral pre-defined flow structures.  

Custom level to output 

A customized level-to-output linearization function is available to calculate volume or volume 
flow, for vessels not included in the pre-defined shapes as noted above. 

4.4 Approvals 
SITRANS Probe LU240 is available with approvals for General purpose and Intrinsic safety for 
hazardous area installations.  
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In all cases, check the device nameplate and confirm the approval rating. 
 

 Note 
Full list of approvals 

For more information see Approvals (Page 176). 
 

4.5 System configuration 

Typical PLC/mA configuration 

 
① power supply ④ HART modem 
② PLC ⑤ HART communicator 
③ R = 250 Ω   

4.6 HART communication 
Specific device versions (6 m, 12 m) support HART communication protocol. For more 
information, see HART communication (Page 196). 
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 Installing/mounting 5 
5.1 Basic safety notes 
 

 CAUTION 
Hot surfaces resulting from hot process media 

Risk of burns resulting from surface temperatures above 65 °C (149 °F).  
• Take appropriate protective measures, for example contact protection. 
• Make sure that protective measures do not cause the maximum permissible ambient 

temperature to be exceeded. Refer to the information in Technical data (Page 172). 
 

 

 WARNING 
Wetted parts unsuitable for the process media 

Risk of injury or damage to device.  

Hot, toxic and corrosive media could be released if the wetted parts are unsuitable for the 
process medium.  
• Ensure that the material of the device parts wetted by the process medium is suitable for 

the medium. Refer to the information in Technical data (Page 172). 
 

 

 Note 
Material compatibility 

Siemens can provide you with support concerning selection of sensor components wetted by 
process media. However, you are responsible for the selection of components. Siemens 
accepts no liability for faults or failures resulting from incompatible materials. 

 

 

 WARNING 
Unsuitable connecting parts 

Risk of injury or poisoning.  

In case of improper mounting, hot, toxic, and corrosive process media could be released at 
the connections. 
• Ensure that connecting parts (such as flange gaskets and bolts) are suitable for 

connection and process media. 
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 WARNING 
Exceeded maximum permissible operating pressure 

Risk of injury or poisoning. 

The maximum permissible operating pressure depends on the device version, pressure limit 
and temperature rating. The device can be damaged if the operating pressure is exceeded. 
Hot, toxic and corrosive process media could be released. 

Ensure that maximum permissible operating pressure of the device is not exceeded. Refer to 
the information on the nameplate and/or in Technical data (Page 172). 

 

 

 CAUTION 

External stresses and loads 

Damage to device by severe external stresses and loads (e.g. thermal expansion or pipe 
tension). Process media can be released. 
• Prevent severe external stresses and loads from acting on the device. 

 

5.1.1 Installation location requirements 
 

 NOTICE 

Strong vibrations 

Damage to device. 
• In installations with strong vibrations, mount the transmitter in a low vibration 

environment. 
 

 

 NOTICE 
Aggressive atmospheres 

Damage to device through penetration of aggressive vapors. 
• Ensure that the device is suitable for the application. 

 



 Installing/mounting 
 5.1 Basic safety notes 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 25 

 

 NOTICE 
Direct sunlight 

Damage to device. 

The device can overheat or materials become brittle due to UV exposure. 
• Protect the device from direct sunlight. 
• Make sure that the maximum permissible ambient temperature is not exceeded. Refer to 

the information in Technical data (Page 172). 
 

 

 NOTICE 

Mounting location 
• Ideally, mount device so that face of transducer is at least 300 mm (1 ft) above the 

highest anticipated material level. 
 

5.1.1.1 Recommended 
• Ambient temperature within –40 to +80 °C (–40 to +176 °F) 

• Process temperature within –40 to +85 °C (–40 to +185 °F) 

• Environment suitable to the housing rating and materials of construction 

• Sound path perpendicular to the material surface 

• Display and local buttons easily accessible for programming 

• Cable entries easily accessible for wiring 

• Sufficient room to open device lid with clear access 

• Mounting surface free from vibration 

• Place for a laptop computer provided for on-site configuration (optional, as laptop not 
required for configuration) 

 

 NOTICE 

Device rotation 

The device can be rotated separate from the process connection. 
• There is no limit to the number of times device can be rotated without damage. 
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① Customer-supplied flange 
② Ambient temperature surrounding enclosure –40 to +80 °C (–40 to +176 °F)  
③ Device tag (optional) 

5.1.1.2 Avoid 
• Proximity to high voltage or current wiring, high voltage or current contacts, and to 

variable frequency motor speed controllers 

• Exposure to direct sunlight. (Provide a sun shield to avoid direct sunlight.) 

• Interference to sound path from obstructions (such as rough walls, seams, rungs, etc.), or 
from fill path 

 
 ① Pipe 
 ② Rungs 
 ③ Seams 
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5.1.2 Proper mounting 
 

 NOTICE 
Incorrect mounting 

The device can be damaged, destroyed, or its functionality impaired through improper 
mounting. 
• Before installing ensure there is no visible damage to the device. 
• Make sure that process connectors are clean, and suitable gaskets and glands are used. 
• Mount the device using suitable tools. Refer to the information in Technical data 

(Page 172). 
 

5.1.2.1 Process connections 
Process connections are available with three thread types: 

• 2" NPT [(Taper), ASME B1.20.1] 

• R 2" [(BSPT), EN 10226] 

• G 2" [(BSPP), EN ISO 228-1] 

 

 NOTICE 

Process connection type 

The thread type can be found on the device process connection, defined by a letter in the 
mold, near the end of the threads. 

 

 
N=NPT 
B=R2/BSPT 
P=G2/BSPP/PF2 

 

1. Before inserting device into its mounting connection, ensure threads are of the same type to 
avoid damaging them. 

2. Screw device into process connection and hand tighten, or use a strap wrench to seat gasket 
if required (1/4 turn past hand tight is recommended).  
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The process connection should be checked periodically following the initial installation, and 
retightened accordingly. 

5.2 Disassembly 
 

 WARNING 
Incorrect disassembly 

The following risks may result from incorrect disassembly:  

- Injury through electric shock 

- Risk through emerging media when connected to the process 

- Risk of explosion in hazardous area 

In order to disassemble correctly, observe the following: 
• Before starting work, make sure that you have switched off all physical variables such as 

pressure, temperature, electricity etc. or that they have a harmless value. 
• If the device contains hazardous media, it must be emptied prior to disassembly. Make 

sure that no environmentally hazardous media are released. 
• Secure the remaining connections so that no damage can result if the process is started 

unintentionally. 
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 Connecting 6 
6.1 Basic safety notes 
 

 NOTICE 

Condensation in the device 

Damage to device through formation of condensation if the temperature difference 
between transportation or storage and the mounting location exceeds 20 °C (36 °F). 
• Before taking the device into operation, let the device adapt for several hours in the new 

environment. 
 

 

 WARNING 

Connecting device in energized state 

Risk of explosion in hazardous areas. 
• Connect devices in hazardous areas only in a de-energized state. 

 

6.2 Connecting SITRANS Probe LU240 
 

 WARNING 
Incorrect connection to power source 

Risk to personnel, system and environment can result from improper power connection. 
• The DC input terminals shall be supplied from a source providing electrical isolation 

between the input and output, in order to meet the applicable safety requirements of 
IEC 61010-1. For example, SELV source. 

• All field wiring must have insulation suitable for rated voltages. 
 

 

 WARNING 
Loss of protection 

Loss of approvals can result from improper connection. 
• Check the nameplate on your device, to verify the approval rating. 
• Use approved cable gland/conduit seal to maintain TYPE 4X, TYPE 6, IP66, IP68 ratings. 
• See Hazardous area installations (Page 32). 
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 Note 
Considerations for connecting device 
• Use shielded, twisted pair cable (wire gauge AWG 22 to AWG 14/ 0.34 mm2 to 2.08 mm2). 
• Separate cables and conduits may be required to conform to standard instrumentation 

wiring practices, or electrical codes. 
• If cable is routed through conduit, use only approved suitable-size hubs for waterproof 

applications. 
• Non-metallic enclosure does not provide a continuous ground path between conduit 

connections: use grounding-type bushings and jumpers. 
• More detailed information can be found on Hazardous area installations (Page 193). 

 

6.2.1 Wiring instructions 
 

 Note 
Initial connection 

The display is not connected to the device when shipped. If this is not initial connection, 
remove the display before wiring. See Remove existing display (Page 151). 

 

 



 Connecting 
 6.2 Connecting SITRANS Probe LU240 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 31 

1. Turn lid by hand in a counter-clockwise direction to remove it from device. 

2. Strip cable jacket for approximately 70 mm (2.75") from end of cable, and thread wires 
through gland. 

3. Connect wires to terminals as shown below: polarity is identified on terminal block. 

 
4. Tighten gland to form a good seal. 

5. Press female end of cable from optional display onto male four-pin connector. See Install a 
new display (Page 152) for illustration. 

6. Set optional display into enclosure. Buttons on display should sit over terminal block. 
Gently turn display a quarter turn clockwise to secure the display in the enclosure. 

7. Replace device lid. Thread onto enclosure, turning clockwise. Hand tighten until mechanical 
stop is reached. 
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6.3 Hazardous area installations 
 

 WARNING 
Improper power supply 

Risk of explosion in hazardous areas as result of incorrect power supply. 
• Connect the device in accordance with the specified power supply and signal circuits. 

The relevant specifications can be found in the certificates, in Technical data (Page 172) 
or on the nameplate. 

 

6.3.1 Nameplates for hazardous area installations 

6.3.1.1 Intrinsic safety wiring 

Device nameplate (ATEX/IECEX/INMETRO/RCM) 
 

 Note 
Sample nameplate 

This nameplate is given as an example only.  
 

 
① ATEX certificate 

The ATEX certificate number (SIRA 18ATEX2045X) listed on the nameplate can be 
downloaded from our website: 
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Product page (www.siemens.com/sitransprobelu240)  

Go to Support > Approvals/Certificates. 

The IECEx certificate listed on the nameplate can be viewed on the IECEx website: 

http://iecex.iec.ch (http://iecex.iec.ch) 

Under the "Certified Equipment" tab in the "Certificate/ExTR/QAR number" field, enter the 
IECEx SIR number:18.0013X. 

For more information on hazardous area installations, refer to Instructions specific to 
hazardous area installations (Page 34). 

Connection drawing (FM/CSA) 
The FM/CCSAUS connection drawing number (A5E44090649A) listed on the device nameplate 
can be downloaded from our website: 

Product page (www.siemens.com/sitransprobelu240) 

Go to Technical Info > Images, graphics, drawings. 

6.3.1.2 Non-incendive wiring 

Connection drawing (FM) 
The FM connection drawing number (A5E44092290) listed on the device nameplate can be 
downloaded from our website: 

Product page (www.siemens.com/sitransprobelu240) 

Go to Technical info > Images, graphics, drawings. 

6.3.2 Further information related to hazardous area installations 
• For power demands see Loop power (Page 192). 

• For wiring requirements follow local regulations. 

• Use approved cable gland/conduit seal to maintain Type 4X, Type 6, IP66, IP68 ratings. 

• For hazardous area approvals, see Approvals (Page 176). 

http://www.siemens.com/sitransprobelu240
http://iecex.iec.ch/
http://www.siemens.com/sitransprobelu240
http://www.siemens.com/sitransprobelu240
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6.3.3 Instructions specific to hazardous area installations 

6.3.3.1 Instructions in accordance with IEC 60079-0:2011 clause 30 
The following instructions relevant to safe use in a hazardous area apply to equipment 
covered by certificate numbers Sira 18ATEX2045X and IECEx SIR 18.0013X. 

1. The certification marking is as follows: 

 

Certificate number: IECEx SIR 18.0013X Sira 18ATEX2045X 
Certification code: Ex ia IIC T4 Ga Ex ia IIC T4 Ga 
Other marking:  

  

2. The equipment may be used in zones 0, 1 & 2 with flammable gases and vapours with 
apparatus groups IIA, IIB & IIC and with temperature classes T4. 

3. The equipment is only certified for use in ambient temperatures in the range -40 ºC to 
+80 ºC and should not be used outside this range. 

4. Installation shall be carried out in accordance with the applicable code of practice by 
suitably-trained personnel. 

5. There are no special checking or maintenance conditions other than a periodic check. 

6. With regard to explosion safety, it is not necessary to check for correct operation. 

7. The equipment contains no user-replaceable parts and is not intended to be repaired by the 
user. Repair of the equipment is to be carried out by the manufacturer, or their approved 
agents, in accordance with the applicable code of practice. 

8. Repair of this equipment shall be carried out in accordance with the applicable code of 
practice. 

9. If the equipment is likely to come into contact with aggressive substances, e.g. acidic liquids 
or gases that may attack metals or solvents that may affect polymeric materials, then it is 
the responsibility of the user to take suitable precautions that prevent it from being 
adversely affected thus ensuring that the type of protection is not compromised. 

10. The certificate number has an ‘X’ suffix which indicates that special conditions of installation 
and use apply. Those installing or inspecting this equipment must have access to the 
contents of the certificate or these instructions. The conditions listed in the certificate are 
reproduced below: 

– Under certain extreme circumstances, the non-metallic parts incorporated in the 
enclosure of this equipment may generate an ignition-capable level of electrostatic 
charge. Therefore the equipment shall not be installed in a location where the external 
conditions are conducive to the build-up of electrostatic charge on such surfaces. 

– In addition, the equipment shall only be cleaned with a damp cloth. This is particularly 
important if the equipment is installed in a zone 0 location. 
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 Commissioning 7 
7.1 Basic safety notes 
 

 WARNING 
Loss of explosion protection 

Risk of explosion when device is not properly commissioned 

If opening device 
• Isolate from power. 

- or - 
• Ensure that the atmosphere is explosion-free (hot work permit). 

Ensure device is properly closed before returning to operation. 
 

7.2 Local commissioning 
SITRANS Probe LU240 can be quickly commissioned using wizards, and menu driven 
parameters. The parameters can be modified locally using the device display and buttons, 
also known as the Human Machine Interface (HMI). 

 
① Local device buttons 

The quick start wizards provide an easy step-by-step procedure to help you configure the 
device for a simple application. We recommend that you configure your application in the 
following order:  

• First, run the "Quick commissioning wizard" for your application 
(Level/Space/Distance/Custom, Volume, Volume flow). 

• Next, run the "Auto false echo suppression wizard" (optional) to prevent false echo 
detection. 

• After completing the wizards, configure any custom parameters via the parameter menus. 

• Lastly, if desired, configure alarms and warnings using "Limit monitoring and event 
counter" via a remote engineering system. 
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There are two ways to access the quick commissioning wizards:  

• Locally via HMI (see Quick commissioning (Page 42)) 

• From a remote location (see Quick commissioning wizards (Page 42)) 

See Level application example (Page 66), or Volume flow application example (Page 67) for 
illustrations, and for the complete range of parameters, see Parameter assignment - Local 
(Page 102) and Parameter assignment - Remote (Page 142). 

7.2.1 Activating SITRANS Probe LU240 
Power up the device.  

SITRANS Probe LU240 runs through an initialization routine for approximately three seconds. 
Next, the device name and then firmware revision appear. The display goes into 
measurement view (measured process values show as "- - - - -" before the first measurement 
is completed). The "Distance" measurement (displayed in meters) appears first by default. 
Press  button to scroll through other values in measurement view.  

The device is now ready for operation. 

7.2.2 Local display 
 

 Note 
Low temperature affects local display 

The operating temperature of the display is -25 °C to +85 °C; -40 °C to +85 °C with reduced 
readability. 

 

 
① Title line ⑥ EDIT indicator 
② Main line ⑦ INFO indicator 
③ UP/DOWN navigation arrows ⑧ NE107 diagnostic states 
④ Info field ⑨ Bar graph 
⑤ Lock symbol ⑩ Sign of the process value 



 Commissioning 
 7.2 Local commissioning 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 37 

7.2.2.1 Display symbols 
 
INFO field Symbol Meaning 
LP 

 
Device is write-protected via parameter "User PIN". 

LL Device is write-protected via parameter "Button lock". 
Co  Loop test is running. 
 
 
 

EDIT When symbol is flashing, you can edit the parameter.  
INFO Diagnostic message. The ID next to the "INFO" symbol is used for iden-

tification of the diagnostic message. 

For more information on diagnostic messages, see Fault codes and corrective actions 
(Page 158).  

7.2.2.2 Display views 
 

 Note 
Display views 
• Edit view and measurement view refer to the display only. While the device is in edit 

view, the output remains active and continues to respond to changes in the device. 
• The display will return to measurement view after ten minutes of inactivity (from last 

button press), when in edit view and from within a wizard. Pressing  button will then 
take you to the main navigation menu. (It will not return to the screen from which the 
timeout occurred.) 

 

Measurement view shows the current measured values of the device as well as status and 
diagnostic messages. 

 
① Process value name 
② Process value unit  

(① and ② alternate on display) 
③ Process value measurement 

If the process value is too large to be shown on the display (value has more than 5 digits), 
hashes "#####" will be shown instead. 

④ Process value number 
⑤ Diagnostic symbol 

Parameter view shows the parameters, parameter values and the wizards of the device.  
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① Parameter name 
② Parameter value 
③ Parameter number 
④ "EDIT" symbol (permanently enabled) 

Edit view 

Change parameter values in this view. Wizards are available for specific parameters. 

 
① Parameter name 
② Process value unit (① and ② alternate on display) 
③ Scrolling arrows (within options list only) 
④ Parameter number 
⑤ "EDIT" symbol (flashing) 

Service view 

Sets operation of local device display to show menu numbers in parameter view. 

 
① Menu number 

Parameter name (top left), parameter unit (if available, top right), and menu number (as shown 
above, top left) alternate in two-second intervals. 
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 Note 
Show menu numbers on local display 

To view menu numbers on the device, parameter "Service view" must be enabled. (Go to 
menu "Setup > Local display".) 
• The item number of the current selection appears in the info field. 
• The menu number in which the current selection resides, appears on the title line (thus 

no menu numbers appear for top-level menu items, such as "QUICK START", "SETUP", etc.). 

Refer to full device menu in HMI menu structure. 
 

 

 Note 
Dynamic decimal places 

Each setting for parameter "Units" has a default number of decimal places used to show the 
process value on the local display. However, if the value is too large to show on the segment 
display, the decimal places will be automatically adjusted to show the process value. 

 

 

 Note 
Process value too large to display 

In some cases, even with dynamic decimal places, it is possible that the process value be too 
large to show on the local display, "#####" will show instead. 

To correct, adjust parameter "Units" or "Custom units", depending on your application. 

(Note that custom units can only be defined via remote operation, and if custom units are 
adjusted, rescaling of output is also required.) 
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7.2.2.3 Navigating in the views 
 
Measurement view 

 

After initialization, the display will be in measurement view. 
1. Select the desired measurement value using  and  but-

tons. 
2. Navigate to parameter view using  button. 
3. Return to measurement view using  button. 

Parameter view 

 

The "EDIT" symbol is not flashing. 
1. Select a parameter using  and  buttons. 
2. Navigate to edit view using  button. 
3. Return to measurement view using  button. 

Edit view 

 

The "EDIT" symbol is flashing. 
1. Change the parameter value using  and  buttons. 
2. Accept a selected parameter value using  button. 
3. Return to measurement view using  button. 

7.2.2.4 Parameter menus 
 

 Note 
Complete parameter list 

For a complete list of parameters with instructions, see Parameter assignment - Local 
(Page 102) and Parameter assignment - Remote (Page 142). 

 

Parameters are identified by name and organized into function groups, then arranged in a 
three-level menu structure. 

On the local display: 

• Navigate to a menu - menu name shows on title line, and "MENU" shows on main line. 
(Info field shows number of current selection within menu structure.) 

• Navigate to a wizard - wizard name shows on title line, and "WIZ" shows on main line. 
(Info field shows number of current selection within menu structure.) 

• Navigate to a parameter - parameter name shows on title line, and parameter number 
shows in info field. 
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 Note 
Items numbers may not appear sequentially 

Although item numbers are sequential, they may not appear so as some menus and 
parameters are only visible on the device based on configuration settings. 

 

 For a full device menu see HMI menu structure (Page 242). 

The three-level menu structure explained below is for the purpose of documenting, thus item 
numbers do not match exactly to the local display: 

• For items that show "MENU" on device, this equates to "M" in documented menu structure 
below. 

• For items that show "WIZ" on device, this equates to "W" in documented menu structure 
below. 

• Menu and wizard numbers in the three-level structure are separated by dashes for each 
level (e.g. M 02-01 SELECT OUT). 

• Parameter IDs are a combination of menu number and parameter number, where 
parameter number follows the dot (e.g. 02-01.01 PV SELECT). 

• Wizard steps do not include the menu number (e.g. .01 OPERATION). 

M 01 QUICK START 

 W 01-01 COMMISSION 

 .01 OPERATION 

... 

M 02 SETUP 

 M 02-01 SELECT OUT 

 02-01.01 PV SELECT 

... 

M 03 MAINT/DIAGS 

 M 03-01 SIGNAL 

 M 03-01-01 SIG QUALITY 

 M 03-01-01.01 SHRTSHOTCONF 

7.2.3 Programming 
From measurement view, press  button to enter parameter view and open the first 
menu level M 01. 

To select a listed option: 

1. Navigate to the desired parameter. 

2. Press  button to open edit view. The current selection is highlighted. 
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3. Scroll to a new selection using  and  buttons. 

4. Press  button to accept it. The display returns to parameter view and shows the new 
selection. 

To change a numeric value: 

1. Navigate to the desired parameter. 

2. When selected, the current value is displayed. 

3. Press  button to configure it. The "EDIT" symbol is flashing. 

4. Use  and  buttons to increase or decrease the value. Press and hold button to increase 
scrolling speed. 

5. To escape without saving your changes, press  button to return to parameter view. 

6. Press  button to accept the new value. The display returns to parameter view ("EDIT" 
symbol is no longer flashing) and shows the new selection. Review for accuracy. 

Button functions for editing 
 
Button Name Function 

 

 

UP or DOWN 
arrow 
 

Selecting parameter 
settings 

Scrolls to item 

Alpha-numeric editing Increases or decreases value. Pressing and 
holding will increase scrolling speed through 
values.  

 

RIGHT arrow Selecting parameters Accepts the data (writes the parameter setting)  
 

 

LEFT arrow Selecting parameter 
settings 
 

Cancels edit view without changing the pa-
rameter setting. 
 

7.2.4 Wizards 

7.2.4.1 Quick commissioning 

Quick commissioning wizards 
A wizard provides an easy step-by-step procedure that configures the device for a simple 
application. To configure the SITRANS Probe LU240 for applications of level, space, distance, 
volume, or volume flow, use the "Quick commissioning wizard" via HMI. It is possible to 
configure custom applications employing more complex vessel shapes via the HMI, but we 
suggest using a remote engineering system, such as SIMATIC PDM.  
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 Note 
Quick commissioning of 3 m version 
• 3 m version must be commissioned via the HMI 
• 3 m version can be commissioned for level, space, and distance applications only 

 

Quick commissioning wizards are also available remotely using various software packages: 

• SIMATIC PDM (Page 199) 

• AMS device manager (Page 230) 

• Field Communicator (FC) 375/475 (Page 231) 

• FDT (Field Device Tool) (Page 232) 

Quick commissioning wizard 

The SITRANS Probe LU240 provides a single quick commissioning wizard that can be used for 
various applications.  

The initial wizard steps are common for all application types. Subsequent wizard parameters 
will vary depending on the application you choose. For the purpose of documenting, three 
separate lists follow. These lists include the wizard parameters available to commission each 
application type (see links below). 

1. From measurement view, press  button to enter parameter view. The first level menu 
(QUICK START) will display. Press  button to enter this menu. 

2. Press  button again to enter "Quick commissioning wizard" (COMMISSION). 

In the wizard, it is not necessary to press  button to navigate to the next step. In each 
step, you are taken directly to edit view. 

3. Set "Operation", then "Material type". 

Subsequent wizard parameters will vary depending on the application you choose. See 
links below to step you through the wizard appropriate to your application. 

4. Select "Yes" to confirm all parameter changes as the final step in the quick commissioning 
wizard, and return to parameter view. "DONE" will appear on the main line of the display. 

5. Press  button three times to return to measurement view. 

For more information about commissioning a Level, Space, Distance or Custom application, 
go to Quick commissioning: Level/Space/Distance/Custom (Page 45). 

For more information about commissioning a Volume application, go to Quick 
commissioning: Volume (Page 50). 

For more information about commissioning a Volume flow application, go to Quick 
commissioning: Volume flow (Page 55).  
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 Note 
Important information regarding the use of commissioning wizard 
• A reset to factory defaults should be performed before running "Quick commissioning 

wizard" if the device has been used in a previous application. See Reset (03-04.02) 
(Page 137). 

• Settings for quick commissioning wizard are inter-related and changes apply only after 
"Confirm" is set to 'Yes' in final step. 

• Do not use quick commissioning wizard to modify individual parameters. (See instead 
chapter Parameter assignment - Local (Page 102).) 
Perform customization for your application only after "Quick commissioning wizard" has 
been completed. 

 

 

 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 

 

 

 Note 
Commissioning wizard may fail due to invalid configuration 

Device may show "ERROR" if the commissioning wizard completes with some invalid 
configurations. Invalid value(s) may be stored in the parameter(s). 
• Review application parameters, then perform a "Factory reset" or re-run the "Quick 

commissioning wizard" with proper values to clear the invalid configuration. 
 

 

 Note 
Update of process value on display when commissioning wizard run via EDD 

Process values shown in measurement view on local display will not automatically update to 
reflect a change made remotely via "Wizard - Quick start...". 
• To have device process values update when configured remotely, use local buttons to take 

device in and out of measurement view (i.e. go to parameter view then back to 
measurement view). 
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Quick commissioning: Level/Space/Distance/Custom 

 
 

 Note 
Distance and Custom applications 
• When "Operation" is set to "Distance", setting the upper calibration point is not required 

(will not appear in the wizard). 
• Only when "Operation" is set to "Custom", is the upper range value required (will appear in 

the wizard). 
 

 

 Note 
Output remains active 

While the device is being configured, the output remains active and continues to respond to 
changes in the process. 

 

 

 Note 
Parameter options 

In the following wizard steps, a full list of options for each parameter is shown. However, 
some options may not appear on the device, based on the application selected. 
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Operation 
Sets operation mode which defines output and local display. 
 
Setting Level LEVEL 

Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 

Default Level LEVEL 
 

 Note 
Settings for 3 m version 

3 m version can be configured for level, space, and distance applications only. 
 

 

 Note 
Completing a Custom setup 

For a custom application ("Operation" set to "Custom"), at least one pair of input and output 
breakpoints (parameters "X-value" and "Y-value") must be defined, after the wizard is 
complete. See Customized characteristic curve (M 02-07.02) (Page 124). 

 

 
① Distance ⑤ Lower calibration point 
② Space ⑥ Far range 
③ Upper calibration point ⑦ Level 
④ Sensor reference point   
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Setting Description Reference point 
Level  LEVEL Height of material Lower calibration point (process 

empty level) 
Space  SPACE  

Distance to material surface 
 

Upper calibration point (process 
full level) 

Distance DIST Sensor reference point 

Custom CUSTM Linearization table (level/volume 
or level/flow breakpoints) 

Lower calibration point 

Material type 
Used to optimize performance based on material type. 
 
Setting Liquid LQD 

Solid SOLID 
Default Liquid LQD 

Units 
Sets measurement units used. 
 
 Default 
Setting Meters m 3 decimal places 

Centimeters cm 1 decimal place 
Millimeters mm 0 decimal places 
Feet Ft 3 decimal places 
Inches in 2 decimal places 

Default Meters m 3 decimal places 
 

 Note 
Dynamic decimal places 

Each setting for parameter "Units" has a default number of decimal places used to show the 
process value on the local display. However, if the value is too large to show on the segment 
display, the decimal places will be automatically adjusted to show the process value. 
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 Note 
Process value too large to display 

In some cases, even with dynamic decimal places, it is possible that the process value be too 
large to show on the local display, "#####" will show instead. 

If this occurs in a typical application: 
• Adjust parameter "Units" so that a smaller value can be shown, e.g. use meters instead of 

millimeters. 

If this occurs in a custom application: 
• Adjust parameter "Custom units" so that a smaller value can be shown, e.g. use tons 

instead of pounds. 
• Note that a change to custom units also requires a scaling adjustment (see Upper range 

value (Page 49)). 
 

Custom units can only be defined via remote operation (see Custom units (Page 144)). 

Lower calibration point 
Sets distance from sensor reference point to lower calibration point: usually process empty 
level. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default • 3 m (3 m device) 
• 6 m (6 m version) 
• 12 m (12 m version) 

Defined in parameter "Units". 

Upper calibration point 
Sets distance from sensor reference point to upper calibration point: usually process full level. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 0 m 

Defined in parameter "Units". 
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Response rate 
Sets reaction speed of device to measurement changes in target range. 

Use a setting just faster than the maximum filling or emptying rate (whichever is faster). 
 
Setting Slow SLOW 0.1 m/min (fill/empty rate) 

Medium MED 1.0 m/min (fill/empty rate)  
Fast FAST 10.0 m/min (fill/empty rate) 

Default Slow 
 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

Further information can be found in Measurement response (Page 185). 

Upper range value 
Sets process value that corresponds to 20 mA loop current. 
 
Setting 0 to 9999999 
Default 100 <Custom units> 

 

 

 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", the 

parameter "Upper scaling point" is automatically adjusted to the same value. 
• Setting a value for either parameter outside of the wizard will not automatically adjust the 

other value. 
 

 

 Note 
Changing custom units 

If a change is made to custom units, be sure to rescale the output, as rescaling for custom 
units is not handled automatically by the device. 
• Use parameters "Upper range value" and "Upper scaling point" to rescale output. 

 

Confirm 
Applies settings as last step in wizard. 
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Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 

Quick commissioning: Volume 
 

 Note 
Requirement for volume application 

Only 6 m and 12 m versions of the device support volume applications. 
 

 
 

 Note 
Output remains active 

While the device is being configured, the output remains active and continues to respond to 
changes in the process. 
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 Note 
Parameter options 

In the following wizard steps, a full list of options for each parameter is shown. However, 
some options may not appear on the device, based on the application selected. 

 

Operation 
Sets operation mode which defines output and local display. 
 
Setting Level LEVEL 

Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 

Default Level LEVEL 

 
① Distance ⑤ Lower calibration point 
② Space ⑥ Far range 
③ Upper calibration point ⑦ Level 
④ Sensor reference point   
 
Setting Description Reference point 
Volume VOL Volume of material in Volume 

units (based on level) 
Lower calibration point 

Material type 
Used to optimize performance based on material type. 
 
Setting Liquid LQD 

Solid SOLID 
Default Liquid LQD 
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Units 
Sets measurement units used. 
 
 Default 
Setting Meters m 3 decimal places 

Centimeters cm 1 decimal place 
Millimeters mm 0 decimal places 
Feet Ft 3 decimal places 
Inches in 2 decimal places 

Default Meters m 3 decimal places 
 

 Note 
Dynamic decimal places 

Each setting for parameter "Units" has a default number of decimal places used to show the 
process value on the local display. However, if the value is too large to show on the segment 
display, the decimal places will be automatically adjusted to show the process value. 

 

 

 Note 
Process value too large to display 

In some cases, even with dynamic decimal places, it is possible that the process value be too 
large to show on the local display, "#####" will show instead. 

If this occurs in a typical application: 
• Adjust parameter "Units" so that a smaller value can be shown, e.g. use meters instead of 

millimeters. 

If this occurs in a custom application: 
• Adjust parameter "Custom units" so that a smaller value can be shown, e.g. use tons 

instead of pounds. 
• Note that a change to custom units also requires a scaling adjustment (see Upper range 

value (Page 54)). 
 

Custom units can only be defined via remote operation (see Custom units (Page 144)). 
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Vessel shape 
Sets vessel shape, and allows device to calculate volume in addition to level. 
 
Settings Linear vessel LINR 

Conical bottom vessel CONIC 
Parabolic bottom vessel PARAB 
Half sphere bottom vessel HALF 
Flat sloped bottom vessel FLAT 
Cylinder vessel CYLIN 
Parabolic ends vessel PARAE 
Sphere vessel SPHER 

Default Linear vessel LINR 

Vessel dimension A 
Sets height of vessel bottom when bottom is conical, parabolic, half spherical, or flat sloped. 
If horizontal parabolic ends vessel, sets depth of end. 
 
Setting 0 to 99.999 m 
Default 0 

See Vessel shape (02-05.01) (Page 117) for illustration. 

Vessel dimension L 
Sets length of cylindrical section of horizontal parabolic ends vessel. 
 
Setting 0 to 99.999 m 
Default 0 

See Vessel shape (02-05.01) (Page 117) for illustration. 

Lower calibration point 
Sets distance from sensor reference point to lower calibration point: usually process empty 
level. 
 
Setting • 0 to 6 m (6 m device) 

• 0 to 12 m (12 m device) 

Default • 6 m (6 m device) 
• 12 m (12 m device) 

Defined in parameter "Units". 
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Upper calibration point 
Sets distance from sensor reference point to upper calibration point: usually process full level. 
 
Setting • 0 to 6 m (6 m device) 

• 0 to 12 m (12 m device) 

Default 0 m 

Defined in parameter "Units". 

Response rate 
Sets reaction speed of device to measurement changes in target range. 

Use a setting just faster than the maximum filling or emptying rate (whichever is faster). 
 
Setting Slow SLOW 0.1 m/min (fill/empty rate) 

Medium MED 1.0 m/min (fill/empty rate)  
Fast FAST 10.0 m/min (fill/empty rate) 

Default Slow 
 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

Further information can be found in Measurement response (Page 185). 

Volume units 
Sets volume measurement units. 
 
Setting 
 
 

Cubic meters m3 
Liters l 
US gallons Ga 
Imperial gallons IGa 

Default Cubic meters m3 

Upper range value 
Sets process value that corresponds to 20 mA loop current. 
 
Setting 0 to 9999999 
Default 100 liters 
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 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

 

 Note 
Changing custom units 

If a change is made to custom units, be sure to rescale the output, as rescaling for custom 
units is not handled automatically by the device. 
• Use parameters "Upper range value" and "Upper scaling point" to rescale output. 

 

Confirm 
Applies settings as last step in wizard. 
 
Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 

Quick commissioning: Volume flow 
 

 Note 
Requirement for volume flow application 

Only 6 m and 12 m versions of the device support volume flow applications. 
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 Note 
Output remains active 

While the device is being configured, the output remains active and continues to respond to 
changes in the process. 

 

 

 Note 
Parameter options 

In the following wizard steps, a full list of options for each parameter is shown. However, 
some options may not appear on the device, based on the application selected. 
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Operation 
Sets operation mode which defines output and local display. 
 
Setting Level LEVEL 

Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 

Default Level LEVEL 

 
① Sensor reference point ⑤ Zero level (head) 
② Upper calibration point ⑥ Level (head) 
③ Lower calibration point ⑦ Material surface 
④ Far range ⑧ Upper scaling point (maximum volume/flow) 
 
Setting Description Reference point 
Volume flow VFLOW Flow rate in an open channel in 

Volume flow units 
Zero level, zero flow 

Material type 
Used to optimize performance based on material type. 
 
Setting Liquid LQD 

Solid SOLID 
Default Liquid LQD 
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Units 
Sets measurement units used. 
 
 Default 
Setting Meters m 3 decimal places 

Centimeters cm 1 decimal place 
Millimeters mm 0 decimal places 
Feet Ft 3 decimal places 
Inches in 2 decimal places 

Default Meters m 3 decimal places 
 

 Note 
Dynamic decimal places 

Each setting for parameter "Units" has a default number of decimal places used to show the 
process value on the local display. However, if the value is too large to show on the segment 
display, the decimal places will be automatically adjusted to show the process value. 

 

 

 Note 
Process value too large to display 

In some cases, even with dynamic decimal places, it is possible that the process value be too 
large to show on the local display, "#####" will show instead. 

If this occurs in a typical application: 
• Adjust parameter "Units" so that a smaller value can be shown, e.g. use meters instead of 

millimeters. 

If this occurs in a custom application: 
• Adjust parameter "Custom units" so that a smaller value can be shown, e.g. use tons 

instead of pounds. 
• Note that a change to custom units also requires a scaling adjustment (see Upper range 

value (Page 64)). 
 

Custom units can only be defined via remote operation (see Custom units (Page 144)). 

Primary measuring device 
Sets the type of primary measuring device (PMD) used. 
 
Setting Exponential devices EXPON 

Rectangular flume BS 3680/ISO 4373 RECFL 
Round nose horizontal crest weir BS 3680/ISO 4373 RNHWR 
Trapezoidal flume BS 3680/ISO 4373 TRPFL 
U-flume BS 3680/ISO 4373 UFLM 
Finite crest weir BS 3680/ISO 4373 FINWR 
Thin plate rectangular weir BS 3680/ISO 4373 TPRWR 
Thin plate V-notch weir BS 3680/ISO 4373 TPVWR 
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Rectangular weir contracted RWRC 
Round pipe RPIPE 
Palmer-Bowlus flume PBFLM 
H-flume HFLM 

Default Exponential devices  EXPON 

Method of flow calculation 
Sets method of flow calculation. 
 
Setting Absolute ABS 

Ratiometric RATIO 
Default Absolute ABS 

Set this parameter to "Ratiometric" only if the primary measuring device (PMD) supports 
ratiometric calculations. (Note that Palmer Bowlus Flume and H-Flume support ratiometric 
calculations only.) For more details on absolute and ratiometric calculations, see Method of 
flow calculation (Page 191). 

Flow exponent 
Sets exponent for flow calculation formula. 
 
Setting -999 to 9999 
Default 1.55 

Use if parameter "Primary measuring device" is set to "Exponential devices". The flow 
exponent is used to create an exponential curve with end points set by "Upper scaling point" 
and Zero level (head), and with the curve based on the specified exponent. 
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The exponential equation is 

Q = KHFlow exponent 

Where: 

Q = flow 

K = constant factor 

H = level (head) 

Use the exponent specified by the PMD manufacturer, if available, or relevant Open Channel 
Monitoring reference material. 

K-factor 
Sets constant used in volume flow calculation formula, for absolute calculation of 
exponential device only. 
 
Setting -999 to 99999 
Default 1.0 

Use if parameter "Primary measuring device" is set to "Exponential devices". The constant 
factor (K-factor) is used to create an exponential curve with end points set by "Upper scaling 
point" and Zero level (head), and with the curve based on the specified exponent. 

 

 Note 
Accurate flow calculation 

In a volume flow application using exponential device, and absolute method of flow 
calculation, the following must be consistent for flow calculation to be valid: 
• Engineering units for level (parameter "Units") 
• Engineering units for volume flow (parameter "Volume flow units") 
• Constant factor (parameter "K-factor"). 

V-notch angle 
Sets V-notch angle used in volume flow calculation formula. 
 
Setting 25° to 95° 
Default 25° 

Use when parameter "PMD dimensions" is set to "Thin plate V-Notch weir BS 3680/ISO 4373". 
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Slope 
Sets flow slope used in volume flow calculation formula. 
 
Setting 0 to 1 
Default 0 

Use when parameter "PMD dimensions" is set to "Trapezoidal flume BS 3680/ISO 4373" or 
"Round pipe". 

Roughness coefficient 
Sets flow roughness coefficient used in volume flow calculation formula. 
 
Setting -999 to 9999 
Default 0 

Use when parameter "PMD dimensions" is set to "Round pipe". 

PMD dimensions 
Sets dimensions of primary measuring device (PMD), to calculate volume. 

The following table is a reference to the parameters that must be set for each PMD. 
 
Supported 
PMD 

Dimensions required 

Exponential devices 
 Flow exponent 
 K-factor 
Rectangular flume BS 3680/ISO 4373 
 OCM dimension 1: Approach width  
 OCM dimension 2: Throat width 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
Round nose horizontal crest weir BS 3680/ISO 4373 
 OCM dimension 1: Crest width 
 OCM dimension 2: Crest height 
 OCM dimension 3: Crest length 
Trapezoidal flume BS 3680/ISO 4373 
 OCM dimension 1: Approach width 
 OCM dimension 2: Throat width 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
 Slope 
U-flume BS 3680/ISO 4373 
 OCM dimension 1: Approach diameter 
 OCM dimension 2: Throat diameter 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
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Supported 
PMD 

Dimensions required 

Finite crest weir BS 3680/ISO 4373 
 OCM dimension 1: Crest width 
 OCM dimension 2: Crest height 
 OCM dimension 3: Crest length 
Thin plate rectangular weir BS 3680/ISO 4373 
 OCM dimension 1: Approach width 
 OCM dimension 2: Crest width 
 OCM dimension 3: Crest height 
Thin plate V-notch weir BS 3680/ISO 4373 
 V-Notch angle 
Rectangular weir contracted 
 OCM dimension 1: Crest width 
Round pipe 
 OCM dimension 1: Pipe diameter 
 Slope 
 Roughness coefficient 
Palmer-Bowlus flume 
 OCM dimension 1: Maximum flume width 
H-flume 
 OCM dimension 1: Flume height 
Custom  
 Volume (up to 32) 
 Flow (up to 32) 

OCM dimension 1-4 
Sets OCM dimension for each directly supported primary measuring device (PMD). 

See table under parameter "PMD dimensions" to relate "OCM Dimension 1 - 4" to a specific 
dimension for each directly supported primary measuring device. For PMDs that are not 
directly supported, use a universal flow calculation. See Custom calculation support 
(Page 93). 

For more information, see Open Channel Monitoring (OCM) (Page 74). 

Lower calibration point 
Sets distance from sensor reference point to lower calibration point: usually process empty 
level. 
 
Setting • 0 to 6 m (6 m device) 

• 0 to 12 m (12 m device) 

Default • 6 m (6 m device) 
• 12 m (12 m device) 

Defined in parameter "Units". 
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Upper calibration point 
Sets distance from sensor reference point to upper calibration point: usually process full level. 
 
Setting • 0 to 6 m (6 m device) 

• 0 to 12 m (12 m device) 

Default 0 m 

Defined in parameter "Units". 

Response rate 
Sets reaction speed of device to measurement changes in target range. 

Use a setting just faster than the maximum filling or emptying rate (whichever is faster). 
 
Setting Slow SLOW 0.1 m/min (fill/empty rate) 

Medium MED 1.0 m/min (fill/empty rate)  
Fast FAST 10.0 m/min (fill/empty rate) 

Default Slow 
 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

Further information can be found in Measurement response (Page 185). 

Volume flow units 
Sets measurement units used when parameter "PV selection" set to "Volume flow". 
 
Setting 
 

Liters per second l/S 
Liters per minute l/m 
Cubic feet per second Ft3/S 
Cubic feet per day Ft3/d 
US gallons per minute Ga/m 
US gallons per day Ga/d 
Imperial gallons per minute IGa/m 
Imperial gallons per day IGa/d 
Cubic meters per hour m3/h 
Cubic meters per day m3/d 
US million gallons per day MGl/d 

Default Liters per second l/S 
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Upper range value 
Sets process value that corresponds to 20 mA loop current. 
 
Setting 0 to 9999999 
Default 100 liters per second 

 

 

 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

 

 Note 
Changing custom units 

If a change is made to custom units, be sure to rescale the output, as rescaling for custom 
units is not handled automatically by the device. 
• Use parameters "Upper range value" and "Upper scaling point" to rescale output. 

 

Confirm 
Applies settings as last step in wizard. 
 
Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 

7.2.4.2 AFES wizard 
Used to prevent false echo detection over a specified range. 

Use AFES wizard if there are known obstructions in the application and if false echoes are 
anticipated. Perform the AFES wizard when the material level is low. 

To run the wizard, enter the auto false echo suppression range. 
 

 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 
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Auto false echo suppression range 
Sets end point of the learned TVT distance. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 1 m 

To calculate value  

1. Determine the auto false echo suppression range by measuring the actual distance from the 
sensor reference point to the material surface using a rope or tape measure. 

2. Subtract 0.5 m (20") from this distance and use the resulting value. 

 

 Note 
For best results with AFES 
• Set up auto false echo suppression during commissioning if possible, by running "Auto 

false echo suppression wizard". 
• Ensure material level is below all known obstructions at the moment when "Auto false 

echo suppression wizard" learns the TVT. Ideally the vessel should be empty or almost 
empty. 

• Use auto false echo suppression only if target is greater than one meter from transducer 
face (sensor reference point) 

• Note the distance to material level when learning the echo profile, and set value in 
parameter "Auto false echo suppression range" to a shorter distance to avoid the material 
echo being screened out. 

• If the vessel contains an agitator, it should be running. 
 

Once the wizard completes successfully, parameter "Auto false echo suppression" is set to 
"Enabled" and the learned TVT will be used. 

For more information about auto false echo suppression, see Auto false echo suppression and 
Custom TVT (Page 182). 

Confirm 
Applies settings as last step in wizard. 
 
Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 
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7.2.5 Requesting an echo profile 
After commissioning the device, an echo profile may be viewed using a remote engineering 
system, such as SIMATIC PDM. 

For details, see Echo profile utilities (Page 222). 

7.2.6 Device address 
Setting a device address is not necessary for local operation, but must be set if configuring 
the device for use on a HART network. See Polling address (04.01) (Page 139). 

7.2.7 Testing the configuration 
After configuring the device, it is recommended that you test the device to ensure that it 
performs to your specifications. This test can be run in simulation mode or by varying the 
actual process value in the application. The latter is preferred, as it more accurately 
represents operating conditions. However, if it is not possible to do a physical test, a 
simulation will ensure that control programming is correct. For more details, see Simulation 
(Page 97). 

7.3 Application examples 

7.3.1 Level application example 

 
① Distance (5.5 m) ⑥ 9.0 m 
② Space (4.5 m) ⑦ Lower calibration point 
③ 1.0 m ⑧ Far range 
④ Upper calibration point ⑨ Level (3.5 m) 
⑤ Sensor reference point   
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Quick commissioning parame-
ter 

Setting/value Description 

Operation Level Material level referenced from "Lower calibra-
tion point" 

Material type Liquid  
Units m Sensor measurement units 
Lower calibration point 9.0 m Process empty level 
Upper calibration point 1.0 m Process full level 
Response rate Slow Sets "Fill rate" and "Empty rate" to 0.1 m/min 

The application is a vessel that takes an average 3 hours (180 minutes) to fill and 3 weeks to 
empty.  

"Fill rate" = ("Lower calibration point" – "Upper calibration point") / fastest of fill or empty time  

= (9 m – 1 m) / 180 min 

= 8 m /180 min. = 0.04 m/min 

7.3.2 Volume flow application example 
In this example, a 12 inch (0.305 m) Parshall Flume has been installed in an open channel. As 
per the supplier’s data sheet, the device has been rated for a maximum flow of 1143 m3 per 
hour at a maximum level of 0.6 m. The Parshall Flume is considered an exponential device, 
therefore the supplier’s data sheet includes a flow exponent value of 1.522. The SITRANS 
Probe LU240 has been installed 1.6 m above the channel.  

 
① SITRANS Probe LU240 ④ Direction of flow 
② 2/3 of converging dimension ⑤ Zero level (head) 
③ Converging dimension   
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① Upper calibration point (1.0 m) 
② Lower calibration point (1.6 m) 
③ Upper scaling point (0.6 m) 
 
Quick commissioning 
parameter 

Setting/value Description 

Operation Volume flow VFLOW  
Material type Liquid LQD  
Units Meters m Units corresponding to the level (head) 

measurement. 
Primary measuring device 
(PMD) 

Exponential EXPON Parshall Flumes are a type of exponen-
tial device. 

Method of flow calcula-
tion 

Ratiometric RATIO Used when the maximum level and 
maximum flow values ("Upper scaling 
point", "Upper range value") are pro-
vided. 

Flow exponent  1.522 Available from the PMD supplier data 
sheet. 

Lower calibration point  1.6 The distance to the empty point or 
bottom of the flume. This sets the 
material level at 4 mA. 

Upper calibration point  1.0 The distance to the maximum level. 
This sets the "Upper range value". 

Response rate Medium 
(1.0 m/min) 

MED Response rate is set to be faster than 
the fastest rise in material level under 
typical operating conditions. 

Upper scaling point  0.6 m Available from the PMD supplier data 
sheet. 
("Upper scaling point" is set by "Upper 
range value" in "Quick commissioning 
wizard".) 

Volume flow units Cubic meters 
per hour 

m3/h Set per end user requirements. 

Upper range value  1143 Available from the PMD supplier data 
sheet. 
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 Operating 8 
 

 

This chapter provides details on the general operation and functionality of the SITRANS Probe 
LU240. For instructions on the use of the device local display HMI, refer to Local display 
(Page 36). 

For a complete list of parameters, see Parameter assignment - Local (Page 102) or Parameter 
assignment - Remote (Page 142). 

8.1 Ultrasonic operation 
 

 

 CAUTION 
Ultrasonic operation 
• Never point any transducer directly at the ear. 
• Never operate a transducer in a small enclosed room containing personnel. 
• A transducer located in a tank, bin, or silo presents no health hazard. 

 

8.2 Starting measurement 
The SITRANS Probe LU240 is a single point device. After startup, the measurement view 
reports a list of measurement values in the order shown below. 
 
Process value Text as shown in measurement view of device 
Level  LEVEL 
Space SPACE 
Distance DISTANCE 
Volume* VOLUME 
Volume flow* VOLUME FLOW 
Custom* CUSTOM 
Loop current** LOOP CURRENT 
Primary variable** PV 
% of range** % OF RANGE  
Sensor temperature SENSOR TEMP 
 * "Volume", "Volume flow", and "Custom" are not visible until configured. 

** Measurements based on primary variable (PV) selection. Default PV is set to "Distance" at startup. 
(See "Operation" in quick commissioning wizard, or parameter "PV selection" in menu "Setup > Se-
lect output" to change this default.) 
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Process value Text as shown in measurement view of device 
 

 Note 
Damped PV 

All process values are damped by the value in parameter "Sensor damping value".  

The process value that is set as the primary variable (PV) for the application can be damped 
further using value in parameter "Damping value". 

 

The device starts with "Distance" as the default measurement, and a preset (based on 
version*) for lower calibration point. Change the following common parameters in the quick 
commissioning wizard to reflect your application.  
 
Parameter Sample value 
Operation Level 
Response rate Medium 
Units meters 
Lower calibration point 6 
Upper calibration point 2 

* Lower calibration point is preset to 3 meters for the 3 m version, 6 meters for the 6 m 
version, and 12 meters for the 12 m version of the device. 

8.3 Measurement conditions 
The following information will help you configure your device for optimal performance and 
reliability.  

Response Rate  

The response rate of the device influences the measurement reliability. Use the slowest rate 
possible with the application requirements.  

 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

Dimensions  

Dimensions of the vessel, wet well, or reservoir (other than lower and upper calibration 
points) are only important if you require volume readings. In this case, all dimensions are 
used to calculate the volume value in terms of level. 
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Fail-safe  

The fail-safe parameters ensure that the device defaults to an appropriate state when a valid 
level reading is not available. (See Fault codes and corrective actions (Page 158) for a list of 
fault codes related to fail-safe.) 

• Parameter "Fault current" defines the behavior (mA output value to report) when an error 
condition, such as loss of echo, is detected. 

• A fail-safe timer also activates when an error condition is detected. "Fail-safe LOE timer" 
sets the amount of time the loss of echo will persist before device enters fail-safe mode. 

• Upon expiration of the timer, and if device is still in an error condition, the mA output 
value reported is based on value set in parameter "Fail-safe loss of echo". 

If fail-safe operation activates frequently, see Diagnosing and troubleshooting (Page 155). 

8.4 mA control 

mA output 

The device has one mA output, used for communications with other devices.  

Example:  

Configuring the mA output to send a 4 to 20 mA signal corresponding to a scaled value of 
10% to 90% of maximum process level:  
 
Parameter Sample value Description 
PV selection Level Set mA proportional to level reading 
Lower range value 1.2 Set 4 mA at process level equal to 10% of maxi-

mum ("Lower calibration point" minus "Upper 
calibration point")* 

Upper range value 10.8 Set 20 mA at process level equal to 90% of max-
imum ("Lower calibration point" minus "Upper 
calibration point")** 

Lower saturation limit 3.55 Set lower limit for saturation range, past which 
the loop current cannot decrease. 

Upper saturation limit 22.8 Set upper limit for saturation range, past which 
the loop current cannot increase. 

 * If the level reading drops below 1.2 m, the mA output drops below 4 mA. 
** If the level reading rises above 10.8 m, the mA output rises above 20 mA. 

 

 

 Note 
Default mA values 

If default values (4 and 20 mA) are used for the upper and lower saturation limits, the mA 
output (shown under "Loop current" in measurement view of device) will remain at the set 
mA limit, even if the level reading falls below/rises above the lower and upper range values. 
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Verifying the mA range  

Check that the external device can track the entire 4 to 20 mA range sent by the device. 
Follow the steps below if actual mA readings differ between the device (shown under "Loop 
current" in measurement view of device) and an external device (such as a PLC). 

1. To test the loop current, run the "Loop test wizard". Select a constant mA value to use in the 
test from a list of mA values, or set a custom mA value by selecting option "User", then set a 
value. 

2. Check that the external device displays the same mA reading as the mA value set above. 

3. If external device reading differs from the value manually set on the device, adjust the 
reading on the external device to match the reading on the device. 

8.5 Volume 
 

 Note 
Requirement for volume application 

Only 6 m and 12 m versions of the device support volume applications. 
 

8.5.1 Vessel shape and dimensions 
The device can be configured to suit many common vessel shapes. See Vessel shape (02-
05.01) (Page 117). Whenever possible, use one of the pre-defined selections. If one of the 
pre-defined selections is not applicable, a custom volume calculation can be used. (Configure 
a custom application by setting parameter "Operation" or "PV selection" to option "Custom", 
then define your vessel shape using Custom (M 02-07) (Page 124).) For more details, see 
Volume calculation (Page 188). 

Each vessel shape uses the empty distance value in its calculations of volume. See PV 
selection (02-01.01) (Page 103) for an illustration. 

Some vessel shapes also require extra dimensions to calculate the volume. Do not estimate 
these values as they must be exact to ensure the accuracy of your volume calculations. 

Example: 

To configure volume for a vessel with a half-sphere bottom, set the following: 

 
① Vessel dimension A 
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Parameter Sample value Description 
Vessel shape Half sphere bottom vessel Sets correct vessel shape 
Upper scaling point 100 Sets upper scaling at 100  

(defined in "Volume units") 
Vessel dimension A 1.3 Sets dimension A to 1.3 m 

 

 

 Note 
Example outcome 
• The default reading changes to a range from 0 to 100, which is the value in parameter 

Upper scaling point (02-05.05) (Page 118). 
• The process empty value is still measured to the bottom of the vessel (value in parameter 

"Lower calibration point"), not the top of dimension A. 
 

8.6 Volume flow 
 

 Note 
Requirement for volume flow application 

Only 6 m and 12 m versions of the device support volume flow applications. 
 

8.6.1 Flow calculation 
The SITRANS Probe LU240 provides numerous open channel flow calculation features. The 
device can be configured to select the flow calculation specific to the primary measuring 
device (PMD), such as a flume or weir. If the PMD does not match any of the preset PMD 
calculations, a custom volume flow calculation can be used. (Configure a custom application 
by setting parameter "Operation" or "PV selection" to option "Custom", then define your PMD 
using Custom (M 02-07) (Page 124).) For more details, see Volume flow calculation 
(Page 189). 

The device converts the level measurement into a volume flow rate. 
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8.6.2 Open Channel Monitoring (OCM) 
An OCM installation is defined one of three ways, based on the Primary Measuring Device 
(PMD): 

1. Dimensional 

For some common weir and flume types. PDM dimensions are entered directly. 

 

Rectangular flume BS 3680/ISO 4373 (Page 82) 

Round nose horizontal crest weir BS 3680/ISO 4373 (Page 83) 

Trapezoidal flume BS 3680/ISO 4373 (Page 84) 

U-flume BS 3680/ISO 4373 (Page 85) 

Finite crest weir BS 3680/ISO 4373 (Page 86) 

Thin plate rectangular weir BS 3680/ISO 4373 (Page 87) 

Thin plate V-notch weir BS 3680/ISO 4373 (Page 88) 

Rectangular weir contracted (Page 89) 

Round pipe flume (Page 90) 

Palmer-Bowlus flume (Page 91) 

H-flume (Page 92) 

2. Exponential 

For most other weir and flume types. PMD exponents provided by the manufacturer are 
entered. Volume flow is calculated using parameter "Flow exponent", and the maximum 
value parameters ("Upper scaling point" and "Upper range value"). 

 

Standard weirs (Page 76) 

Parshall flume (Page 78) 

Leopold-Lagco flume (Page 79) 

Cut throat flume (Page 80) 

3. Custom 

For all other PMDs, a level versus volume flow curve can be plotted based on known 
breakpoints, usually supplied by the PMD manufacturer. 

 

Typical flow characterization (Page 93) 

Example flumes (Page 94) 

Example weir profiles (Page 95) 
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8.6.2.1 Methods to calculate volume flow 
When using the device in a volume flow application, a method of flow calculation must be 
selected. There are two possible methods for calculating volume flow with the device: 
absolute or ratiometric, and different information must be entered for the device to carry out 
the calculation. For more details and an example, refer to Method of flow calculation 
(Page 191). 

8.6.2.2 Common parameters 
These common parameters are required for all installations. 
 
Parameter Sample value 
Operation (Page 46) (set in quick commissioning wiz-
ard), or 
PV selection (02-01.01) (Page 103) (set in navigation 
view) 

Volume flow 

Response rate (Page 49) Medium 
Units (02-02.01) (Page 105) Meters 
Lower calibration point (02-03.03) (Page 110) 1.8 
Upper calibration point (02-03.04) (Page 110) 0.4 
Far range (03-01-02.02) (Page 128) 0.8 

8.6.2.3 Setting zero level 
Many PMDs start flowing higher than the traditional empty distance of the application. 
Account for the volume flow as follows: 

Use parameter "Far range" where the empty level is set to the bottom of the weir and above 
the bottom of the channel. It should be used if the surface monitored can fall past the lower 
calibration point in normal operation without reporting a loss of echo. Set the value for 
parameter "Far range" to the lower calibration point plus the amount by which the surface 
monitored exceeds the lower calibration point. The value for parameter "Far range" can be 
greater than the range of the transmitter 
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① Sensor reference point ⑤ Zero level 
② Upper calibration point ⑥ Level 
③ Lower calibration point ⑦ Material surface 
④ Far range ⑧ Upper scaling point 

The examples on the following pages show this method. 

8.6.2.4 PMDs with exponential level to volume flow function 
For Primary Measuring Devices (PMDs) that measure flow by an exponential equation, use 
these parameters. Ensure that you use the correct exponent for your PMD; the values below 
are samples only. 

Standard weirs 

 
① SITRANS Probe LU240 ③ Level  
② 3 to 4 x levelmax ④ Weir profile 
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Applicable weir profiles 
  

 
 

 
V-notch or  
triangular 

Suppressed  
rectangular 

Cipolleti or  
trapezoidal 

Sutro or  
proportional 

 
Parameter Value 
Primary measuring device (02-06.01) 
(Page 119) 

Exponential devices 

Flow exponent (02-06-05.01) (Page 122) Weir type Value1) 
V-notch 2.50 
Suppressed rectangular 1.50 
Cipolletti or trapezoidal 1.50 
Sutro or proportional 1.00 

Upper scaling point (02-05.05) (Page 118) 
Upper range value (02-04.05) (Page 114) 
Volume flow units (02-06.03) (Page 120) 
Far range (03-01-02.02) (Page 128) 
K-factor (02-06-05.02) (Page 122)2) 
 1)  Values are samples only. Consult weir manufacturer’s documentation for correct flow exponent. 

2)  Required for exponential device absolute calculation only. 
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Parshall flume 

 
① SITRANS Probe LU2401) ④ Direction of flow 
② 2/3 of converging dimension ⑤ Zero level 
③ Converging dimension 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 

Application information 

• Sized by throat width 

• Set on solid foundation 

• For rated flows under free flow conditions, the level is measured at 2/3 the length of the 
converging section from the beginning of the throat section 

 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Exponential devices 
Flow exponent (02-06-05.01) (Page 122) 1.522–1.6071) 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
K-factor (02-06-05.02) (Page 122)2)  
 1) Typical Flow Exponent range for Parshall flume; consult your flume documentation. 

2)  Required for exponential device absolute calculation only. 
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Leopold-Lagco flume 

 
① Throat ④ Diverging 
② SITRANS Probe LU2401) ⑤ Converging 
③ Zero level ⑥ Point of measurement 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Exponential devices 
Flow exponent (02-06-05.01) (Page 122) 1.5471) 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
Volume flow units (02-06.03) (Page 120)  
K-factor (02-06-05.02) (Page 122) 2)  
 1) Typical Flow Exponent range for Parshall flume; consult your flume documentation. 

2)  Required for exponential device absolute calculation only. 

Application information 

• Designed to be installed directly into pipelines and manholes 

• Leopold-Lagco may be classed as a rectangular Palmer-Bowlus flume 

• Sized by pipe (sewer) diameter 

• For rated flows under free flow conditions, the level is measured at a point upstream 
referenced to the beginning of the converging section. Refer to the following table: 
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Flume size Point of measurement 
pipe diameter in inches cm inches 
4-12 2.5 1 
15 3.2 1.25 
18 4.4 1.75 
21 5.1 2 
24 6.4 2.5 
30 7.6 3 
42 8.9 3.5 
48 10.2 4 
54 11.4 4.5 
60 12.7 5 
66 14.0 5.5 
72 15.2 6 

Cut throat flume 

 

Application information 

• Similar to Parshall flume except that the floor is flat bottomed and throat has no virtual 
length. 

• Refer to manufacturer’s specifications for flow equation and point of level measurement. 

 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Exponential devices 
Flow exponent (02-06-05.01) (Page 122) 1.56 - 2.001) 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
Volume flow units (02-06.03) (Page 120)  
K-factor (02-06-05.02) (Page 122) 2)  
 1) Typical flow exponent range for Cut throat flume; consult your flume documentation. 

2)  Required for exponential device absolute calculation only. 
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Khafagi-Venturi flume 

 
① Channel width ④ Zero level 
② 1 x channel width ⑤ SITRANS Probe LU2401) 
③ Direction of flow 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 

Application information 

• Similar to Parshall flume except that the floor is flat bottomed and the sidewalls are 
curved. 

• For rated flows under free flow conditions, the level is measured 1 x (channel width) 
upstream from the beginning of the converging section. 

 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Exponential devices 
Flow exponent (02-06-05.01) (Page 122) 1.55 (Consult your flume documentation.) 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
Volume flow units (02-06.03) (Page 120)  
K-factor (02-06-05.02) (Page 122)1)  
 1)  Required for exponential device absolute calculation only. 
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Applications supported by SITRANS Probe LU240 

Rectangular flume BS 3680/ISO 4373 

 
① SITRANS Probe LU2401) ⑥ Direction of flow 
② Approach width ⑦ Hump height 
③ 3 to 4 x levelmax ⑧ Level 
④ Throat width ⑨ Zero level 
⑤ Throat length 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Rectangular flume BS 3680/ISO 4373 
PMD dimensions (M 02-06-05) (Page 120) Approach width 

Throat width 
Hump height 
Throat length 

Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Round nose horizontal crest weir BS 3680/ISO 4373 

 
① SITRANS Probe LU2401)  ④ Crest height 
② Crest width ⑤ 3 to 4 x levelmax 
③ Crest length ⑥ Level 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Round nose horizontal crest weir 

BS 3680/ISO 4373 
PMD dimensions (M 02-06-05) (Page 120) Crest width 

Crest height 
Crest length 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Trapezoidal flume BS 3680/ISO 4373 

 
① SITRANS Probe LU2401)  ⑧ Zero level 
② Approach width ⑨ Level 
③ 3 to 4 x levelmax ⑩ Hump height 
④ Throat width ⑪ Approach width 
⑤ Throat length ⑫ Throat width 
⑥ Direction of flow 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Trapezoidal flume BS 3680/ISO 4373  
PMD dimensions (M 02-06-05) (Page 120) Slope 

Approach width 
Throat width 
Hump height 
Throat length 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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U-flume BS 3680/ISO 4373 

 
① SITRANS Probe LU2401) ⑥ Direction of flow 
② Approach diameter ⑦ Hump height 
③ 3 to 4 x levelmax ⑧ Zero level 
④ Throat diameter ⑨ Level 
⑤ Throat length 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) U-flume BS 3680/ISO 4373 
PMD dimensions (M 02-06-05) (Page 120) Approach diameter 

Throat diameter 
Hump height 
Throat length 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Finite crest weir BS 3680/ISO 4373 

 
① SITRANS Probe LU2401) ⑤ Direction of flow 
② Crest width ⑥ Zero level 
③ 3 to 4 x levelmax ⑦ Level 
④ Crest length ⑧ Crest height 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Finite crest weir BS 3680/ISO 4373  
PMD dimensions (M 02-06-05) (Page 120) Crest width 

Crest height 
Crest length 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Thin plate rectangular weir BS 3680/ISO 4373 

 
① Approach width ⑤ Zero level 
② SITRANS Probe LU2401) ⑥ Level 
③ 4 to 5 x levelmax ⑦ Crest width 
④ Direction of flow ⑧ Crest height 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Thin plate rectangular weir 

BS 3680/ISO 4373  
PMD dimensions (M 02-06-05) (Page 120) Approach width 

Crest width 
Crest height 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Thin plate V-notch weir BS 3680/ISO 4373 

 
① SITRANS Probe LU2401) ⑤ Zero level 
② Approach width ⑥ Level 
③ 4 to 5 x levelmax ⑦ V-notch angle 
④ Direction of flow ⑧ Crest width 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Thin plate V-notch weir BS 3680/ISO 4373 
PMD dimensions (M 02-06-05) (Page 120) V-notch angle 
Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Rectangular weir contracted 

 
① Approach width ⑤ Zero level 
② SITRANS Probe LU2401) ⑥ Level 
③ 4 to 5 x levelmax ⑦ Crest width 
④ Direction of flow ⑧ Crest height 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Rectangular weir contracted 
PMD dimensions (M 02-06-05) (Page 120) Crest width 
Upper scaling point (02-07.01) (Page 124)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Round pipe flume 

 
① SITRANS Probe LU240 ④ Level 
② This dimension should be at least 15 cm (6") shorter 

than the blanking value  
(see Near range (03-01-02.01) (Page 128)) 

⑤ Pipe diameter 

③ The transducer must be above the upper scaling point by at least the blanking value. 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Round pipe 
PMD dimensions (M 02-06-05) (Page 120) Pipe diameter 

Slope (fall/run) 
Roughness coefficient 

Upper scaling point (02-05.05) (Page 118)  
Far range (03-01-02.02) (Page 128)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119)  
Upper range value (02-04.05) (Page 114)  
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Palmer-Bowlus flume 

 
① Direction of flow ④ Pipe diameter 
② SITRANS Probe LU2401) ⑤ (Pipe diameter)/2, point of measurement2) 
③ Zero level 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 
2) For rated flows under free flow conditions 
 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) Palmer-Bowlus flume 
PMD dimensions (M 02-06-05) (Page 120) Maximum flume width 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119) Ratiometric 

 

 

 Note 
Method of flow calculation 

The Palmer-Bowlus flume can only be set up using ratiometric calculations. 
 

Application information 

• Sized by pipe diameter 

• Flume relief is trapezoidal 

• Designed to install directly into pipelines and manholes 

• Level is referenced to bottom of the throat, not bottom of the pipe 

• For rated flows under free flow conditions, the level is measured at a distance equal to 
(Pipe diameter)/2 upstream from the beginning of the converging section. 
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H-flume 

 
① SITRANS Probe LU2401) ③ Zero level 
② Point of measurement ④ Flume height 
1) The device must be above the upper scaling point by at least the blanking value (Near range (03-01-
02.01) (Page 128)). 

 

 Note 
Method of flow calculation 

H-flume can only be set up using ratiometric calculations. 
 

 

 
Parameter Value 
Primary measuring device (02-06.01) (Page 119) H-flume 
Flow exponent (02-06-05.01) (Page 122) Flume height 
Upper scaling point (02-05.05) (Page 118)  
Upper range value (02-04.05) (Page 114)  
Volume flow units (02-06.03) (Page 120)  
Method of flow calculation (02-06.02) (Page 119) Ratiometric 

Application information 

• Sized by maximum depth of flume 

• Approach is preferably rectangular, matching width and depth for distance 3 to 5 times 
the depth of the flume. 
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• For rated flows under free flow conditions, the level is measured at a point downstream 
from the flume entrance. Refer to the following table. 

 

Flume size Point of measurement 
diameter in feet cm inches 
0.5 5 1.75 
0.75 7 2.75 
1.0 9 3.75 
1.5 14 5.5 
2.0 18 7.25 
2.5 23 9 
3.0 28 10.75 
4.5 41 16.25 

• H-flumes come with a flat or sloping floor. The same flow table can be used because error 
is less than 1%. 

Custom calculation support 
When the primary measuring device (PMD) does not fit one of the standard types, it can be 
configured using a custom characterization. Define your PMD using Custom (M 02-07) 
(Page 124). 

For this curve, both level and volume flow breakpoints (X-value, Y-value, up to 32) are 
entered to define the flow. The device supports a linear flow calculation shown in the 
following chart. (The method of flow calculation for custom support can be ratiometric or 
absolute. Refer to your PMD manufacturer’s documentation.) 

Typical flow characterization 

 

Characterization is achieved by entering the level and corresponding volume flow 
breakpoints, either from empirical measurement or from the manufacturer's specification. 
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Increasing the number of defined breakpoints will increase the accuracy of the volume flow 
measurement.  

Breakpoints should be concentrated in areas exhibiting the higher degrees of nonlinear flow. 
A maximum of 32 breakpoints can be defined, with a minimum of four required. The curve’s 
end point is always specified by parameter "Upper scaling point", for maximum volume or 
maximum flow. ("Upper scaling point" is set by parameter "Upper range value" in "Quick 
commissioning wizard".)  

This parameter value is in addition to the 32 breakpoints available for definition.  

Use as many breakpoints as required by the complexity of your PMD. For more information, 
refer to Characterization chart (Page 95).  

Example flumes 
These example flumes would both require a custom calculation using a characteristic curve. 

Trapezoidal flume 

 

 

Dual range (nested) Parshall 
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Example weir profiles 
These weirs could require a custom calculation using a characteristic curve. 
 
  

 
 
Contracted  
regular 

Compound Poebing Approximate  
exponential 

 
 
   
   

8.7 Custom application 

8.7.1 Characterization chart 
Regardless of whether you wish to measure volume or volume flow, if you cannot use a pre-
defined vessel (Vessel shape (02-05.01) (Page 117)) or PMD (Primary measuring device (02-
06.01) (Page 119)), you must configure a custom application. 

Configure a custom application by setting parameter "Operation" (in quick commissioning 
wizard), or "PV selection" (in navigation view) to option "Custom", then define your 
vessel/PMD using Custom (M 02-07) (Page 124). 

Up to 32 breakpoints, each consisting of an input and output value (X- and Y-value), are 
available to define your vessel shape/PMD. 

• For a custom volume characteristic curve, X-values refer to level, Y-values refer to volume. 

• For a custom volume flow characteristic curve, X-values refer to level, Y-values refer to 
volume flow. 
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1. Plot a chart. Usually a vessel supplier will provide this chart. However, if you have a custom-
built vessel/PMD, then you will need access to complete drawings, or accurate 
measurements. 

2. Enter the curve values from this chart using "X-value n", "Y-value n" breakpoints, where 'n' is 
the breakpoint number 1 to 32. 

 
  Note 

If breakpoints are entered via local display, then an upload is performed via SIMATIC PDM, 
a second upload via PDM may be necessary to transfer the breakpoint values.  

 

3. Ensure extra points are added around sharp transitions in the vessel/PMD (e.g: steps in a 
vessel wall). 

 
  Note 

The end points in the curve are 0,0 (fixed), and the point defined by parameter "Upper 
scaling point" for maximum volume or maximum flow. 
("Upper scaling point" is set by parameter "Upper range value" in "Quick commissioning 
wizard".)  

 

Example chart for custom volume characterization (with 15 of possible 32 breakpoints 
defined):  
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Parameter Value Description 
X-value 1 0.0  

 
 
 
 
 
 
 
 
 

Determines the level break-
points at which the volume 
breakpoints are known. 

X-value 2 0.8 
X-value 3 2.0 
X-value 4 3.5 
X-value 5 4.1 
X-value 6 4.7 
X-value 7 5.1 
X-value 8 5.2 
X-value 9 5.3 
X-value 10 5.4 
X-value 11 5.5 
X-value 12 5.6 
X-value 13 6.0 
X-value 14 7.2 
X-value 15 9.0 

 

 
Parameter Value Description 
Y-value 1 0.0  

 
 
 
 
 
 
 

 
Determines the volume break-
points which correspond to the 
level breakpoints. 

Y-value 2 2.1 
Y-value 3 4.0 
Y-value 4 5.6 
Y-value 5 5.9 
Y-value 6 6.3 
Y-value 7 6.7 
Y-value 8 7.1 
Y-value 9 7.8 
Y-value 10 8.2 
Y-value 11 8.8 
Y-value 12 9.2 
Y-value 13 10.9 
Y-value 14 13.0 
Y-value 15 15.0 

For more details regarding characterization, refer to Volume calculation (Page 188), or 
Volume flow calculation (Page 189). 

8.8 Simulation 
Process values, loop current, and diagnostics can be simulated with this device. Loop current 
can be simulated via the HMI, or via an engineering system such as SIMATIC PDM. Process 
values and diagnostics can be simulated via a remote engineering system. 

[Specific device versions (6 m, 12 m) support HART communication protocol.] 
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Current output simulation 

The current output can also be simulated using Loop test wizard (03-03.01) (Page 136). 

A simulated value (from a preset selection, or a value set by customer) can be set to test the 
functioning of the mA connections during commissioning or maintenance of the device. The 
range is 3.55 mA to 22.8 mA. 

 
① Normal operation ④ Upper saturation limit (factory 

setting) 
② Lower fault current (factory setting) ⑤ Upper fault current (factory 

setting) 
③ Lower saturation limit (factory setting)   

 

 Note 
Simulated current output 

The simulated current output value influences output to the control system. 
 

In general, to simulate current output: 

1. Run the "Loop test wizard" from the menu "Maintenance and diagnostics > Loop test" on the 
device (or from the Device menu in SIMATIC PDM). 

– Select a preset mA value, or enter a custom value. (Custom value can be entered by 
selecting "User" option on device, or "Other" option in PDM.) 

2. Start the loop test. 

3. When you are ready to end the simulation, stop the loop test by exiting the wizard. The 
device returns to the actual output value. 

Process value simulation 

Process value simulation is an iterative process whereby parameters are adjusted and 
corresponding results are displayed. Process values can only be simulated using a remote 
engineering system, but when a simulation is active, it will be represented by the fault code 
"Cb" and corresponding symbol appearing on the device display. 

 

 Note 
Simulation enabled 
• Simulation fault code "Cb" will show on local display even if other faults are present. 
• Simulation fault code and corresponding symbol are shown with a cyan background in the 

EDD. 
 



 Operating 
 8.8 Simulation 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 99 

When Simulation is enabled, some of the device's configured functionality will respond to the 
simulated value, including: 

• Limit monitoring: Any warnings and process alarms that have been configured, will 
activate based on the simulated value. 

• Logging: Log files will reflect the simulated values. 

• Milliamp output: The loop current output will also track the corresponding process value 
it has been configured to read. 

The following function will not respond to the simulated value when simulation is enabled: 

• Fault conditions: The device will never enter the fail-safe state when in simulation mode. 
Faults that would normally cause a fail-safe condition (such as a broken cable) may still 
occur, but a fail-safe condition will not be reported on the device during simulation. 

In general, to simulate a process value via PDM: 

1. Go to the Device menu in PDM, and choose "Simulation > Process values". (For parameter 
details, see Simulation (Page 206)). 

2. Set a simulation mode. 

3. Set simulation value, and any parameters for a ramp simulation. 

4. Start simulation (click "Transfer" button). 

(The status of the simulation can be monitored in the PDM menu "View > Process values".) 

To stop simulation at any time, change parameter "Simulation mode" to "Disabled".  

Simulating a fixed process value  

1. Set parameter "Simulation mode" to "Enabled" to simulate a fixed process value. 

2. Set parameter "Simulation value" to the desired fixed value for the simulation. 

3. Set parameter "PV status" to the status to simulate. 

4. Click "Transfer" button to start the simulation. 

5. Set parameter "Simulation mode" to "Disabled" to stop the simulation. 

Simulating a changing process value  

1. Set parameter "Simulation mode" to "Ramp" to simulate a changing process value. 

2. Set parameter "Simulation value" to the desired starting value for the simulation. 

3. Set parameter "PV status" to the status to simulate. 

4. Set parameter "Ramp end" to stop the simulation when the process value reaches the ramp 
end value. 

5. Set parameter "Ramp steps" to set the number of steps in the ramp simulation. 

6. Set parameter "Ramp duration" to set the time interval (in seconds) for each step in the 
simulation. 

7. Click button "Transfer" to start the simulation. 

The simulated level will initially begin ramping up from the simulation value. When the 
process value rises to 100% or falls to 0%, it reverses direction at the same rate. The 
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simulation will stop based on the ramp end value, but ensure parameter "Simulation mode" is 
set to "Disabled" before the current output is returned to automatic control. 

Application test  

You can test the application by varying the actual process value (the preferred test method), 
or by simulating changes to the process value. 

When simulating a changing process value, run a complete cycle to verify that device 
operates as expected. Monitor system performance carefully, under all anticipated operating 
conditions.  

1. When the device performs exactly as required, programming is complete. 

2. If alternate measurement units, or fail-safe action is desired, update the parameters for the 
new functionality. 

3. If you experience problems with system performance, see Diagnosing and troubleshooting 
(Page 155). 

If you cannot observe all possible operating conditions by varying the process value, use the 
simulation process above to verify programming.  

Retest the system each time you adjust any parameters. 

Diagnostic simulation 

Diagnostics can be simulated via a remote engineering system. Diagnostics related to "Device 
status", "Limit monitoring and event counter", and "HART status" can be chosen from a select 
list to simulate. 

In general, to simulate diagnostics via PDM: 

1. Go to the menu "Device" in PDM and choose "Simulation > Diagnostics". 

2. On the tab "Diagnostics simulation", click button "Enable" (button toggles between "Enable" 
and "Disable") to put the device in simulation mode. 

3. Select the diagnostics to simulate from the drop-down list provided for the "Diagnostics" 
field. 

4. For each diagnostic selected, set the "Action" to be simulated: "On" or "Off". 

5. Start simulation (click "Transfer" button). 

The status of the simulation for each diagnostic selected, can be seen on the remaining tabs 
in the dialogue window. The diagnostic being simulated will show a checked box. 

End simulation on the tab "Diagnostics simulation": 

• To end simulation of a specific diagnostic, click the button "Enable/Disable Simulation" 
(below the "Action" field). 

• To stop device simulation at any time, click the toggle button at the top of the window 
from "Enable" to "Disable". 
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8.9 Communication system 
SITRANS Probe LU240 (6 m and 12 m version) is a transmitter capable of communicating 
process information to a Supervisory Control and Data Acquisition (SCADA) system, via a 
HART modem. 

 

Further information can be found in HART communication (Page 196). 
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 Parameter assignment - Local 9 
 

 

This chapter includes all parameters accessible via local operation.  

Parameters are identified by name (followed by parameter number in parenthesis), and 
organized into function groups within a menu structure.  

See HMI menu structure (Page 242) for a list of abbreviated parameter names, as they appear 
on the device. 

 

 Note 
• In Navigation view, local buttons (    ) navigate in the direction of the arrow. 
• Press  button to open Edit Mode, or to save a modification. 

 

For other parameters accessible only via an engineering system (such as SIMATIC PDM, or 
AMS Device Manager), see Parameter assignment - Remote (Page 142). 

9.1 Quick start (M 01) 
From measurement view, press  button to enter parameter view, then press  button to 
select the "Quick commissioning wizard". Press  button to open the first step, and follow 
the instructions.  

 

 Note 

Do not use a quick commissioning wizard to modify individual parameters. (Perform 
customization for your application only after "Quick commissioning wizard" has been 
completed). 

 

• See Quick commissioning via HMI (Page 42). 

• See Quick commissioning via SIMATIC PDM (Page 203). 

9.1.1 Quick commissioning (01-01) 
Provides step-by-step procedure to set up common applications easily. 

9.1.2 AFES wizard (01-02) 
Used to prevent false echo detection over a specified range. 
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9.2 Setup (M 02) 
The following parameters relate to device setup. 

9.2.1 Select output (M 02-01) 

9.2.1.1 PV selection (02-01.01) 
Sets the primary variable by selecting a process value that corresponds to the loop current. 

 

 Note 
Settings for 3 m version 

3 m version can be configured for level, space, and distance applications only. 
 

 
Setting Level LEVEL 

Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 

Default Distance DIST 
 

 Note 
Start view set automatically by wizard 

The process value to display on device after power on is set automatically by the "Quick 
commissioning wizard". 
• When parameter "Operation" is set in the wizard, the value is written to parameter "Start 

view". 
• If a change is made to parameter "Start view" or parameter "PV selection" after running the 

wizard, the last one set will apply. 
• Options "Volume", "Volume flow", and "Custom" are not visible in measurement view 

until configured. If one of these unconfigured options is selected in parameter "Start 
view", measurement view will show the next visible process value. 
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① Distance ⑤ Lower calibration point 
② Space ⑥ Far range 
③ Upper calibration point ⑦ Level 
④ Sensor reference point   

 
① Sensor reference point ⑤ Zero level (head) 
② Upper calibration point ⑥ Level (head) 
③ Lower calibration point ⑦ Material surface 
④ Far range ⑧ Upper scaling point (maximum volume/flow) 
 
Option Description Reference point 
Level  Distance to material surface Lower calibration point (process empty level) 
Space  Distance to material surface Upper calibration point (process full level) 
Distance Distance to material surface Sensor reference point 

 
Volume Volume of material in Volume units 

(based on level) 
Lower calibration point 

Volume flow Flow rate in an open channel in Volume 
flow units 

Zero level, zero flow 

9.2.1.2 SV selection (02-01.02) 
Sets a process value as secondary variable. 
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 Note 
Settings for 3 m version 

3 m version can be configured for level, space, and distance applications only. 
 

 

 
Setting 
 

Level LEVEL 
Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 
Sensor temperature STEMP 

Default Sensor temperature STEMP 

9.2.1.3 Linearization type (02-01.03) 
Sets type of linearization used to calculate volume or volume flow. 
 
Setting None NONE 

Volume VOL 
Volume flow VFLOW 
Custom CUSTM 

Default None NONE 

9.2.2 Sensor (M 02-02) 

9.2.2.1 Units (02-02.01) 
Sets measurement units used. 
 
 Default 
Setting Meters m 3 decimal places 

Centimeters cm 1 decimal place 
Millimeters mm 0 decimal places 
Feet Ft 3 decimal places 
Inches in 2 decimal places 

Default Meters m 3 decimal places 
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 Note 
Dynamic decimal places 

Each setting for parameter "Units" has a default number of decimal places used to show the 
process value on the local display. However, if the value is too large to show on the segment 
display, the decimal places will be automatically adjusted to show the process value. 

 

 

 Note 
Process value too large to display 

In some cases, even with dynamic decimal places, it is possible that the process value be too 
large to show on the local display, "#####" will show instead. 

If this occurs in a typical application: 
• Adjust parameter "Units" so that a smaller value can be shown, e.g. use meters instead of 

millimeters. 

If this occurs in a custom application: 
• Adjust parameter "Custom units" so that a smaller value can be shown, e.g. use tons 

instead of pounds. 
• Note that a change to custom units also requires a scaling adjustment (see Upper range 

value (02-04.05) (Page 114)). 
 

Custom units can only be defined via remote operation (see Custom units (Page 144)). 

9.2.2.2 Fill rate (02-02.02) 
Sets the maximum fill rate the device can track. Used to enhance the process value damping. 

Enter a value slightly greater than the vessel's maximum filling rate. 
 
Setting 0 to 99999 
Default 0.1 m/min 

 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

9.2.2.3 Empty rate (02-02.03) 
Sets the maximum empty rate the device can track. Used to enhance the process value 
damping. 
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Enter a value slightly greater than the vessel’s maximum emptying rate. 
 
Setting 0 to 99999 
Default 0.1 m/min  

 

 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

9.2.3 Calibration (M 02-03) 

9.2.3.1 Auto sound velocity wizard (02-03.01) 
Used to adjust the speed of sound, based on an actual measurement, to change the distance 
value. 

 

 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 

 

 

 Note 
Distance measurement used in calibration wizards is important 

To successfully calibrate using "Auto sound velocity wizard" and "Sensor offset wizard", the 
distance must be set correctly:  
• Wizards cannot be performed using the same distance for each 
• Distance set in "Auto sound velocity wizard" must be greater than distance set in the 

"Sensor offset wizard" 
• "Auto sound velocity wizard" must be performed outside of the short shot range (i.e. set 

distance greater than 1.0 meter). 
 

Via SIMATIC PDM, go to menu "Device > Auto sound velocity wizard". 
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Conditions for use of this feature: 

• The acoustic beam atmosphere is other than air 

• The acoustic temperature is unknown 

• The reading accuracy is acceptable at higher material levels only 

For best results, calibrate with the level at a known value near low calibration point. 

Using Auto sound velocity 

Start with a steady distance at a known high distance value (high distance value equates to a 
low level value). 

1. Review the distance measurement via local display for approximately 30 seconds to verify 
repeatability. 

2. Measure the actual distance (for example, with a tape measure). 

3. Enter the actual distance, defined in parameter "Units". 

Repeat this procedure if the atmosphere type, concentration, or temperature conditions are 
different from when the last sound velocity calibration was performed. 

Actual distance 
The true measurement that the user has measured in vessel. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 0 

Confirm 
Applies settings as last step in wizard. 
 
Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 

9.2.3.2 Sensor offset wizard (02-03.02) 
Used to calculate sensor offset, based on an actual measurement, to change the distance 
value. 
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 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 

 

 

 Note 
Distance measurement used in calibration wizards is important 

To successfully calibrate using "Auto sound velocity wizard" and "Sensor offset wizard", the 
distance must be set correctly:  
• Wizards cannot be performed using the same distance for each 
• Distance set in "Auto sound velocity wizard" must be greater than distance set in the 

"Sensor offset wizard" 
• "Auto sound velocity wizard" must be performed outside of the short shot range (i.e. set 

distance greater than 1.0 meter). 
 

Via SIMATIC PDM, go to menu "Device > Sensor offset wizard". 

Actual distance 
The true measurement that the user has measured in vessel. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 0 

Confirm 
Applies settings as last step in wizard. 
 
Setting Yes. Wizard completes and settings are applied. YES 

No. Returned to start of wizard. (Settings are saved to perform 
wizard again, but not applied until "Confirm" set to "YES".)  

NO 

Default No NO 
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9.2.3.3 Lower calibration point (02-03.03) 
Sets distance from sensor reference point to lower calibration point: usually process empty 
level. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default • 3 m (3 m device) 
• 6 m (6 m version) 
• 12 m (12 m version) 

Defined in parameter "Units". 

9.2.3.4 Upper calibration point (02-03.04) 
Sets distance from sensor reference point to upper calibration point: usually process full level. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 0 m 

Defined in parameter "Units". 

9.2.3.5 Lower level point (02-03.05) 
Sets level value when material is at lower calibration point. 
 
Setting -99999 to 99999 m 
Default 0  

9.2.3.6 Upper level point (02-03.06) 
Sets level value when material is at upper calibration point. 
 
Setting -99999 to 99999 m 
Default • 3 m (3 m version) 

• 6 m (6 m version) 
• 12 m (12 m version) 

9.2.3.7 Sensor offset (02-03.07) 
Sets offset to compensate for changes in sensor reference point. 

Changes to sensor reference point may result from adding a thicker gasket or reducing the 
standoff/nozzle height. 
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Setting -99.999 to 99.999 m 
Default 0  

If amount of parameter "Sensor offset" is known, enter the constant that can be added to or 
subtracted from sensor value1) to compensate if the sensor reference point has shifted. 
1) The value produced by the echo processing which represents the distance from sensor 
reference point to the target 

9.2.3.8 Sound velocity (02-03.08) 
Displays calculated velocity at measured temperature of medium. 

Units displayed in meters per second (m/s). 

9.2.3.9 Sound velocity (20 °C) (02-03.09) 
Sets velocity of sound in medium at 20 °C. 
 
Setting Not limited 
Default 344.13 m/s 

If the acoustic beam atmosphere sound velocity at 20 °C (68 °F) is known, and the sound 
velocity vs. temperature characteristics are similar to that of air (344.1 m/s), enter the sound 
velocity. Units displayed in meters per second (m/s). 

9.2.3.10 Short shot frequency (02-03.10) 
Sets short shot transmit pulse frequency, in kHz. 
 
Setting 40000 to 75000 Hz 
Default 54000 Hz 

9.2.3.11 Long shot frequency (02-03.11) 
Sets the long shot transmit pulse frequency, in kHz. 
 
Setting 40000 to 75000 Hz 
Default 54000 Hz 

9.2.3.12 Low-level cutoff (02-03.12) 
Sets lower limit on measured value (before any offset applied). 

For example, set value to zero to prevent a negative level measurement. 
 
Setting -999 to 0 m 
Default -999 m 
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 Note 
Default value disables parameter 

By using the default value of -999 m, or a lower value, the parameter "Low-level cutoff" is 
disabled. 

To enable "Low-level cutoff", set a value greater than the default, e.g. -998 or higher. 
 

9.2.4 Current output (M 02-04) 

 
① Sensor reference point ⑥ Distance 
② Upper calibration point ⑦ Material level 
③ 20 mA 100% ⑧ Level 
④ Space ⑨ Lower calibration point 
⑤ 4 mA 0%   

 
① Sensor reference point ⑤ Zero level (head) 
② Upper calibration point ⑥ Level (head) 
③ Lower calibration point ⑦ Material surface 
④ Far range ⑧ Upper scaling point (maximum volume/flow)1) 
1) Refer to PMD supplier documentation. 
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9.2.4.1 Loop current mode (02-04.01) 
Sets operation of Loop current for HART multidrop mode. 
 
Setting Enabled ON 

Disabled OFF 
Default Enabled ON 

The device is in loop current mode by default. Disabling parameter "Loop current mode" will 
result in a fixed loop current setting for multidrop operation (see Loop current value in 
multidrop mode (02-04.02) (Page 113)). 

9.2.4.2 Loop current value in multidrop mode (02-04.02) 
Sets mA value for loop current in HART multidrop mode. 
 
Setting 3.6 to 22.8 mA 
Default 4 mA 

9.2.4.3 Damping value (02-04.03) 
Sets the damping (filtering) of the PV to smooth out response to sudden changes in 
measurement. 

An increase of damping increases response time of device, and affects digital value and loop 
current. If output values are noisy, increase parameter "Damping value". For faster response 
time, decrease parameter "Damping value". Find a value that meets requirements of signal 
stability and response time. 
 
Setting 0 to 100 s  
Default 0 s 

 

 Note 
Damped PV 

All process values are damped by the value in parameter "Sensor damping value".  

The process value that is set as the primary variable (PV) for the application can be damped 
further using value in parameter "Damping value". 

 

9.2.4.4 Lower range value (02-04.04) 
Sets process value that corresponds to 4 mA loop current. 
 
Setting -99999 to +99999  

(based on PV, setting for PV of Level shown here) 
Default 0 ("Units" based on PV) 
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 Note 
Setting for parameter "Lower range value" is based on selected PV 
• PV set to Level, Space - Setting based on parameter "Lower level point" 
• PV set to Distance - Setting based on parameter "Upper calibration point" 
• PV set to Volume - Setting based on parameter "Upper scaling point" in "Volume" menu 
• PV set to Volume flow - Setting based on parameter "Upper scaling point" in "Volume flow" 

menu 
• PV set to Custom - Setting based on parameter "Upper scaling point" in "Custom" menu 

 

 Note 
Parameter "Lower range value" is limited when PV set to Level or Space 

When PV is set to Level or Space, the setting for parameter "Lower range value" is limited by 
the setting for parameter "Lower level point".  
• If desired setting for parameter "Lower range value" is greater than the current setting in 

parameter "Lower level point", it is necessary to first set parameter "Lower level point" to a 
value equal to, or greater than the desired value for parameter "Lower range value". 

 

9.2.4.5 Upper range value (02-04.05) 
Sets process value that corresponds to 20 mA loop current. 
 
Setting -99999 to +99999  

(based on PV, setting for PV of Level shown here) 
Default 12 ("Units" based on PV) 

 

 

 Note 
Setting for parameter "Upper range value" is based on selected PV 
• PV set to Level, Space - Setting based on parameter "Upper level point" 
• PV set to Distance - Setting based on parameter "Lower calibration point" 
• PV set to Volume - Setting based on parameter "Upper scaling point" in "Volume" menu 
• PV set to Volume flow - Setting based on parameter "Upper scaling point" in "Volume flow" 

menu 
• PV set to Custom - Setting based on parameter "Upper scaling point" in "Custom" menu 
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 Note 
Parameter "Upper range value" is limited when PV set to Level or Space 

When PV is set to Level or Space, the setting for parameter "Upper range value" is limited by 
the setting for parameter "Upper level point".  
• If desired setting for parameter "Upper range value" is greater than the current setting in 

parameter "Upper level point", it is necessary to first set parameter "Upper level point" to a 
value equal to, or greater than the desired value for parameter "Upper range value". 

 

 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

 

 Note 
Changing custom units 

If a change is made to custom units, be sure to rescale the output, as rescaling for custom 
units is not handled automatically by the device. 
• Use parameters "Upper range value" and "Upper scaling point" to rescale output. 

 

9.2.4.6 Lower saturation limit (02-04.06) 
Sets lower limit for saturation range (4 mA to parameter "Lower saturation limit"), past which 
the loop current cannot decrease. 
 
Setting 3.55 to 4 mA 
Default 3.8 mA 

9.2.4.7 Upper saturation limit (02-04.07) 
Sets upper limit for saturation range (20 mA to parameter "Upper saturation limit"), past 
which the loop current cannot increase. 
 
Setting 20 to 22.8 mA 
Default 20.5 mA 

9.2.4.8 Lower fault current (02-04.08) 
Sets Lower fault current in Non-safety mode. 
 
Setting 3.55 to 4.0 mA 
Default 3.55 mA 
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9.2.4.9 Upper fault current (02-04.09) 
Sets Upper fault current in Non-safety mode. 
 
Setting 20.0 to 22.8 mA 
Default 22.8 mA 

9.2.4.10 Fault current (02-04.10) 
Defines behavior when Fail-safe is initiated. 
 
Setting Upper fault current UPPER 

Lower fault current LOWER 
Default Lower fault current LOWER 

See Fault codes and corrective actions (Page 158) for a list of faults that initiate Fail-safe, 
causing "Fault current" setting to display. 

9.2.4.11 Fail-safe loss of echo (02-04.11) 
Defines fail-safe behavior when fail-safe loss of echo occurs and fail-safe LOE timer expires. 
 
Setting Hold HOLD Last valid reading 

Fault current FAULT Value set in parameter "Fault current" 
Default Hold HOLD 

9.2.4.12 Fail-safe LOE timer (02-04.12) 
Sets amount of time loss of echo will persist before device enters fail-safe mode. 
 
Setting 0 to 720 s 
Default 100 s 

9.2.5 Volume (M 02-05) 
 

 Note 
Menu visibility 

This menu will not appear on device unless it is configured. 
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9.2.5.1 Vessel shape (02-05.01) 
Sets vessel shape, and allows device to calculate volume in addition to level. 

 
 Display name/description Vessel shape Other parameter settings required 
Setting LINR 

Linear vessel 

 

Upper scaling point 

CONIC 
Conical bottom vessel 

 

Upper scaling point, Vessel dimension A 

PARAB 
Parabolic bottom vessel 

 

Upper scaling point, Vessel dimension A 

HALF 
Half sphere bottom vessel 

 

Upper scaling point, Vessel dimension A 

FLAT 
Flat sloped bottom vessel 

 

Upper scaling point, Vessel dimension A 

CYLIN 
Cylinder vessel 

 

Upper scaling point 

PARAE 
Parabolic ends vessel 

 

Upper scaling point, Vessel dimension A, Vessel 
dimension L 
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SPHER 
Sphere vessel 

 

Upper scaling point 

Default LINR Linear vessel  
 ① Dimension A ② Dimension L  

9.2.5.2 Vessel dimension A (02-05.02) 
Sets height of vessel bottom when bottom is conical, parabolic, half spherical, or flat sloped. 
If horizontal parabolic ends vessel, sets depth of end. 
 
Setting 0 to 99.999 m 
Default 0 

See Vessel shape (02-05.01) (Page 117) for illustration. 

9.2.5.3 Vessel dimension L (02-05.03) 
Sets length of cylindrical section of horizontal parabolic ends vessel. 
 
Setting 0 to 99.999 m 
Default 0 

See Vessel shape (02-05.01) (Page 117) for illustration. 

9.2.5.4 Volume units (02-05.04) 
Sets volume measurement units. 
 
Setting 
 
 

Cubic meters m3 
Liters l 
US gallons Ga 
Imperial gallons IGa 

Default Cubic meters m3 

9.2.5.5 Upper scaling point (02-05.05) 
Sets maximum scaled measurement value. 
 
Setting 0 to 9999.999 m3 
Default 0.1 m3  
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 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

9.2.6 Volume flow (M 02-06) 
 

 Note 
Menu visibility 

This menu will not appear on device unless it is configured. 
 

9.2.6.1 Primary measuring device (02-06.01) 
Sets the type of primary measuring device (PMD) used. 
 
Setting Exponential devices EXPON 

Rectangular flume BS 3680/ISO 4373 RECFL 
Round nose horizontal crest weir BS 3680/ISO 4373 RNHWR 
Trapezoidal flume BS 3680/ISO 4373 TRPFL 
U-flume BS 3680/ISO 4373 UFLM 
Finite crest weir BS 3680/ISO 4373 FINWR 
Thin plate rectangular weir BS 3680/ISO 4373 TPRWR 
Thin plate V-notch weir BS 3680/ISO 4373 TPVWR 
Rectangular weir contracted RWRC 
Round pipe RPIPE 
Palmer-Bowlus flume PBFLM 
H-flume HFLM 

Default Exponential devices  EXPON 

9.2.6.2 Method of flow calculation (02-06.02) 
Sets method of flow calculation. 
 
Setting Absolute ABS 

Ratiometric RATIO 
Default Absolute ABS 

Set this parameter to "Ratiometric" only if the primary measuring device (PMD) supports 
ratiometric calculations. (Note that Palmer Bowlus Flume and H-Flume support ratiometric 
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calculations only.) For more details on absolute and ratiometric calculations, see Method of 
flow calculation (Page 191). 

9.2.6.3 Volume flow units (02-06.03) 
Sets measurement units used when parameter "PV selection" set to "Volume flow". 
 
Setting 
 

Liters per second l/S 
Liters per minute l/m 
Cubic feet per second Ft3/S 
Cubic feet per day Ft3/d 
US gallons per minute Ga/m 
US gallons per day Ga/d 
Imperial gallons per minute IGa/m 
Imperial gallons per day IGa/d 
Cubic meters per hour m3/h 
Cubic meters per day m3/d 
US million gallons per day MGl/d 

Default Liters per second l/S 

9.2.6.4 Upper scaling point (02-06.04) 
Sets maximum scaled measurement value. 
 
Setting 0 to 9999999 
Default 100 liters per second 

 

 

 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

9.2.6.5 PMD dimensions (M 02-06-05) 
Sets dimensions of primary measuring device (PMD), to calculate volume. 

The following table is a reference to the parameters that must be set for each PMD. 
 
Supported 
PMD 

Dimensions required 

Exponential devices 
 Flow exponent 
 K-factor 
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Supported 
PMD 

Dimensions required 

Rectangular flume BS 3680/ISO 4373 
 OCM dimension 1: Approach width  
 OCM dimension 2: Throat width 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
Round nose horizontal crest weir BS 3680/ISO 4373 
 OCM dimension 1: Crest width 
 OCM dimension 2: Crest height 
 OCM dimension 3: Crest length 
Trapezoidal flume BS 3680/ISO 4373 
 OCM dimension 1: Approach width 
 OCM dimension 2: Throat width 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
 Slope 
U-flume BS 3680/ISO 4373 
 OCM dimension 1: Approach diameter 
 OCM dimension 2: Throat diameter 
 OCM dimension 3: Hump height 
 OCM dimension 4: Throat length 
Finite crest weir BS 3680/ISO 4373 
 OCM dimension 1: Crest width 
 OCM dimension 2: Crest height 
 OCM dimension 3: Crest length 
Thin plate rectangular weir BS 3680/ISO 4373 
 OCM dimension 1: Approach width 
 OCM dimension 2: Crest width 
 OCM dimension 3: Crest height 
Thin plate V-notch weir BS 3680/ISO 4373 
 V-Notch angle 
Rectangular weir contracted 
 OCM dimension 1: Crest width 
Round pipe 
 OCM dimension 1: Pipe diameter 
 Slope 
 Roughness coefficient 
Palmer-Bowlus flume 
 OCM dimension 1: Maximum flume width 
H-flume 
 OCM dimension 1: Flume height 
Custom  
 Volume (up to 32) 
 Flow (up to 32) 
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Flow exponent (02-06-05.01) 
Sets exponent for flow calculation formula. 
 
Setting -999 to 9999 
Default 1.55 

Use if parameter "Primary measuring device" is set to "Exponential devices". The flow 
exponent is used to create an exponential curve with end points set by "Upper scaling point" 
and Zero level (head), and with the curve based on the specified exponent. 

 

The exponential equation is 

Q = KHFlow exponent 

Where: 

Q = flow 

K = constant factor 

H = level (head) 

Use the exponent specified by the PMD manufacturer, if available, or relevant Open Channel 
Monitoring reference material. 

K-factor (02-06-05.02) 
Sets constant used in volume flow calculation formula, for absolute calculation of 
exponential device only. 
 
Setting -999 to 99999 
Default 1.0 
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Use if parameter "Primary measuring device" is set to "Exponential devices". The constant 
factor (K-factor) is used to create an exponential curve with end points set by "Upper scaling 
point" and Zero level (head), and with the curve based on the specified exponent. 

 

 Note 
Accurate flow calculation 

In a volume flow application using exponential device, and absolute method of flow 
calculation, the following must be consistent for flow calculation to be valid: 
• Engineering units for level (parameter "Units") 
• Engineering units for volume flow (parameter "Volume flow units") 
• Constant factor (parameter "K-factor"). 

 

V-notch angle (02-06-05.03) 
Sets V-notch angle used in volume flow calculation formula. 
 
Setting 25° to 95° 
Default 25° 

Use when parameter "PMD dimensions" is set to "Thin plate V-Notch weir BS 3680/ISO 4373". 

Slope (02-06-05.04) 
Sets flow slope used in volume flow calculation formula. 
 
Setting 0 to 1 
Default 0 

Use when parameter "PMD dimensions" is set to "Trapezoidal flume BS 3680/ISO 4373" or 
"Round pipe". 

Roughness coefficient (02-06-05.05) 
Sets flow roughness coefficient used in volume flow calculation formula. 
 
Setting -999 to 9999 
Default 0 

Use when parameter "PMD dimensions" is set to "Round pipe". 

OCM dimension 1 (02-06-05.06) 
Sets OCM dimension for each directly supported primary measuring device (PMD). 

See table under parameter "PMD dimensions" to relate "OCM Dimension 1 - 4" to a specific 
dimension for each directly supported primary measuring device. For PMDs that are not 
directly supported, use a universal flow calculation. See Custom calculation support 
(Page 93). 
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For more information, see Open Channel Monitoring (OCM) (Page 74). 

OCM dimension 2 (02-06-05.07) 
See OCM dimension 1 (02-06-05.06) (Page 123). 

OCM dimension 3 (02-06-05.08) 
See OCM dimension 1 (02-06-05.06) (Page 123). 

OCM dimension 4 (02-06-05.09) 
See OCM dimension 1 (02-06-05.06) (Page 123). 

9.2.7 Custom (M 02-07) 
 

 Note 
Menu visibility 

This menu will not appear on device unless it is configured. 
 

9.2.7.1 Upper scaling point (02-07.01) 
Sets maximum scaled measurement value. 
 
Setting 0 to 9999999 
Default 100 <Custom units> 

 

 

 Note 
"Upper range value" (URV) versus "Upper scaling point" 
• When parameter "Upper range value" is set within the "Quick commissioning wizard", it 

automatically sets the "Upper scaling point" to the same value. 
• Setting a value for either parameter outside of the wizard, will not automatically adjust 

the other value. 
 

9.2.7.2 Customized characteristic curve (M 02-07.02) 
Used to enter Level and Output breakpoints for universal Primary measuring device (PMD). 
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If the shape of vessel (volume) or PMD (volume flow) is more complex than any of the 
preconfigured shapes, you can define the shape as a series of segments. A value is assigned 
to each input (level) breakpoint and a corresponding value is assigned to each output 
(volume or volume flow) breakpoint.  

• Level values are defined in Units (02-02.01) (Page 105). 

• Volume values are defined in Volume units (02-05.04) (Page 118). 

• Volume flow values are defined in Volume flow units (02-06.03) (Page 120). 

For more information, see Volume calculation (Page 188) , or Volume flow calculation 
(Page 189). 

Custom units can only be defined via remote operation (see Custom units (Page 144)). 

X-value 1...X-value 32 (02-07-02.01) 
Sets level breakpoints for which output is known.   
 
Setting -9999999 to +9999999 
Default 0 

Y-value 1...Y-value 32 (02-07-02.02) 
Sets output corresponding to each input breakpoint entered.   
 
Setting -9999999 to +9999999 
Default 0 

9.2.8 Local display (M 02-08) 

9.2.8.1 Start view (02-08.01) 
Sets process value shown first on display after power on. 

 

 Note 
Settings for 3 m version 

3 m version can be configured for level, space, and distance applications only. 
 

 
Setting Level  LEVEL 

Space SPACE 
Distance DIST 
Volume VOL 
Volume flow VFLOW 
Custom CUSTM 
Loop current LOOPC 
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Primary variable PV 
% of range % 
Sensor temperature STEMP 

Default Distance DIST 
 

 Note 
Start view set automatically by wizard 

The process value to display on device after power on is set automatically by the "Quick 
commissioning wizard". 
• When parameter "Operation" is set in the wizard, the value is written to parameter "Start 

view". 
• If a change is made to parameter "Start view" or parameter "PV selection" after running the 

wizard, the last one set will apply. 
• Options "Volume", "Volume flow", and "Custom" are not visible in measurement view 

until configured. If one of these unconfigured options is selected in parameter "Start 
view", measurement view will show the next visible process value. 

 

9.2.8.2 Service view (02-08.02) 
Sets operation of local device display to show menu numbers in navigation view. 
 
Setting Enabled ON 

Disabled OFF 
Default Disabled OFF 

 

 Note 
Show menu numbers on local display 

To view menu numbers on the device, parameter "Service view" must be enabled. (Go to 
menu "Setup > Local display".) 
• The item number of the current selection appears in the info field. 
• The menu number in which the current selection resides, appears on the title line (thus 

no menu numbers appear for top-level menu items, such as "QUICK START", "SETUP", etc.). 

Refer to full device menu in HMI menu structure. 
 

9.2.8.3 Display test wizard (02-08.03) 
Used to test device display. 
 
Setting Start START 

Cancel CANCL 
Default Start START 

The "Display test wizard" commands the field device to perform a test of all segments on the 
local display.  
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This test is accessible only via local operation, and a bar graph shows progress of test. After 
test is complete the message "COMPL" appears. 

9.3 Maintenance and diagnostics (M 03) 
The following parameters relate to device maintenance and diagnostics. 

9.3.1 Signal (M 03-01) 

9.3.1.1 Signal quality (M 03-01-01) 

Short shot confidence (03-01-01.01) 
Displays short shot echo quality: higher values represent better echo quality.  

Confidence (03-01-01.02) 
Displays echo quality: higher values represent better echo quality. 

Short shot echo signal strength (03-01-01.03) 
Displays strength of short shot echo, in dB.  

Echo signal strength (03-01-01.04) 
Displays strength of selected echo, in dB. 

Noise average (03-01-01.05) 
Displays the average ambient noise, in dB.  

The noise level is a combination of transient acoustic noise and electrical noise (induced into 
the receiving circuitry). See Noise problems (Page 166). 

Noise parameter values are automatically updated periodically. 

Noise peak (03-01-01.06) 
Displays the peak ambient noise, in dB. 

Noise parameter values are automatically updated periodically. 
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9.3.1.2 Echo configuration (M 03-01-02) 

Near range (03-01-02.01) 
Sets minimum distance from sensor reference point, beyond which an echo should be 
considered valid. 

This is sometimes referred to as blanking or a dead zone. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 0.2 m 

Far range (03-01-02.02) 
Sets maximum distance from sensor reference point, within which an echo should be 
considered valid. 

Use this feature if the measured surface can drop below the lower calibration point in normal 
operation. 
 
Setting Range for "Lower calibration point" + 2.4 m 

• 0.0 to 5.4 m (3 m version) 
• 0.0 to 8.4 m (6 m version) 
• 0.0 to 14.4 m (12 m version) 

Default Default value for "Lower calibration point" + 1.0 m 
• 4.0 m (3 m version) 
• 7.0 m (6 m version) 
• 13.0 m (12 m version) 

9.3.1.3 Echo select (M 03-01-03) 

Algorithm (03-01-03.01) 
Sets algorithm (applied to the echo profile) to extract the true echo. 
 
Setting Area largest first echo ALF 

Largest echo L 
Largest echo area AL 
Best echo of the first and largest echo BLF 
True first echo TF 

Default Best echo of the first and largest echo BLF 
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Short shot echo threshold (03-01-03.02) 
Sets minimum short shot echo confidence. Only echoes above this threshold are evaluated. 
 
Setting -20 to 70 
Default 10 

Echo threshold (03-01-03.03) 
Sets minimum echo confidence. Only echoes above this threshold are considered as true 
echoes. 
 
Setting -20 to 70 
Default 5 

Position detect (03-01-03.04) 
Sets algorithm used to calculate the position of the echo. 

Defines where on the echo the distance measurement is determined. 
 
Setting Rising RISE Rising edge of echo (calculated using echo peak to echo 

floor average) 
Center CNTR Center of the echo 
Rising 2 RISE2 Rising edge of echo (calculated using fixed amount of 

10 dB down from echo peak) 
Default Rising 2 RISE2  

Echo marker (03-01-03.05) 
Sets measurement point inside window set by parameter "Echo lock window". 
 
Setting 5% to 95% 
Default 50 (%) 

Applicable only when using "Rising" algorithm, set in parameter "Position detect". 

9.3.1.4 Filtering (M 03-01-04) 

Narrow echo filter (03-01-04.01) 
Clips echoes at a specified width. 
 
Setting 0 to 70 intervals1) (greater=wider) 
Default 3 

1) One interval = span of 64 microseconds (μs) 

Use this for acoustic beam interference (e.g. ladder rungs). Enter the width of false echoes (in 
groups of 64 microseconds), to be removed from the echo profile. For example, select value 
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of 3 to remove 192 microseconds (3 x 64 microseconds) of false echoes from the profile. 
When a value is entered, the nearest acceptable interval value in microseconds is set. 

Narrow echo filter is not recommended for liquids. 

Reform echo (03-01-04.02) 
Used to smooth jagged peaks in the echo profile. Reforms fragmented echoes into one echo. 
 
Setting 0 to 50 intervals1) (greater = wider) 
Default 0 

1) One interval = span of 64 microseconds (μs) 

Use this feature when monitoring solids if the reported level fluctuates slightly though the 
monitored surface is still. Enter the amount of smoothing required to the echo profile. When 
a value is entered, the nearest acceptable interval value, in microseconds, is set. 

Gain control (03-01-04.03) 
Used to adjust signal based on echo strength.  
 
Setting 
 

Auto AUTO 
Enabled ON 
Disabled OFF 

Default Auto AUTO 
 

 

 Note 
Gain control set to "Auto" 

Setting parameter "Gain control" to "Auto" requires that both parameters "Number of short 
shots" and "Number of long shots" be set to a value of one (1) or greater.  

Setting either parameter "Number of short shots" or "Number of long shots" to a value of zero 
(0) without taking parameter "Gain control" out of "Auto", may result in loss of echo or 
inaccurate measurement. 
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Gain lower threshold (03-01-04.04) 
Sets lower threshold to enable parameter "Gain control". 
 
Setting 0 to 99 dB 
Default 42 dB 

Gain upper threshold (03-01-04.05) 
Sets upper threshold to disable parameter "Gain control". 
 
Setting 0 to 99 dB 
Default 45 dB 

Sensor damping value (03-01-04.06) 
Sets the damping (filtering) of raw sensor value to smooth out response to sudden changes 
in measurement. 
 
Setting 0 to 1500 s 
Default 10 s 

 

 Note 
Rate parameters 

The three rate parameters "Fill rate", "Empty rate", and "Sensor damping value" work in 
conjunction, and are affected by parameter "Response rate" (set in the "Quick commissioning" 
wizard). The rate parameters automatically adjust when parameter "Response rate" is altered, 
but any changes made to the rate parameters following the completion of the wizard will 
supersede the response rate setting. 

 

 

 Note 
Damped PV 

All process values are damped by the value in parameter "Sensor damping value".  

The process value that is set as the primary variable (PV) for the application can be damped 
further using value in parameter "Damping value". 

 

 

 Note 
Damping via HART network 

HART common practice commands set parameter "Damping value", not parameter "Sensor 
damping value". 
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9.3.1.5 Sampling (M 03-01-05) 

Echo lock (03-01-05.01) 
Sets measurement verification process. When echo lock set to "Total lock", parameter "Echo 
lock window" is preset to 0 for automatic width and cannot be changed. 
 
Setting Disabled OFF 

Maximum verification MXVER 
Material agitator M AG 
Total lock TLOCK 

Default Material agitator M AG 

Use "Material agitator" option to prevent false echoes from agitator blades. 

"Maximum verification" option can be used if experiencing frequent loss of echo (LOE). 
However, it is recommended that you contact your Siemens representative before activating. 

Echo lock window (03-01-05.02) 
Sets distance window (centered on echo) used to derive reading. When new measurement is 
in window, window is recentered and reading is calculated. 
 
Setting 0 to 65535 m 
Default 0  

Number of short shots (03-01-05.03) 
Sets number of short shots to be fired (and results averaged) per transmit pulse. 
 
Setting 0 to 25 
Default 1 

A higher number of shots may result in a reduction in variation of the reported measurement 
value, but can increase the update time between measurements. 

 

 Note 
Gain control set to "Auto" 

Setting parameter "Gain control" to "Auto" requires that both parameters "Number of short 
shots" and "Number of long shots" be set to a value of one (1) or greater.  

Setting either parameter "Number of short shots" or "Number of long shots" to a value of zero 
(0) without taking parameter "Gain control" out of "Auto", may result in loss of echo or 
inaccurate measurement. 
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Number of long shots (03-01-05.04) 
Sets number of long shots to be fired (and results averaged) per transmit pulse.  
 
Setting 0 to 25 
Default 2 

A higher number of shots may result in a reduction in variation of the reported measurement 
value, but can increase the update time between measurements. 

 

 Note 
Gain control set to "Auto" 

Setting parameter "Gain control" to "Auto" requires that both parameters "Number of short 
shots" and "Number of long shots" be set to a value of one (1) or greater.  

Setting either parameter "Number of short shots" or "Number of long shots" to a value of zero 
(0) without taking parameter "Gain control" out of "Auto", may result in loss of echo or 
inaccurate measurement. 

 

Short shot duration (03-01-05.05) 
Sets duration of short shot transmit pulse. 
 
Setting 50 to 2000 μs 
Default 150 μs 

Long shot duration (03-01-05.06) 
Sets duration of long shot transmit pulse. 
 
Setting 150 to 2000 μs 
Default 1000 μs 

9.3.1.6 TVT configuration (M 03-01-06) 

Hover level (03-01-06.01) 
Sets offset of TVT above noise floor of echo profile. Value in percent with respect to noise 
floor and peak value of largest echo. 
 
Setting 0 to 100% 
Default 40% 
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Auto false echo suppression (03-01-06.02) 
Used to screen out false echoes in a vessel with known obstructions. 

A learned TVT (time varying threshold) replaces the default TVT over a specified range. 
 
Setting 
 

Enabled ON 
Disabled OFF 

Default Disabled OFF 

To screen out false echoes using auto false echo suppression (AFES): 

1. Determine range and enter this value in parameter "Auto false echo suppression range". 

2. Run "Auto false echo suppression wizard" to "learn" the TVT. 

Once the wizard completes successfully, parameter "Auto false echo suppression" is set to 
"Enabled" and the learned TVT will be used. 

 

 Note 
TVT "Learn" 

Although the parameters "Auto false echo suppression" and "Auto false echo suppression 
range" may be adjusted on their own, the "Auto false echo suppression wizard" must be used 
to "learn" the TVT. 

 

 

 Note 
AFES automatically disabled 

The device will automatically reset parameter "Auto false echo suppression" to "Disabled" 
under the following conditions: 
• Parameter "Auto false echo suppression" is manually enabled, and an initial device TVT 

learn is never requested (via AFES wizard) 
• Parameter "Auto false echo suppression" is enabled (either manually or automatically 

based on previous TVT learn using AFES wizard), and a new TVT learn request fails (for 
example, due to a power failure during the learn process). 

To avoid situations where AFES is disabled by the device, use "Auto false echo suppression 
wizard" initially. The wizard will store a learned TVT and enable AFES.  

If AFES is later disabled then re-enabled, the stored TVT will be used. 
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 Note 
For best results with AFES 
• Set up auto false echo suppression during commissioning if possible, by running "Auto 

false echo suppression wizard". 
• Ensure material level is below all known obstructions at the moment when "Auto false 

echo suppression wizard" learns the TVT. Ideally the vessel should be empty or almost 
empty. 

• Use auto false echo suppression only if target is greater than one meter from transducer 
face (sensor reference point) 

• Note the distance to material level when learning the echo profile, and set value in 
parameter "Auto false echo suppression range" to a shorter distance to avoid the material 
echo being screened out. 

• If the vessel contains an agitator, it should be running. 
 

Auto false echo suppression range (03-01-06.03) 
Sets end point of the learned TVT distance. 
 
Setting • 0 to 3 m (3 m version) 

• 0 to 6 m (6 m version) 
• 0 to 12 m (12 m version) 

Default 1 m 

To calculate value  

1. Determine the auto false echo suppression range by measuring the actual distance from the 
sensor reference point to the material surface using a rope or tape measure. 

2. Subtract 0.5 m (20") from this distance and use the resulting value. 

Custom TVT breakpoints 
TVT breakpoints can be manually defined only via remote operation. See Custom TVT 
breakpoints (Page 223) under "Echo profile utilities" in the SIMATIC PDM menu "Device". 

9.3.2 Peak values (M 03-02) 
Displays peak measured values. 

9.3.2.1 Minimum PV (03-02.01) 
Displays minimum value of the primary variable. Value may reset when units are changed.  
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9.3.2.2 Maximum PV (03-02.02) 
Displays maximum value of the primary variable. Value may reset when units are changed.  

9.3.2.3 Minimum distance (03-02.03) 
Displays minimum distance value. Value may reset when units are changed. 

9.3.2.4 Maximum distance (03-02.04) 
Displays maximum distance value. Value may reset when units are changed. 

9.3.2.5 Minimum sensor temperature (03-02.05) 
Displays minimum sensor temperature value. 

9.3.2.6 Maximum sensor temperature (03-02.06) 
Displays maximum sensor temperature value. 

9.3.3 Loop test (M 03-03) 

9.3.3.1 Loop test wizard (03-03.01) 
Provides step-by-step procedure to simulate the loop current. 

A loop test can be initiated via local operation (with any errors reported through diagnostic 
icons on the local display), or remotely, using an engineering system such as SIMATIC PDM. 

 

 Note 
Simulated current output 

The simulated current output value influences output to the control system. 
 

A simulated value can be set to test the functioning of the mA connections during 
commissioning or maintenance of the device. 
 
Setting 3.55 

4.0 
12.0 
20.0 
22.8 
User (Set any mA value between 3.6 and 22.8) 

Default 12.0 mA 

Select a preset mA value, or enter a custom value (under option "User") to run the wizard.  
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Press  button to stop and exit the loop test.  

For more information, see mA control (Page 71). 

9.3.4 Resets (M 03-04) 
 

9.3.4.1 Device restart (03-04.01) 
Used to restart device without disconnecting power. 

Simulation will be terminated. Stored configurations are not reset. 
 
Setting Cancel CANCL 

Ok OK 
Default Cancel CANCL 

9.3.4.2 Reset (03-04.02) 
Used to provide various device reset options. 
 
Setting Factory reset FACT 

Restore ordered configuration CUST 
Default Factory reset FACT 

 

 

 Note 
Factory reset requires reprogramming 

Following a reset to factory defaults, the device is in a "Not configured" state, and shows the 
fault "Configuration error" (code SC). The fault code remains until the device is 
reprogrammed.  

 

Choosing option "Factory reset" will reset all parameters to factory defaults, with the 
following exceptions: 

• "Device address" remains unchanged 

• "User PIN" (write protection) value is not reset 

• "Peak values" and "Operating time" are not reset 

• "Long shot duration" and "Short shot duration" are not reset 

• "Auto false echo suppression" is reset to default (Disabled), but learned TVT is not lost 

• "Auto false echo suppression range" is not reset 

• "Custom TVT shaper mode" is reset to default (Disabled), but "Custom TVT breakpoints" are 
not lost 
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To perform a "Factory reset" via SIMATIC PDM, go to menu "Device > Reset > Factory reset".  
 

 Note 
Restore ordered configuration requires 22.5 mA 

Device output reads 22.5 mA while "Restore ordered configuration" is running. When restore 
is complete, device output returns to normal behavior. 
• Restore takes approximately 20 seconds to complete. 
• Following a restore to ordered configuration, the device is in a "Configured" state, and mA 

output is based on current measurement of restored PV. 
 

Choosing option "Restore ordered configuration" restores device to customer-ordered default 
settings. The parameters not configured via the order are reset to the factory default settings. 

 

 Note 
AFES disabled 

Although learned TVT is not lost, parameter "Auto false echo suppression" is reset to its 
default value of "Disabled" when "Restore ordered configuration" is performed. 

 

In SIMATIC PDM, go to menu "Device > Reset > Restore ordered configuration". 

A third option to "Restore to factory DAC calibration" is available via SIMATIC PDM. This option 
restores the DAC trim (digital-to-analog converter trim) to the factory setting. [The DAC trim 
is used to calibrate the 4 mA and 20 mA end points of the analog output with an external 
reference (e.g. current measurement device).]  

Go to menu "Device > Reset > Restore to factory DAC calibration". 

9.3.4.3 Reset peak values (03-04.03) 
Resets all recorded Peak values. 
 
Setting No NO 

Primary variable PV 
Distance DIST 
Sensor temperature STEMP 
Peak values 
(Resets recorded minimum and maximum values for PV, 
Distance, and Sensor temperature.) 

PKVAL 

Default No NO 

9.4 Communication (M 04) 
Specific device versions (6 m, 12 m) support HART communication protocol. 

The following parameters relate to device Communication. 
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9.4.1 Polling address (04.01) 
Sets poll ID on a HART network. 

For point-to-point configurations, the standard address is zero (0). For multidrop 
configurations, use a non-zero HART address. 
 
Setting 0 to 63 
Default 0 

9.4.2 Identify the device (04.02) 
Used to arm device locally to produce a visual alert (blinking display) so device can be 
identified. 
 
Setting Enabled ON 

Disabled OFF 
Default Disabled OFF 

 

 

 Note 
Optional display required 

When HART command 72 is issued to the device address, a display test is run, causing the 
attached optional display to blink. 

 

9.5 Security (M 05) 
The following parameters relate to device Security. 

9.5.1 Change user PIN (05.01) 
Used to change PIN code that enables user access level. 
 
Setting 0 to 65535 
Default 0 

9.5.2 Recovery ID (05.02) 
Displays recovery ID that must be provided to Technical Support to obtain the PIN-Unlock-Key 
(PUK) required to recover the PIN(s). 
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Record the number shown in parameter "Recovery ID", and the serial number of the device. 
(Serial number can be found on device nameplate, or via remote operation if data was 
previously uploaded from device to EDD and saved in offline table, e.g. PDM Structure view.) 

When you provide this information to Siemens Technical Support, a PUK (PIN Unlock Key) will 
be supplied to you. Enter this PUK in parameter "PIN recovery" to reset the user PIN to factory 
default value. 

 

 Note 
Parameter visibility 

Parameter "Recovery ID" will only show on the local display if parameter "User PIN" is enabled. 
 

9.5.3 PIN recovery (05.03) 
Used to enter PIN unlock key (PUK) which resets PIN(s) to factory default value. The PUK is 
available from Technical Support. 

 

For more information, see Recovery ID (05.02) (Page 139). 
 

 Note 
Parameter visibility 

Parameter "PIN recovery" will only show on the local display if parameter "User PIN" is 
enabled. 

 

9.5.4 User PIN (05.04) 
Used to enable/disable user PIN. When user PIN is enabled, changes to parameter settings 
require a PIN to be entered. 

 

 Note 
Factory PIN 

Device is shipped unlocked. If device is locked unintentionally (user PIN enabled), enter PIN 
2457 to unlock device (disabled user PIN). 

 

 
Setting Enabled ON 

Disabled OFF 
Default Disabled OFF 

In Parameter view, the local display shows the action that can be performed: 

• If display shows "ENABL", this means that security is currently disabled 

• If display shows "DISAB", this means that security is currently enabled. 
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 Note 
Effectivity of change to user PIN setting 

When the setting for parameter "User PIN" is changed, it will not take effect immediately. 
Once setting is changed, a power cycle of the device or ten (10) minutes must pass before 
the change will take effect. (This delay applies only when a change is made to this parameter 
on the local device, not via remote operation.) 

 

9.5.5 Button lock (05.05) 
Sets access to device buttons. When lock enabled, device operation is only possible via 
engineering system. 

To disable lock locally press right button for 5 seconds, or use engineering system to disable 
remotely. 
 
Setting Enabled ON  Button lock enabled 

Disabled OFF Button lock disabled 
Default Disabled OFF  
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 Parameter assignment - Remote 10 
 

 

Specific device versions (6 m, 12 m) support HART communication protocol. 

This chapter includes all parameters accessible via a remote engineering system (such as 
SIMATIC PDM, or AMS Device Manager).  

Parameters are organized into similar functions groups and menu structure as those 
accessible via local operation, although structure varies slightly. Refer to the Structure view 
in SIMATIC PDM, or the Configure/Setup menu in AMS Device Manager. (If a parameter is 
not available in PDM Structure view, refer to the PDM menus: Parameters and methods via 
PDM menus (Page 202).) 

For more details, see: 

• SIMATIC PDM (Page 199) 

• AMS device manager (Page 230) 

• Field Communicator (FC) 375/475 (Page 231) 

• FDT (Field Device Tool) (Page 232) 

10.1 Identification 
The following Identification parameters are accessible only via a remote engineering system 
(such as SIMATIC PDM). 

10.1.1 Tag 
Defines a unique tag name for device or measurement point. Limited to 8 characters. 

10.1.2 Long tag 
Defines a unique tag name for device or measurement point. Limited to 32 characters. 

10.1.3 Descriptor 
Defines a unique description for the measuring point. Limited to 16 characters. 

10.1.4 Message 
Sets unique message for device. Limited to 32 characters. 
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10.1.5 Installation date 
Sets the installation date of the device. 

10.1.6 Device 

10.1.6.1 Manufacturer 
Displays manufacturer of device. 

10.1.6.2 Product name 
Displays product name. 

10.1.6.3 Protocol 
Displays communication protocol supported by device. 

10.1.6.4 Article number 
Displays the article number (MLFB) of the device. 

10.1.6.5 Order option 1 
Displays number for specific customer order option. 

10.1.6.6 Order option 2 
Displays number for specific customer order option. 

10.1.6.7 Serial number 
Displays unique serial number of device, set by factory. 

10.1.6.8 HW version 
Displays version number corresponding to electronics hardware of device. 

10.1.6.9 FW version 
Displays version number corresponding to software or firmware embedded in device. 
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10.1.6.10 EDD version 
Displays version number corresponding to Electronics Device Description (EDD) installed with 
device. 

10.1.6.11 Final assembly number 
Sets a number for user to identify the device.  It is normally changed when electronics or 
other device components are upgraded in the field. 

10.2 Setup 
Setup parameters under the following menus are accessible via both an engineering system 
and the local display (HMI). For more details, see respective link to Parameter assignment - 
Local chapter. 

• Select output (M 02-01) (Page 103) 

• Sensor (M 02-02) (Page 105) 

• Calibration (M 02-03) (Page 107) 

• Current output (M 02-04) (Page 112) 

• Volume (M 02-05) (Page 116) 

• Volume flow (M 02-06) (Page 119) 

• Local display (M 02-08) (Page 125) 

• Custom (M 02-07) (Page 124) 

Additional Setup parameters as detailed below, are accessible only via an engineering 
system. For example, these parameters can be found in the Structure view of SIMATIC PDM, 
or in the Configure/Setup menu of AMS Device Manager. 

• Custom 

– Custom units 

10.2.1 Custom units 
Sets unit text to display, in a custom application. Limited to 16 characters.  

The text entered is simply for display purposes. No unit conversion occurs. 
 

 Note 
Changing custom units 

If a change is made to custom units, be sure to rescale the output, as rescaling for custom 
units is not handled automatically by the device. 
• Use parameters "Upper range value" and "Upper scaling point" to rescale output. 
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10.3 Maintenance and diagnostics 
Maintenance and diagnostics parameters under the following menus, are accessible via both 
an engineering system and the local display (HMI). For more details, see respective link to 
Parameter assignment - Local chapter. 

•  Signal (M 03-01) (Page 127) 

– Signal quality (M 03-01-01) (Page 127) 

– Echo configuration (M 03-01-02) (Page 128) 

– Echo select (M 03-01-03) (Page 128) 

– Filtering (M 03-01-04) (Page 129) 

– Sampling (M 03-01-05) (Page 132) 

– TVT configuration (M 03-01-06) (Page 133)) 

• Peak values (M 03-02) (Page 135)) 

Additional Maintenance and diagnostics parameters as detailed below, are accessible only via 
an engineering system. For example, these parameters can be found in the Structure view of 
SIMATIC PDM, or in the Configure/Setup menu of AMS Device Manager. 

• Audit trail 

10.3.1 Audit trail 

10.3.1.1 Configuration change counter 
Displays number of times device configuration or calibration changed, locally or via 
engineering system. 

10.4 Communication 
The following Communication parameters are accessible only via a remote engineering 
system (such as SIMATIC PDM). 

For example, these parameters can be found in the Structure view of SIMATIC PDM, or in the 
Configure/Setup menu of AMS Device Manager. 

• Manufacturer's ID 

• HART expanded device type 

• Device ID 

• HART device revision 

• HART software revision 

• HART hardware revision 

• HART EDD revision 
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• Universal command revision 

• Device profile code 

• Polling address 

10.4.1 Manufacturer's ID 
Displays numerical code that refers to manufacturer of device.  

10.4.2 HART expanded device type 
Displays numerical code that refers to manufacturer's ID plus device type. 

10.4.3 Device ID 
Displays unique ID for device, set by manufacturer. 

10.4.4 HART device revision 
Displays the HART device revision used to map the associated device description. 

10.4.5 HART software revision 
Displays HART software revision used with device. 

10.4.6 HART hardware revision 
Displays HART hardware revision used with device. 

10.4.7 HART EDD revision 
 Displays HART EDD revision used with device. 

10.4.8 Universal command revision 
Displays revision of Universal Device Description associated with device. 
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10.4.9 Device profile code 
Displays the type of device. 

10.4.10 Polling address 
Sets poll ID on a HART network. 

For point-to-point configurations, the standard address is zero (0). For multidrop 
configurations, use a non-zero HART address. 

10.5 Security 
The following Security parameters are accessible via both an engineering system and the 
local display (HMI).  

• User PIN (05.04) (Page 140) 

• Button lock (05.05) (Page 141) 

Parameters available via the menu Security on the local display, such as "Change user PIN 
wizard", "Recovery ID" and "PIN recovery", can be found in PDM under menu "Device > 
Security". 

10.6 Characteristics 
Characteristics parameters as detailed below are accessible only via an engineering system. 

• Certificates and approvals 

– Intrinsic safety 

– Flameproof/Explosion proof 

– Increased safety 

– Protection by enclosure/Dust ignition proof 

– Non-sparking/Non-incendive 

– Protection by encapsulation 

• Sensor limits 

– Lower limit 

– Upper limit 

– Minimum measuring span 
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10.6.1 Certificates and approvals 

10.6.1.1 Intrinsic safety 
Displays whether device has type of protection "Intrinsic safety". Examples: Ex ia, Ex ib, Ex ic 

10.6.1.2 Flameproof/Explosion proof 
Displays whether device has type of protection "Flame proof/Explosion proof". Example: Ex d 

10.6.1.3 Increased safety 
Displays whether device has type of protection "Increased safety". Examples: Ex eb, Ex ec  

10.6.1.4 Protection by enclosure/Dust ignition proof 
Displays whether device has "Protection by enclosure/Dust ignition proof". Examples: Ex ta, Ex 
tb, Ex tc  

10.6.1.5 Non-sparking/Non-incendive 
Displays whether device has type of protection "Non-sparking/Non-incendive". Examples: Ex 
nA 

10.6.1.6 Protection by encapsulation 
Displays whether device has "Protection by encapsulation". Examples: Ex ma, Ex mb, Ex mc  

10.6.2 Sensor limits 

10.6.2.1 Lower limit 
Displays minimum usable value for parameter "Lower range value". 

10.6.2.2 Upper limit 
Displays maximum usable value for parameter "Upper range value". 

10.6.2.3 Minimum measuring span 
Defines the smallest allowable difference between the upper range value and the lower 
range value. 
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 Service and maintenance 11 
11.1 Basic safety notes 

The device is maintenance-free. However, a periodic inspection according to pertinent 
directives and regulations must be carried out.  

An inspection can include, for example, check of: 

• Ambient conditions 

• Seal integrity of the process connections, cable entries, and cover 

• Reliability of power supply, lightning protection, and grounds 

11.1.1 Steps for periodic inspection 
Suggested steps for a periodic inspection: 

• Clean the device 

• Inspect for damage, cracks, or changes since installation 

• Check the display for any diagnostic symbols or error messages 

 

 NOTICE 
Penetration of moisture into the device 

Damage to device. 
• Make sure when carrying out cleaning and maintenance work that no moisture 

penetrates the inside of the device. 
 

 

 CAUTION 

Releasing button lock 

Improper modification of parameters could influence process safety. 
• Make sure that only authorized personnel may cancel the button locking of devices for 

safety-related applications. 
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11.2 Cleaning 

Cleaning the enclosure 
• Clean the outside of the enclosure with the inscriptions and the display window using a 

cloth moistened with water or a mild detergent. 

• Do not use any aggressive cleansing agents or solvents, e.g. acetone. Plastic parts or the 
painted surface could be damaged. The inscriptions could become unreadable. 

 

 WARNING 
Maintenance during continued operation in a hazardous area 

There is a risk of explosion when carrying out repairs and maintenance on the device in a 
hazardous area. 
• Isolate the device from power. 

- or - 
• Ensure that the atmosphere is explosion-free (hot work permit). 

 

11.3 Maintenance and repair work 
 

 WARNING 
Impermissible repair of the device 
• Repair must be carried out by Siemens authorized personnel only. 

 

 

 WARNING 

Humid environment 

Risk of electric shock. 
• Avoid working on the device when it is energized. 
• If working on an energized device is necessary, ensure that the environment is dry. 
• Make sure when carrying out cleaning and maintenance work that no moisture 

penetrates the inside of the device. 
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11.3.1 Replacing the display 

11.3.1.1 Remove existing display 
To remove display for wiring or to replace a damaged display, follow steps below: 

1. Turn lid by hand in a counter-clockwise direction to remove it from device. 

2. Remove display by gently turning the display a quarter turn counter-clockwise, to free it 
from the enclosure. 

3. Pull up to disconnect display cable from connector. The display is now free to lift out of 
enclosure. 
(Dispose of a damaged display according to local regulations.) 
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11.3.1.2 Install a new display 
 

 Note 
Mounting orientation for display 

The display can be mounted in 1 of 4 positions at 90 degree intervals, for easy viewing after 
installation. 

 

1. Press the female end of cable from replacement display onto male four-pin connector. 

2. Set replacement display into enclosure approximately one quarter turn counter-clockwise 
from the desired final orientation. Gently turn display one quarter turn clockwise to secure 
the display in the enclosure. 

3. Replace device lid. Thread onto enclosure, turning clockwise. Hand tighten until mechanical 
stop is reached. 

 
① Male four-pin connector 
② Female end of display cable 
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11.3.2 Spare parts list 
Below is a list of spare parts with article numbers for this device.  
 
Part description Article number 
Spare lid, clear A5E44267491 
Spare lid, blind A5E44267497 
Spare o-ring for lid A5E44267501 
Spare segmented display and 4-button HMI A5E44809382 

11.4 Return procedure 
Enclose the bill of lading, return document and decontamination certificate in a clear plastic 
pouch and attach it firmly to the outside of the packaging. 

Required forms 
• Delivery note 

• Return goods delivery note 
(http://www.siemens.com/processinstrumentation/returngoodsnote) 

with the following information: 

– Product (item description) 

– Number of returned devices/replacement parts 

– Reason for returning the item(s) 

• Decontamination declaration (http://www.siemens.com/sc/declarationofdecontamination) 

With this declaration you warrant "that the device/replacement part has been carefully 
cleaned and is free of residues. The device/replacement part does not pose a hazard for 
humans and the environment." 

If the returned device/replacement part has come into contact with poisonous, corrosive, 
flammable or water-contaminating substances, you must thoroughly clean and 
decontaminate the device/replacement part before returning it in order to ensure that all 
hollow areas are free from hazardous substances. Check the item after it has been 
cleaned. 

Any devices/replacement parts returned without a decontamination declaration will be 
cleaned at your expense before further processing. 

http://www.siemens.com/processinstrumentation/returngoodsnote
http://www.siemens.com/sc/declarationofdecontamination
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11.5 Disposal 
 

 

Devices described in this manual should be recycled. They may not be 
disposed of in the municipal waste disposal services according to the Di-
rective 2012/19/EC on waste electronic and electrical equipment (WEEE). 
Devices can be returned to the supplier within the EC, or to a locally ap-
proved disposal service for eco-friendly recycling. Observe the specific 
regulations valid in your country. 
Further information about devices containing batteries can be found at: 
Information about battery / product return (WEEE) 
(https://support.industry.siemens.com/cs/document/109479891/) 

 

 Note 
Special disposal required 

The device includes components that require special disposal. 
• Dispose of the device properly and environmentally through a local waste disposal 

contractor. 
 

https://support.industry.siemens.com/cs/document/109479891/
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 Diagnosing and troubleshooting 12 
12.1 Communication troubleshooting 
 

 Note 
Understanding ultrasonic technologies 
• Many parameters referenced and techniques described here require a good understanding 

of ultrasonic technologies and Siemens echo processing software. Use this information 
with caution. 

• If setup becomes too confusing, perform a device reset and start again. 
• As a further resource, "Understanding Ultrasonic Level Measurement" is available on our 

website. Go to: 
Siemens level (http://www.siemens.com/ultrasonics) 
Select "Training center > E-Learning > epubs". 

 

Generally 

1. Check the following: 

– Power is available at device. 

– Optional display shows relevant data. 

– Device can be programmed using local buttons. 

– If any fault codes show on display, see Fault codes and corrective actions (Page 158) 
for a detailed list. 

2. Verify that wiring connections are correct. 

Specifically 

1. If the device is set to communicate via a HART modem but no communication is returning to 
the master, check that the device address is set correctly for the HART network. 

2. If a device parameter is set via remote communication, but the parameter remains 
unchanged, try setting the parameter using local buttons. If it cannot be set locally, ensure 
Button lock (05.05) (Page 141) is set to "Off", and that User PIN is deactivated. 

If you continue to experience problems, go to: 

Product page (www.siemens.com/sitransprobelu240) 

Check the FAQs for this device, or contact your Siemens representative. 

http://www.siemens.com/ultrasonics
http://www.siemens.com/sitransprobelu240
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12.2 Device status symbols 
Device status is shown using symbols on the local display. Additionally, the symbol and 
respective text message for each device status can be seen in remote engineering, asset 
management or process control systems. 

Locally, alarms are shown as a symbol in the lower line of the display. If several diagnostic 
states are active at the same time, the symbol for the most critical state is shown. 

Device status characteristics 

The following table provides possible cause of device status and actions for the user or 
service.  

The symbols used on the local display are based on NAMUR status signals, whereas symbols 
used in SIMATIC PDM are based on Siemens standard alarm classes. 

 

 Note 
Device status priority conflict - Namur vs Siemens standard 

When more than one diagnostic event is active simultaneously, a conflict in priorities may 
arise. In this case, the Namur symbol on the local display will differ from that shown in 
SIMATIC PDM.  
• For example: if both diagnostic states "Maintenance demanded" and "Configuration error" 

are active, 
– Local display (using Namur symbols) will show "Configuration error" as higher priority. 
– SIMATIC PDM (using Siemens standard symbols) will show "Maintenance demanded" as 

higher priority. 

Be aware of the priority for each device status, depending on the interface used. 
 

Device status symbols 
 
Local display 
- NAMUR NE 107 

 
NAMUR - HCF 

SIMATIC PDM/PLC 

Symbol Device status Priority * Symbol Device status Priority ** 

 

Failure 1 

 

Maintenance alarm 1 

Cause: Output signal invalid due to fault in the field device or in the peripherals. 
Action: Maintenance is required immediately. 
 

 

Maintenance required 4 

 

Maintenance demanded 
 

2 

Cause: Output signal is still valid, but wear reserve is almost exhausted and/or a function will be limited soon. 
Action: Maintenance is strongly recommended as soon as possible. 
 

 

Maintenance required 4 

 

Maintenance required 3 
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Local display 
- NAMUR NE 107 

 
NAMUR - HCF 

SIMATIC PDM/PLC 

Symbol Device status Priority * Symbol Device status Priority ** 
Cause: Output signal is still valid. No functional restriction detected but end of wear reserve expected in next weeks. 
Action: Maintenance of device should be planned. 
 

 

Function check 2 
 

Manual operation 4 

Cause: Output signal temporarily invalid (e.g. frozen) due to work being performed on the device. 
Action: Disable manual mode via HMI or engineering system. 
 

 

Function check 2 
 

Simulation or substitute 
value 

5 

Cause: Output signal temporarily does not represent the process because output based on a simulation value. 
Action: Disable simulation mode via HMI or engineering system or restart device. 
 

 

Failure 1 
 

Out of service 6 

Cause: Output signal does not represent process value. Device mode is set to "Out of service". 
Action: Disable “out of service” and enable normal operation. 
 

 

Failure 1 
 

(red) 

Configuration error 7 

Cause: Output signal invalid due to a parameter setting, connection error or a configuration error in the HW. 
Action: Check hardware configuration or parameter settings of the device via HMI or engineering system. 
 

 

Out of specification 3 

 

Process value alarm 8 

Cause: Deviations from permissible ambient or process conditions detected by the device (through self-monitoring, or 
warnings / faults in the device) indicate that the measured value is unreliable or deviations from the set value in the actua-
tors is most likely greater than anticipated under normal operating conditions.  
Process or ambient conditions will damage the device or result in unreliable output. 
Action: Check ambient temperature or process conditions. If possible, install device at different location. 
 

 

Function check 2 
 

(yellow) 

Configuration warning 9 

Cause: Device can operate, but one or more parameters are incorrectly configured. 
Action: 
 

 

Out of specification 3 

 
 

Process value warning 10 
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Local display 
- NAMUR NE 107 

 
NAMUR - HCF 

SIMATIC PDM/PLC 

Symbol Device status Priority * Symbol Device status Priority ** 
Cause: Deviations from permissible ambient or process conditions detected by the device (through self-monitoring, or 
warnings / faults in the device) indicate that the measured value is unreliable or deviations from the set value in the actua-
tors is most likely greater than anticipated under normal operating conditions. 
Process or ambient conditions can damage the device or result in unreliable output. 
Action: Check ambient temperature or process conditions. If possible, install device at different location. 
 
No symbol 
shown 

  

 

Process value tolerance 11 

Cause: At least one process value has exceeded or fallen below a process tolerance limit parameter set in device. 
Action: Check that limit parameter settings are suitable for application.  
 
No symbol 
shown 

  No symbol 
shown 

Configuration changed 12 

Cause: The device configuration has changed due to a work process. 
Action: Reset configuration flag to clear diagnostic message. 
 
No symbol 
shown 

Good - OK  No symbol 
shown 

No assignment 13 

Cause: Device status ok. No active diagnostic errors. 
Action: No action required.  

* Lowest priority number equals highest fault severity. 

** Both the Siemens standard symbol and its corresponding Namur symbol (from device 
display) will be shown in SIMATIC PDM. 

12.3 Device information symbols 

Information symbols 

In addition to device status symbols, information symbols appear on the local display. 

See Display symbols (Page 37). 

12.4 Fault codes and corrective actions 
In the following table the diagnostic message IDs are listed along with possible causes and 
directions for corrective action. 
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Certain faults exist, that when triggered initiate a Fail-safe state. Usually this means that the 
mA output displays the setting in parameter "Fault current". These faults are indicated with a 
single asterisk (*) in the table below. For faults that display a mA output, set by something 
other than parameter "Fault current", refer to numbered footnotes. 

 
ID Symbols Message Cause/action 
A0* 

 

 

Event counter 1 
Number overruns above 
threshold 
Maintenance alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 
 

A1 

 

 

Event counter 1 
Number underruns above 
threshold 
Process value alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A2 

 

 

Event counter 1 
Number underruns above 
threshold 
Maintenance required 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A3* 

 

 

Event counter 1 
Number underruns above 
threshold 
Maintenance alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A4 

 

 

Event counter 2 
Number overruns above 
threshold 
Process value alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A6 

 

 

Event counter 2 
Number overruns above 
threshold 
Maintenance required 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A7* 

 

 

Event counter 2 
Number overruns above 
threshold 
Maintenance alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

A8 

 

 

Event counter 2 
Number underruns above 
threshold 
Process value alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 
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ID Symbols Message Cause/action 
A9 

 

 

Event counter 2 
Number underruns above 
threshold 
Maintenance required 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

AA 

 

 

Device lifetime: mainte-
nance demanded 

Forthcoming end of configured device's lifetime. 
Maintenance is strongly recommended as soon as possible. 

Ab 

 

 

Device lifetime: mainte-
nance required 
 

Forthcoming end of configured device's lifetime. 
Maintenance of device should be planned. 

AE 

 

 

Service: maintenance 
demanded 

Forthcoming end of the configured service interval. 
Maintenance is strongly recommended as soon as possible. 

AF 

 

 

Service: maintenance 
required 

Forthcoming end of the configured service interval. 
Maintenance of device should be planned. 

AG 

 

 

Calibration: maintenance 
demanded 

Forthcoming end of the calibration interval. 
Maintenance is strongly recommended as soon as possible. 

AH 

 

 

Calibration: maintenance 
required 

Forthcoming end of the calibration interval. 
Maintenance of device should be planned. 

AJ 

 

 

Limit monitoring 1 
Above limit 
Process value alarm 

Monitored value is above limit (set in parameter "Upper limit"). 
 

AL 

 

 

Limit monitoring 1 
Below limit 
Process value alarm 

Monitored value is below limit (set in parameter "Lower limit"). 
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ID Symbols Message Cause/action 
An 

 

 

Limit monitoring 2 
Above limit 
Process value alarm 

Monitored value is above limit (set in parameter "Upper limit"). 
 

Ao 

 

 

Limit monitoring 2 
Below limit 
Process value alarm 

Monitored value is below limit (set in parameter "Lower limit"). 
 

AP 

 

 

Limit monitoring 3 
Above limit 
Process value alarm 

Monitored value is above limit (set in parameter "Upper limit"). 

Ar 

 

 

Limit monitoring 3 
Below limit 
Process value alarm 

Monitored value is below limit (set in parameter "Lower limit"). 

AU 

 

 

Event counter 1 
Number overruns above 
threshold 
Process value alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

AY 

 

 

Event counter 1 
Number overruns above 
threshold 
Maintenance required 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

b0 

 

 

Event counter 3 
Number underruns above 
threshold 
Process value alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

b1 

 

 

Event counter 3 
Number underruns above 
threshold 
Maintenance required 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

b2* 

 

 

Event counter 3 
Number underruns above 
threshold 
Maintenance alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 
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ID Symbols Message Cause/action 
bE1) 

 

 

Out of service 
Maintenance alarm 

Output signal does not represent process value. Device mode is set to "Out 
of service". 
Repair is required. Contact Technical support. 

bL* 

 

 

Device restart due to un-
expected program error 
Maintenance alarm 

Watchdog function has detected an internal device error. 
Restart the device. 
If the problem persists, contact Technical support. 

bn 

 

 

Alarm sensor limit exceed-
ed 
Process value alarm 

Process value has reached the sensor limit. 
Review process conditions versus product specifications. 

bS* 

 

 

Event counter 2 
Number underruns above 
threshold 
Maintenance alarm 

The number of underruns of the process value (set in parameters "Lower 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

bt 

 

 

Event counter 3 
Number overruns above 
threshold 
Process value alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

bU 

 

 

Event counter 3 
Number overruns above 
threshold 
Maintenance required 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

bY* 

 

 

Event counter 3 
Number overruns above 
threshold 
Maintenance alarm 

The number of overruns of the process value (set in parameters "Upper 
limit" and "Monitored value") has reached the threshold. 
Reset and acknowledge event counter. 
Check process conditions. 
Check limit monitoring and event counter settings. 

CA 

 

 

Simulation mode 
Simulated or substitute 
value 

The device is in simulation mode and one or more of its device variables 
are not representative of the process. 
Disable the simulation to return to normal operation. 

Cb 

 

 

Diagnostics simulated 
Simulated or substitute 
value 

The device is in simulation mode. 
Disable the simulation to return to normal operation. 
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ID Symbols Message Cause/action 
Co2) 

 

 

Loop current fixed 
Manual operation 

The loop current is being held at a fixed value and is not responding to 
process variations. 
Enter the loop current output value for simulation. 
Disable the simulation to return to normal operation. 

CP3) 

 

 

Loop current in saturation 
Process value warning 

The loop current has reached its upper (or lower) saturation limit and can-
not increase (or decrease) any further. 
Adjust loop current scaling. 

CU 

 

 

PV status: uncertain 
Process value alarm 

Parameter "Fail-safe loss of echo" is set to "Hold", and device is in loss of 
echo (LOE) OR Limit is set for a negative level value, and that value is ex-
ceeded. 
Check for changes in process conditions or obstructions in vessel. 
OR 
Potential product damage. Sensor has malfunctioned. 
A replacement of sensor is recommended. 
Contact Technical support. 

CY* 

 

 

PV status: bad 
Maintenance alarm 

Parameter "Fail-safe loss of echo" is set to "Fault current", and device is in 
loss of echo (LOE). 
Review process conditions versus product specifications. 
Use a device that fulfills your process conditions. 
OR 
The measured value is 10% higher than the physical sensor range. 
Review process conditions versus product specifications. 
Use a device that fulfills your process conditions. 

FJ 

 

 

Process conditions out of 
specification 
Process value warning 

Uncertain values due to process conditions. 
Check installation for abnormal operating conditions. 

Fn* 

 

 

Connection failure to sen-
sor electronics 
Maintenance alarm 

Potential product damage. 
Restart the device. 
If error continues, sensor electronics may have a defect. 
Repair is required. Contact Technical support. 

Fo* 

 

 

Sensor break 
Maintenance alarm 

Potential product damage. 
Sensor has malfunctioned. 
A replacement of sensor is recommended. 
Contact Technical support. 

Fr 

 

 

Internal power supply is 
out of allowable range 
Process value warning 

A replacement of the device is recommended. 
Contact Technical support. 



Diagnosing and troubleshooting  
12.4 Fault codes and corrective actions 

 SITRANS Probe LU240 with mA/HART 

164 Operating Instructions, 03/2021, A5E42673511-AC 

ID Symbols Message Cause/action 
FS* 

 

 

Electronics defect 
Maintenance alarm 

Defect of device electronics. 
A replacement of the device is recommended. 
Contact Technical support. 

SA* 

 

 

Non-volatile memory 
check failure 
Maintenance alarm 
 

Device electronics error. 
Restart the device. 
If error continues, device electronics may have a defect. 
Repair is required. Contact Technical support. 

Sb* 

 

 

Volatile memory check 
failure 
Maintenance alarm 

Device electronics error. 
Restart the device. 
If error continues, device electronics may have a defect. 
Repair is required. Contact Technical support. 

SC* 

 

 
(red) 

Invalid device configura-
tion 
Configuration error 

One or more of parameters are set to invalid values. 
Review configuration values and adjust as necessary. 

Sd4) 

 

 

Sensor fail-safe timer 
expired 
Maintenance required 

Parameter "Fail-safe loss of echo" is set to "Hold", and device is in loss of 
echo (LOE). Sensor is in fail-safe mode and timer has expired, based on 
value set in parameter "Fail-safe LOE timer". 
Check for changes in process conditions or obstructions in vessel. 

1) bE - mA output set to High (see parameter "Upper fault current"). Not possible in simulation 
mode. 
2) Co - mA output set to Fixed current mode (see parameter "Loop current value in multidrop 
mode"). Not possible in simulation mode. 
3) CP - mA output set to Saturated (see default parameter settings for "Lower saturation 
limit", "Upper saturation limit"). Not possible in simulation mode. 
4) Sd - Loss of echo (LOE) exists and timer has expired, therefore mA output setting is based 
on parameter "Fail-safe loss of echo". 
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12.5 Operation troubleshooting 

12.5.1 Common problems 
 
Symptom Possible cause Action 
Display blank, 
transducer not 
pulsing 

No power, incorrect 
power 

Check voltage at terminals, check wiring connections, check wiring. 

Display blank, 
transducer is puls-
ing 

Loose or disconnected 
display 

Reconnect display. 

Display shows 
"#####" instead of 
current measured 
value 

Value too large to show 
on device segment dis-
play 

Adjust units so that a smaller value can be shown on device display, e.g. 
use meters instead of millimeters. See parameter Units (02-02.01) 
(Page 105) or Custom units (Page 144), depending on your application. 

Reading fluctuates 
while material level 
is still 

Material level is changing Visually verify, if possible. 
Strong false echoes Determine source of false echoes and relocate transmitter to avoid source. 
Incorrect damping Adjust damping. See parameter Damping value (02-04.03) (Page 113) and 

Sensor damping value (03-01-04.06) (Page 131). 
Improper echo algorithm 
selection 

Set algorithm to default. If no improvement, try a different algorithm. See 
parameter Algorithm (03-01-03.01) (Page 128). 

High noise levels Verify source and minimize. See section on Noise problems (Page 166) in 
this chapter. 

Weak echo Determine cause: check noise, confidence, and echo strength. See menu 
Signal quality (M 03-01-01) (Page 127). 

Foam on surface of mate-
rial 

Eliminate source of foaming. Use stilling well. 

Rapid temperature 
changes 

If fluctuation is unacceptable, consider an alternative technology. Contact 
your Siemens representative. 

Vapors If fluctuation is unacceptable, consider an alternative product. Contact 
your Siemens representative. 

Reading is fixed, 
but material level 
changes or reading 
does not follow 
material level 

Incorrect speed of re-
sponse 

Verify response speed setting is adequate for process. See parameter Re-
sponse rate (Page 54) (set in "Quick commissioning wizard"). 

Loss of echo condition 
(LOE) 

Check noise, confidence, and echo strength. See menu Signal quality (M 
03-01-01) (Page 127). 
Ensure LOE timer is not set with too short of a time period. See parameter 
Fail-safe LOE timer (02-04.12) (Page 116).  

Agitator blade stopped in 
front of transducer (false 
echo) 

Ensure agitator is running. See note "Unavoidable false echoes from ob-
structions" below.  

Foam on surface of mate-
rial 

Eliminate source of foaming. Use stilling well. 

Incorrect algorithm used Set algorithm to default. If no improvement, try a different algorithm. See 
parameter Algorithm (03-01-03.01) (Page 128). 

Transducer mounting: 
wrong location or incor-
rectly mounted 

Ensure beam has a clear path to material surface. Verify transducer is not 
screwed into the flange too tightly. 

Unavoidable false echoes 
from obstructions 

Relocate transmitter to ensure beam has a clear path to material surface. 
Use manual TVT shaping (via engineering system) or false echo suppres-
sion. See parameters Custom TVT shaper mode (Page 225) or Auto false 
echo suppression (03-01-06.02) (Page 134). 
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Symptom Possible cause Action 
Accuracy varies Vapors present in varying 

concentrations 
Eliminate vapors or consider a different technology. Contact your Siemens 
representative. 

Thermal gradients Insulate vessel. 
Calibration required If accuracy is better when level is close to transducer and worse when level 

is far from transducer, perform calibration. See Auto sound velocity wizard 
(02-03.01) (Page 107). 
If reading is consistently inaccurate, use parameter Sensor offset (02-
03.07) (Page 110) or perform calibration. See Sensor offset wizard (02-
03.02) (Page 108). 

Reading erratic Transducer mounting: 
wrong location or incor-
rectly mounted 

Ensure beam has a clear path to material surface. Verify transducer is not 
screwed into the flange too tightly. 

Unavoidable false echoes 
from obstructions 

Use auto false echo suppression wizard. See parameter AFES wizard (01-
02) (Page 102). 

Confidence too low Check noise, confidence, and echo strength. See menu Signal quality (M 
03-01-01) (Page 127). 
Ensure LOE timer is not set with too short of a time period. See parameter 
Fail-safe LOE timer (02-04.12) (Page 116).  

Multiple echoes Check mounting location and verify material is not entering near range 
(also known as blanking or a dead zone). See parameter Near range (03-
01-02.01) (Page 128). 

Noise in the application Verify source and minimize. See section on Noise problems (Page 166) in 
this chapter. 

Incorrect reading 
(mA output and/or 
displayed value) 

mA function not assigned 
to correct measurement 

Check mA assignment. See parameter PV selection (02-01.01) (Page 103). 

When device configured 
for volume flow: correct 
exponent not selected 

Check configuration. For exponential volume flow applications, verify 
"Linearization type" is set to "Flow" and correct exponent is used. See pa-
rameter Flow exponent (02-06-05.01) (Page 122). 

Incorrect vessel or PMD 
dimensions 

For volume application, verify vessel dimensions. See parameter Vessel 
shape (02-05.01) (Page 117).  
For volume flow application, verify PMD dimensions. See menu PMD di-
mensions (M 02-06-05) (Page 120). 

When device configured 
for custom volume or 
custom volume flow 

For custom volume or volume flow applications, verify parameter "Lineari-
zation type" is set to "Custom" and X and Y values under parameter "Cus-
tomized characteristic curve" are defined. See parameters Linearization 
type (02-01.03) (Page 105) and Customized characteristic curve (M 02-
07.02) (Page 124).  

12.5.2 Noise problems 
Incorrect readings can be the result of noise problems, either acoustic or electrical, in the 
application. The noise present at the input to the ultrasonic receiver can be determined by 
using remote software (engineering system) such as SIMATIC PDM, AMS Device Manager, 
FC375/475, or DTM. In addition, see parameters Noise average (03-01-01.05) (Page 127) and 
Noise peak (03-01-01.06) (Page 127). In general, the most useful value is the average noise.  

High noise decreases the maximum distance that can be measured. An average noise level 
greater than 15 dB may be cause for concern if the maximum operation range matches the 
range of the application. 
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12.5.2.1 Determining the noise source 

Acoustical noise 

To confirm that the problem is acoustical, place several layers of cardboard over the face of 
the transducer. If the noise is reduced, the noise is definitely acoustical. 

12.5.2.2 Other noise sources 
Check that low voltage cables are not run adjacent to high voltage cables or near to electrical 
noise generators such as variable speed drives. 

The device is designed to work near heavy industrial equipment such as variable speed drives. 
Even so, it should not be located near high voltage wires or switch gear. 

12.5.2.3 Reducing electrical noise 
• Filter the noise source 

• Check grounding 

12.5.2.4 Reducing acoustical noise 
• Move the transmitter away from the noise source 

• Use a stilling well 

• Relocate or insulate the noise source 

• Change the frequency of the noise. Ultrasonic devices are sensitive to noise in the 
frequency range of the transducer employed. 

12.5.3 Measurement difficulties 
If the value in parameter "Fail-safe LOE timer" expires due to a measurement difficulty, the 
value set in parameter "Fail-safe loss of echo" displays. In rare cases, the 
SITRANS Probe LU240 may lock on to a false echo and report a fixed or wrong reading. 

Loss of echo (LOE) 

The value set in parameter "Fail-safe loss of echo" displays when the echo confidence is 
below the threshold value set in parameter "Echo threshold" (for long shot), or parameter 
"Short shot echo threshold" (for short shot). 
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LOE occurs when: 

• The echo is lost and no echo is shown above the ambient noise (resulting in low values for 
parameters "Confidence"/"Short shot confidence", and "Echo signal strength"/"Short shot 
echo signal strength"). 

• Two echoes are too similar to differentiate (when BLF algorithm used) (resulting in low 
confidence and low echo signal strength) 

• No echo can be detected within the programmed range (parameter "Far Range" can be 
used to extend range). 

If value set in parameter "Fail-safe loss of echo" displays, check if the surface monitored is 
within the transmitter maximum range. 

12.5.3.1 Adjusting transducer aiming 
For optimum performance, adjust transducer aiming to provide the best confidence and echo 
strength for all material levels within the measurement range. 

Displaying echoes 

To check echo profiles, use an engineering system such as SIMATIC PDM, AMS, FC375/475, or 
DTM. For instructions on how to display an echo profile, see section Requesting an echo 
profile (Page 66), and for details on how to interpret an echo profile, see section Echo 
processing (Page 180). 

Increase fail-safe timer value 

Increase the value in parameter "Fail-safe LOE timer" only if the fail-safe operation will not be 
compromised by the larger value. 

Try this only if LOE exists for short periods of time. 

12.5.3.2 Fixed reading 
If the reading is a fixed value, regardless of the transducer to material surface distance, 
ensure: 

• Transducer acoustic beam is free from obstruction 

• Transducer is properly aimed 

• Transducer is not in contact with any object 

• Material mixer (if used) is operating while the device is operating. If it is stopped, ensure 
that the mixer blade has not stopped directly below the transducer. 

12.5.3.3 Obstructions in the sound beam 
Check for (and remove if present) any acoustic beam obstruction, or relocate the transmitter. 

If an obstruction cannot be removed or avoided, adjust the Time Varying Threshold (TVT) 
curve to reduce the echo confidence derived from the sound reflected by the obstruction. Use 
SIMATIC PDM to adjust the TVT curve (see Custom TVT shaper mode (Page 225)). 
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12.5.3.4 Nozzle mountings 
If the transmitter is mounted on or in a nozzle, grind smooth any burrs or welds on the inside 
or open end (the end that opens into the vessel). If the problem persists, install a larger 
diameter or shorter length nozzle, bevel the inside of the bottom end, or cut the open end of 
the nozzle at a 45° angle. 

If the mounting hardware is overtightened, loosen it. Overtightening changes the resonance 
characteristics of the transducer and can cause problems. 

12.5.3.5 Set the device to ignore the bad echo 
If the preceding remedies have not fixed the problem, the false echo must be ignored. If 
there is a static, incorrect, high level reading from the device, there is probably an obstruction 
reflecting a strong echo back to the transducer. If the material level never reaches that point, 
extend parameter "Near range" to a distance just past the obstruction.  

 

To adjust the time-varying threshold (TVT) to ignore the bad echoes, use auto false echo 
suppression. If this does not correct the problem, enable custom TVT shaper mode and 
manually shape around false echoes. For more information, see: 

• Near range (03-01-02.01) (Page 128) 

• AFES wizard (Page 64) 

• Auto false echo suppression and Custom TVT (Page 182) 

12.5.4 Wrong reading 
If the reading is erratic or jumps to some incorrect value periodically, ensure: 

• Surface monitored is not beyond the transmitter's programmed range or the transmitter's 
maximum range 

• Material is not falling into the transducer’s acoustic beam 

• Material is not inside the blanking distance (parameter "Near range") of the transmitter. 

Types of wrong readings 

If a periodic wrong reading is always the same value, see section Fixed reading (Page 168). 

If the wrong reading is random, ensure the distance from the transducer to the material 
surface is less than value in parameter "Far range" minus one meter (i.e. ensure you are still 
within the measurement range programmed in the device). If the material/object monitored 
is outside this range, increase parameter "Far range" as required. This error is most common 
in OCM applications using weirs. 

Liquid splashing 

If the material monitored is a liquid, check for splashing in the vessel. Enter a lower value in 
parameter "Response rate" to stabilize the reading, or install a stilling well. (Contact Siemens 
representative.) 
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Adjust the echo algorithm 

Use SIMATIC PDM to view echo profiles and to make adjustments to parameter Algorithm 
(03-01-03.01) (Page 128). 

If multiple echoes appear on the echo profile, typical of a flat material profile (especially if the 
vessel top is domed), use the “True first echo” algorithm. Also, if the true echo has jagged 
peaks, use parameter "Reform echo".  

Should a stable measurement still not be attainable, contact Siemens representative. 

12.5.5 Transducer ringing 
If the transducer is mounted too tightly, or if it is mounted so that its side touches something 
(such as a vessel wall, or standpipe), the resonance characteristics of the transducer change 
and this can cause problems. Hand tighten only. PTFE tape is not recommended as it reduces 
friction resulting in a tighter connection that can lead to ringing. 

 
① Ring down ③ Time of correct echo 
② Echo profile ④ TVT curve 

 

 
① Ring down ③ TVT curve 
② Echo profile ④ Time of correct echo 

Ring down times that extend past the near range area can be interpreted by the device as the 
material level and are characterized by a steady high level being reported. 
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12.5.6 Echo profile display and Trend display 
To assist in troubleshooting echo profiles, pan and zoom options are available. See Echo 
profile (Page 222). 

A trend display is available with pan and zoom options. See Process values (Page 228). 
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 Technical data 13 
 

 
 

 Note 
Device specifications 

Siemens makes every attempt to ensure the accuracy of these specifications but reserves the 
right to change them at any time. 

 

 

 Note 
Device-specific approvals 

Always refer to nameplates on the device for device-specific approvals. 
 

 

 Note 
Power 

Nominal 24 V DC at maximum 550 Ohm. For other configurations, see Loop power 
(Page 192). 

 

13.1 Power 
 
 
Supply voltage 30 V DC maximum 
Signal range 4 to 20 mA 
Startup current 3.6 mA maximum 

 

 
SITRANS Probe LU240 with Explosion protection Ex ia 
Ui (Input voltage) 30 V DC maximum 
Ii (Input current) 120 mA DC maximum 
Pi (Input power) 0.8 W 
Ci (Effective inner capacitance) 0 nF 
Li (Effective inner inductance) 0 mH 
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13.2 Performance 
 
Reference operating conditions (in accordance with IEC 60770-1)  
Ambient temperature +15 to +25 °C 
Humidity 45 to 75% relative humidity 
Ambient pressure 860 to 1060 mbar 

 

 
Measurement accuracy (in accordance with IEC 60770-1) 
Measured error (accuracy) 6 m, 12 m version: 

• +/- the greater of 0.15% of range or 6 mm (accuracy 
valid from 0.25 m) 

• +/- 2 mm (0.08 inch) on ranges 4 m (13 ft) or less 
3 m version: 
• +/-10 mm 

Non-repeatability ≤ 3 mm (0.12") (included in accuracy specification) 
Deadband (resolution) ≤ 3 mm (0.12") (included in accuracy specification) 
Hysteresis error Not applicable 

 

 
Analog output accuracy (in accordance with IEC 60770-1) 
Measured error (accuracy) ±0.0096 mA  
Non-repeatability <1 μA (included in accuracy specification) 
Deadband (resolution) <1 μA (included in accuracy specification) 
Hysteresis error Not applicable 

 

 
Frequency 54 KHz 
Measurement range1) • Up to 3 m (3 m version) 

• Up to 6 m (6 m version) 
• Up to 12 m (12 m version) 

Blanking distance 0.2 m (0.66 ft) 
Update time at 4 mA <4 s 
Beam angle 10° at -3 dB boundary 
Temperature compensation Integrated to compensate over temperature range 
Memory Non-volatile EEPROM, no battery required 

1) Reference point for measurement is the transducer face (also known as sensor reference 
point). 
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13.3 Interface 
 
HART (6 m, 12 m version) Standard, integral to analog output 
Configuration Local buttons, or engineering system (6 m, 12 m version), 

such as Siemens SIMATIC PDM (via PC) 
Display (local) Multi-segment alphanumeric liquid crystal, with bar graph 

(representing Level) 

13.4 Outputs 
 
Analog output • 4 to 20 mA 

• 800 ohms maximum 
• ±0.0096 mA 
• Resolution of <1 μA 

13.5 Construction 
 
Process connections • 2" NPT (ASME B1.20.1) (tapered thread) 

• R 2" [(BSPT), EN 10226-1] (tapered thread) 
• G 2" [(BSPP), EN ISO 228-1] (parallel thread) 

Transducer/nosecone • Buna-N seal 
• PVDF (polyvinylidene fluoride) 
• ETFE (ethylene-tetrafluoroethylene) 

Enclosure Body material Plastic (PBT/PC - polybutylene tereph-
thalate/polycarbonate) 

Electrical connections/cable 
entries 

• 2 x M20 x 1.5 (one general purpose 
cable gland and one blocking plug 
provided) 

• 1 x 1/2" NPT 

Ingress protection • IP66, TYPE 4X 
• IP68, TYPE 6 

Clear lid Plastic (PBT/PC - polybutylene terephthalate/polycarbonate) 
Blind lid Plastic (PC - polycarbonate) 
Weight 0.93 kg 
Installation torques Cable gland to enclosure  

(Siemens supplied, metric) 
10 Nm 
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 Note 
Specific configuration requirements 

Check the ambient and operating temperatures under Operating conditions (Page 175) and 
Process (Page 175); also check Approvals (Page 176) for the specific configuration you are 
about to use or install. 

Use approved cable gland/conduit seal to maintain Type 4X, Type 6, IP66, IP68 ratings.  
 

For dimensions of parts listed above, see Dimension drawings (Page 177). 

13.6 Operating conditions 
 
Location Indoor/outdoor 
Altitude 5000 m (16,404 ft) maximum 
Vibration resistance 0.5 g at frequencies from 10 Hz to 100 Hz 
Bump/shock resistance 25 g 
Ambient temperature Storage -40 to +85 °C 
 Operating -40 to +80 °C 
 Operating - MCERTS -40 to +55 °C 
Relative humidity Suitable for outdoor (TYPE 4X, TYPE 6, IP66, IP68 enclosure) 
Installation category I 
Pollution degree 4 
EMC performance Emission EN 55011/CISPR-11 
 Immunity EN/IEC 61326-1 (Industry) 

13.7 Process 
 
Temperature (at flange or threads)  -40 to +85 °C (-40 to +185 °F) 
Pressure (vessel) 0.5 bar g/7.25 psi g (maximum) 
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13.8 Communication 
 
Communication type • HART 

• 4 to 20 mA 

Supported engineering systems 
(6 m, 12 m version) 

• SIMATIC PDM 
• AMS Device Manager 
• FC375/FC475 
• FDT (such as Pactware, or Fieldcare) 
• SITRANS library for use with PCS-7 

13.9 Approvals 
 
General FM/CCSAUS, CE, KC, RCM, EAC 
Hazardous Intrinsic 

safety 
Europe ATEX II 1 G, Ex ia IIC T4 Ga 
International IECEx SIR 18.0013X, Ex ia IIC T4 Ga 
US/Canada FM/CCSAUS 

Class I, Div.1, Groups A, B, C, D 
Class II, Div.1, Groups E, F, G 
Class III T4 

Brazil INMETRO Ex ia IIC T4 Ga 
China NEPSI Ex ia IIC T4 Ga 
Japan CSA UK Ex ia IIC T4 Ga 
Korea KCs Ex ia IIC T4 
Russia EAC Ex 1G Ex ia IIC T4 Ga 
South Africa SABS Ex ia IIC Tx Ga 

 Non-
incendive 

US FM  
Class I, Div. 2, Groups A, B, C, D Tx 

Marine ABS American Bureau of Shipping Type Approval 
BV Bureau Veritas Type Approval 
CCS China Classification Society 
DNV-GL Det Norske Veritas - Germanischer Lloyd 
LR Lloyd's Register of Shipping 

Metrology 
 

CPA China Pattern Approval 
MCERTS Monitoring Certification Scheme • 6 m, 12 m version 

• Certified to +55 °C 

Overfill protec-
tion 

VLAREM II  
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 Dimension drawings 14 
14.1 SITRANS Probe LU240 dimensions 

 

 

Dimensions in mm (inch) 
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14.2 Flange adaptor (optional) 
SITRANS Probe LU240 can be fitted with the optional 3" (80 mm) flange adaptor for mating to 
3" ANSI, DIN 65PN10, and JIS 10K3B flanges. 

 

Dimensions in mm (inch) 
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 Technical reference A 
A.1 Principle of operation 

The transducer emits a series of ultrasonic pulses: each pulse is reflected as an echo from the 
material and sensed by the transducer. The echo is processed by the device using Siemens’ 
proven Process Intelligence techniques. Filtering is applied to help discriminate between the 
true echo from the material, and false echoes from acoustic and electrical noises and agitator 
blades in motion. 

The time for the pulse to travel to the material and back is temperature compensated and 
then converted into distance for display and mA output. 

A.1.1 Process values 
The primary variable (PV) and the secondary variable (SV) (set in PV selection (02-01.01) 
(Page 103), and SV selection (02-01.02) (Page 104)), can be selected from one of five 
process values:  

• Level - difference between material level and lower calibration point 

• Space - difference between material level and upper calibration point 

• Distance - difference between material level and sensor reference point 

• Volume - volume of material based on level 

• Volume flow - flowrate in an open channel, based on level (open channel level also 
known as head) 

• Custom 

In addition to the selections above, the secondary variable (SV) can also be set to Sensor 
temperature. 

A.1.2 Transmit pulse 
The transmit pulse consists of one or more electrical “shot” pulses, which are supplied to the 
transducer. The transducer fires an acoustic “shot” for each electrical pulse supplied. After 
each shot is fired, sufficient time is provided for echo (shot reflection) reception before the 
next shot is fired. After all shots of the transmit pulse are fired, the resultant echoes are 
processed. The transmit pulse shot number, duration, delay, and associated measurement 
range are defined by parameters under Setup (M 02) (Page 103). 
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A.2 Echo processing 
Echo processing consists of echo enhancement, true echo selection, and selected echo 
verification. 

Echo enhancement is achieved by filtering 1) and reforming 2) the echo profile. The true echo 
(echo reflected by the intended target) is selected when that portion of the echo profile 
meets the evaluation criteria of Process Intelligence. Insignificant portions of the echo profile 
outside of the measurement range 3), below the TVT curve 4), and less than the confidence 
threshold 5), are automatically disregarded. The remaining portions of the echo profile are 
evaluated using the selected algorithm 6). The echo profile portion providing the best echo 
confidence 7) is selected. 

True echo verification is automatic. The position (relation in time after transmit) of the new 
echo is compared to that of the previously accepted echo. When the new echo is within the 
echo lock window 8), it is accepted, and displays and outputs are updated per the rate 
parameters 9). If the new echo is outside of the window, it is not accepted until echo lock 
requirements 10) are satisfied. 

 
 
1) Narrow echo filter (03-01-04.01) (Page 129) 6) Algorithm (03-01-03.01) (Page 128) 
2) Reform echo (03-01-04.02) (Page 130) 7) Confidence (03-01-01.02) (Page 127) 
3) Lower calibration point (02-03.03) 
(Page 110) 

8) Echo lock window (03-01-05.02) (Page 132) 

4) Custom TVT shaper mode (Page 225) 9) Fill rate (02-02.02) (Page 106) and Empty 
rate (02-02.03) (Page 106) 

5) Echo threshold (03-01-03.03) (Page 129) 10) Echo lock (03-01-05.01) (Page 132) 
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A.2.1 Echo selection 

A.2.1.1 TVT (time varying threshold) curves 
A TVT curve describes a threshold below which any echoes will be ignored. The default TVT 
curve is used, until Auto false echo suppression (03-01-06.02) (Page 134) and Auto false 
echo suppression range (03-01-06.03) (Page 135) are used to create a new ’learned TVT 
curve’. 

 
① Default TVT ③ Material level 
② Echo profile ④ Echo marker 

A TVT hovers above the echo profile to screen out unwanted reflections (false echoes). In 
most cases the material echo is the only one which rises above the default TVT. In a vessel 
with obstructions, a false echo may occur. For more information, see Auto false echo 
suppression and Custom TVT (Page 182). 

The device characterizes all echoes that rise above the TVT as potential good echoes. Each 
peak is assigned a rating based on its strength, area, height above the TVT, and reliability, 
among other characteristics. 

A.2.1.2 Algorithm 
The true echo is selected based on the setting for the echo selection algorithm. (A full list of 
supported algorithms can be found at Algorithm (03-01-03.01) (Page 128).) All algorithms 
ultimately use confidence to select the true echo. 

Below are the preferred algorithm types because they provide the best echo selection results 
in most applications. Other algorithms may produce better results in specialized applications, 
but they should only be used after consulting an experienced technical expert. 
 
Algorithm Echo determination Suggested use 
ALF Area largest first 

echo 
Selects the echo with the 
highest confidence value 
based on the three criterion 
(widest, highest, and first). 

Use in mid to long range solids applica-
tions where the material return echo is 
wide and large, and where competing 
smaller echoes challenge BLF. 

L Largest echo Selects the largest echo above 
the TVT curve. 

Use in long range liquids applications 
with large (tall) material return echoes. 

AL Largest echo 
area 

Selects the echo with the 
largest area. 

Use in solids applications with a high 
angle of repose. 
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Algorithm Echo determination Suggested use 
BLF Best echo of the 

first and largest 
echo 

Selects the echo (first and 
highest) with the highest 
confidence value. 

Default and most commonly used. Use 
in all short to mid range general liquids 
and solids applications where there is a 
relatively large (tall), sharp echo. 

TF True first echo Selects the first echo that 
crosses TVT curve. 

Use in liquids applications free of ob-
structions when confidence of first echo 
is high. 

A.2.1.3 Confidence 
Confidence (03-01-01.02) (Page 127) describes the quality of an echo. Higher values 
represent higher quality. 

A.2.1.4 Echo threshold 
Echo threshold (03-01-03.03) (Page 129) defines the minimum confidence value required for 
an echo to be accepted as valid and evaluated. 

A.2.1.5 Auto false echo suppression and Custom TVT 
If you have a vessel with known obstructions, use auto false echo suppression to prevent 
false echo detection. If the device displays a false high level, or the reading is fluctuating 
between the correct level and a false high level, this typically is the result of obstructions in 
the vessel. 

False echoes can be caused by an obstruction in the transducer shot path (such as pipes, 
ladders, chains). Such false echoes may rise above the default TVT curve.  

The device takes a profile for the whole measurement range and the TVT is shaped around all 
echoes present at that moment. 

Parameter Auto false echo suppression range (03-01-06.03) (Page 135) specifies the range 
within which the learned TVT is applied. Default TVT is applied over the remainder of the 
measurement range.  

The material level should be below all known obstructions at the moment when the TVT is 
learned. Ideally the vessel should be empty or almost empty. 

AFES range must be set to a distance shorter than the distance to the material level when the 
environment was learned, to avoid the material echo being screened out. 

 

 Note 
TVT "Learn" 

Although the parameters "Auto false echo suppression" and "Auto false echo suppression 
range" may be adjusted on their own, the "Auto false echo suppression wizard" must be used 
to "learn" the TVT. 
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 Note 
AFES automatically disabled 

The device will automatically reset parameter "Auto false echo suppression" to "Disabled" 
under the following conditions: 
• Parameter "Auto false echo suppression" is manually enabled, and an initial device TVT 

learn is never requested (via AFES wizard) 
• Parameter "Auto false echo suppression" is enabled (either manually or automatically 

based on previous TVT learn using AFES wizard), and a new TVT learn request fails (for 
example, due to a power failure during the learn process). 

To avoid situations where AFES is disabled by the device, use "Auto false echo suppression 
wizard" initially. The wizard will store a learned TVT and enable AFES.  

If AFES is later disabled then re-enabled, the stored TVT will be used. 
 

 

 Note 
Persistent false echoes 

If, after using AFES, a problem with false echoes persists, ensure that the learned TVT is 
representative. 
• Review settings for other tuning and filter adjustment parameters (such as "Narrow echo 

filter", "Reform echo", "Hover level", etc.) before readjusting auto false echo suppression. 
 

Example before Auto false echo suppression 

 
① Default TVT ⑤ Upper calibration point = 0.5 m 
② False echo ⑥ Obstruction at 4 m 
③ Material echo ⑦ Material level at 9 m 
④ Sensor reference point ⑧ Lower calibration point = 12 m 
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Example after Auto false echo suppression  

 
① Learned TVT (applied within AFES range) 
② Auto false echo suppression range (set to 6 m) 
③ Default TVT (applied outside AFES range) 
④ Material echo 
⑤ Echo marker 
⑥ False echo 

Custom TVT breakpoints 

This feature allows you to manually adjust the TVT to avoid false echoes caused by 
obstructions. The feature is available remotely, using an engineering system such as SIMATIC 
PDM. "Enable" parameter "Custom TVT shaper mode", then customize up to 40 breakpoints. 
See Custom TVT breakpoints (Page 223). 

A.2.2 Measurement range 
The crystal which produces the transmit pulse has to stop vibrating before it can receive an 
echo. The blanking distance (set in Near range (03-01-02.01) (Page 128) ) is the space in 
front of the transducer face where level measurement is not possible, because within that 
distance, the echo would return before the vibration had ceased. The reference point for 
measuring the blanking distance is the transducer face (sensor reference point).  

Near range (03-01-02.01) (Page 128) programs the device to ignore the area in front of the 
transducer. The default value is 0.2 m (1 ft) from the sensor reference point. Near range can 
be increased from its factory default, but it is generally recommended that Auto false echo 
suppression (Page 182) be used instead. 

Far range (03-01-02.02) (Page 128) can be used in applications where the base of the vessel 
is conical or parabolic. A reliable echo may be available below the vessel empty distance 
(Lower calibration point (02-03.03) (Page 110)) due to an indirect reflection path. Increasing 
Far range by 30% or 40% can provide stable empty vessel readings. 
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A.2.3 Measurement response 
 

 Note 
Related rate parameters 

Parameter "Response rate" is set in Quick commissioning (Page 42), and the related fill and 
empty rate parameters are always defined in meters per minute. 

 

Response rate (Page 49) limits the maximum rate at which the display and output respond to 
changes in the measurement. There are three preset options: slow (default), medium, and 
fast.  Once the real process fill/empty rate (m/min by default) is established, a response rate 
can be selected that is slightly higher than the application rate. "Response rate" automatically 
adjusts the three rate parameters that affect the output response rate. 
 
When "Response rate" set to: "Fill rate" (02-02.02)/"Empty 

rate"  
(02-02.03) automatically ad-
just to: 

"Sensor damping value" 
(03-01-04.06) automatically 
adjusts to: 

Slow 0.1 m/min 100.0 s 
Medium 1.0 m/min 10.0 s 
Fast 10.0 m/min 0.0 s 

A.2.3.1 Damping 
Damping values [set in parameters Sensor damping value (03-01-04.06) (Page 131) and 
Damping value (02-04.03) (Page 113)] smooth out the response to a sudden change in level. 
This is an exponential filter and the engineering unit is always in seconds. 

In five time constants, the output rises exponentially: from 63.2% of the change in the first 
time constant, to almost 100% of the change by the end of the fifth time constant. 

Damping example 

Time constant = 2 seconds 

Input (level) change = 2 meters 
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 Note 
Response to rate changes 

The parameter "Sensor damping value" can be set to zero in order to display measurement 
readings as fast as fill/empty rates permit. Parameters "Fill rate" and "Empty rate" work in 
conjunction with parameter "Sensor damping value", therefore if readings are slow to 
respond to changes, check that fill and empty rates are set to values greater than or equal to 
the desired response rate. 

 

For more information, see Sensor damping value (03-01-04.06) (Page 131), and Damping 
value (02-04.03) (Page 113). 

A.3 Current output 
The current output is proportional to material level in the range 4 to 20 mA. 0% and 100% are 
percentages of the full-scale reading (m, cm, mm, ft, in). Typically, current output is set so 
that 4 mA equals 0% and 20 mA equals 100%. 

PV selection (02-01.01) (Page 103) controls the current output and applies any relevant 
scaling. By default, the PV is set to Distance. Other options are Level, Space, Volume, Volume 
flow, or Custom. (Use Loop test (M 03-03) (Page 136) to test the functioning of the loop.)  

The current output can also be set to report a certain mA value when the device is in an error 
condition. Set the desired mA value in parameter "Upper fault current" (e.g. 22.5 mA) or 
"Lower fault current" (e.g. 3.8 mA). Next, go to parameter "Fault current" and select option 
"Upper fault current" or "Lower fault current" (whichever one includes the desired mA value). 

You can also set the mA output to report when the device is in an error condition and the fail-
safe timer has expired. Set parameter "Fail-safe loss of echo" to use last valid reading or value 
in parameter "Fault current". 
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A.3.1 Fail-safe 
Fail-safe settings are used to put the process into a safe mode of operation in the event of a 
fault or failure. Fault current (02-04.10) (Page 116) sets the value (as displayed in Loop 
current, in measurement view of local display) to be reported in the event of a fault. Set this 
value so that a loss of signal triggers the same response as an unsafe level.  

Loss of echo (LOE) 

A loss of echo (LOE) fault occurs when the calculated measurement is considered unreliable 
because the echo Confidence value has dropped below the Echo threshold. 

For an LOE fault, Fail-safe LOE timer (02-04.12) (Page 116) determines the length of time a 
loss of echo (LOE) condition will persist before a fail-safe state is activated. The default 
setting is 100 seconds.  

Fail-safe loss of echo (02-04.11) (Page 116) determines the mA value (corresponding to the 
selected PV) to be reported when Fail-safe LOE timer expires. Choose between the last valid 
reading ("Hold" = default) or the value set in parameter "Fault current". 

Upon receiving a reliable echo, the loss of echo condition is aborted, the Maintenance 
required icon and error message are cleared, and the current output returns to the current 
material level. 

If two faults are present at the same time, the device status indicator and text for the highest 
priority fault will display. For example, if both loss of echo (PV status: uncertain) and broken 
cable (Sensor break) faults are present, the broken cable fault will display. 
 
Failure  
Sensor break (Fo) 

  

Out of specification 
PV status: uncertain (CU)    

A.4 Distance calculation 
To calculate the transducer to material level (object) distance, the transmission medium 
(atmosphere) Sound velocity (02-03.08) (Page 111) is multiplied by the acoustic transmission 
to reception time period. This result is divided by two to calculate the one-way distance.  

Distance = Sound velocity x Time / 2  

The reading displayed is the result of performing any additional modification to the 
calculated distance as determined by: 

• PV selection (02-01.01) (Page 103) 

• Volume units (02-05.04) (Page 118) 

• Volume conversion parameters - Volume (M 02-05) (Page 116), and Sensor offset (02-
03.07) (Page 110) 

• Volume flow parameters - Volume flow (M 02-06) (Page 119) 
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A.4.1 Sound velocity 
The sound velocity of the transmission medium is affected by the type, temperature, and 
vapor pressure of the gas or vapor present. As preset, the device assumes the vessel 
atmosphere is air at 20 °C (68 °F). Unless altered, the sound velocity used for the distance 
calculation is 344.1 m/s (1129 ft/s). 

Variable air temperature is automatically compensated by use of a temperature sensor in the 
transducer of the device. If the transmitter is exposed to direct sunlight, use of a sunshield is 
recommended. 

Atmosphere composition other than air can pose a challenge for ultrasonic level 
measurement. However, excellent results may be obtained by performing a sound velocity 
calibration (Auto sound velocity wizard (02-03.01) (Page 107)) if the atmosphere is: 

• Homogenous (well-mixed) 

• At a fixed temperature 

• Under constant vapor pressure 

The device automatic temperature compensation is based on the sound velocity/temperature 
characteristics of “air” and may not be suitable for the atmosphere present. If the atmosphere 
temperature is variable, perform frequent sound velocity calibrations to optimize 
measurement accuracy. 

Sound velocity calibration frequency may be determined with experience. If the Sound 
velocity (02-03.08) (Page 111) in two or more vessels is always similar, future calibrations 
may be performed on one vessel and the resultant sound velocity entered directly for the 
other vessel(s). 

When the sound velocity of a vessel atmosphere is found to be repeatable at specific 
temperatures, a chart or curve may be developed. Then, rather than performing a sound 
velocity calibration each time the vessel temperature changes significantly, the anticipated 
sound velocity may be entered directly. 

 

 Note 
Changing sound velocity 

Sound velocity can be changed via remote engineering system. In PDM, the parameter 
"Sound velocity (20 °C)" can be found in "Setup > Calibration".  

 

A.5 Volume calculation 
The device provides a variety of volume calculation features such as: 

• Vessel shape (02-05.01) (Page 117) 

• Upper scaling point (02-05.05) (Page 118) 

• Vessel dimension A (02-05.02) (Page 118) 

• Vessel dimension L (02-05.03) (Page 118) 

If the vessel does not match any of the preset vessel shapes, a custom volume calculation 
may be used. Use the level/volume graph or chart provided by the vessel fabricator (or create 
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one based on the vessel dimensions). Based on the graph, select the level versus volume 
breakpoints (X-value, Y-value) to be entered (maximum of 32) under menu Customized 
characteristic curve (M 02-07.02) (Page 124). Generally, the more breakpoints entered, the 
greater the accuracy. 

 

 Note 
Custom application 

The "Customized characteristic curve" menu is only visible when parameter "Operation" (via 
the quick commissioning wizard), or "PV selection" in the navigation view) is set to 'Custom'. 

 

Creating a customized characteristic curve  
 
Breakpoint number Level breakpoint 

(X-value n) 
Volume breakpoint 
(Y-value n) 

1 0 m 0 
2 1 m 200 
3 2 m 1200 
4 6 m 2600 

 

This volume calculation creates a piece-wise linear approximation of the level/volume curve, 
providing best results if the curve has sharp angles joining relatively linear sections.  

Enter a level breakpoint (X-value) at each point where the vessel shape bends sharply 
(minimum of two). For shapes that are mostly linear but include one or more arcs, enter 
numerous breakpoints along the arc for best volume calculation accuracy. 

A.6 Volume flow calculation 
Special emphasis has been placed on providing the most accurate flow calculations possible. 
To this end, specific routines have been written to comply with the British Standards 
Institute’s Specifications BS-3680. These routines calculate correction factors taking into 
account second order effects, such as approach velocity and boundary layer.  

If the PMD does not match any of the preset PMD calculations, or if a PMD is not used, a 
custom flow calculation may be used. Use the level/volume flow graph or chart provided by 
the PMD fabricator (or create one based on the PMD or channel dimensions). Based on the 
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graph, select the level versus volume flow breakpoints (X-value, Y-value) to be entered 
(maximum of 32) under menu Custom (M 02-07) (Page 124). Generally, the more 
breakpoints entered, the greater the accuracy. 

 

 Note 
Custom application 

The "Customized characteristic curve" menu is only visible when parameter "Operation" (via 
"Quick commissioning wizard"), or "PV selection" in the navigation view) is set to 'Custom'. 

 

Creating a customized characteristic curve 

Example: V-notch weir 
 
Breakpoint number Level breakpoint 

(X-value n) 
Volume flow breakpoint 
(Y-value n) 

4 0.4 m 113.5 
3 0.3 m 55.3 
2 0.2 m 20.07 
1 0 m 0 

 

This calculation creates a piece-wise linear approximation of the level/flow curve, providing 
best results if the curve is non-linear and there are no sharp angles. 

Select at least enough breakpoints from the curve to satisfy the following: 

• Two breakpoints very near the minimum level 

• Minimum two breakpoints near mid-section of PMD 

• Two breakpoints very near the maximum level 

For combination curves, enter at least two breakpoints immediately before and after any 
sharp angle (as well as one breakpoint exactly at the angle) on the curve. 
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A.6.1 Method of flow calculation 
The device can be programmed to use either of two methods for calculating volume flow 
from the level measurement: absolute or ratiometric. The result is the same regardless of the 
method used. The main difference is the information that must be entered in order for the 
device to carry out the calculation. Refer to Primary measuring device (02-06.01) (Page 119) 
and PMD dimensions (M 02-06-05) (Page 120) for a list of information required. 

For the ratiometric method, it is usually sufficient that the user know the volume flow rate 
(Qcal) which occurs at maximum level (Hcal).  

On the other hand, absolute calculations require that the user enter information such as the 
physical dimensions of the PMD and the constant relating to units of measure for both linear 
dimensions and volume flow rates. 

Example:  

The general formula for volume flow through a single exponent PMD is:  

Q = KHx 

The specific formula for volume flow through a 45 ° V-notch weir is:  

cfs = 1.03H2.5 

Thus: Q = flow in cubic feet per second  

K = constant of 1.03  

H = head in feet ('Head' also referred to as 'Level'. For maximum level, see Upper scaling point 
(02-06.04) (Page 120).) 

The absolute method is not applicable to the following:  

• Palmer-Bowlus flume  

• H-flume 
 

 Note 
Accurate flow calculation 

In a volume flow application using exponential device, and absolute method of flow 
calculation, the following must be consistent for flow calculation to be valid: 
• Engineering units for level (parameter "Units") 
• Engineering units for volume flow (parameter "Volume flow units") 
• Constant factor (parameter "K-factor"). 

 

A.7 Chemical compatibility 
The SITRANS Probe LU240 enclosure and lid (with window) are made of a PBT/PC blend of 
plastics. The blank lid is made of PBT plastic, and the transducer is available in ETFE and PVDF. 

All plastic materials used in the construction of the Probe LU240 are resistant to attack from 
most chemicals. For exposure to specific environments, check with chemical compatibility 
charts before installing and operating device in your application. 
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A.8 Startup behavior 
• The device draws less than 3.6 mA at startup (when parameter "Fault current" set to 

default value "Lower fault current"). 

• Time to first measurement is typically 25 seconds. 

A.9 Loop power 
 

 Note 
Loop voltage 

Loop voltage is the voltage at the terminals of the power supply (not the voltage at the 
terminals of the device). 

 

Loop resistance versus Loop voltage 

 
① Loop voltage VL ④ SITRANS Probe LU240 
② Power supply ⑤ Loop current IL 
③ Loop resistance RL   

 
① Loop resistance - RL 
② Loop voltage - VL 
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 Note 
HART communication 

For example as per graph, when using HART communication with 240 Ohms of Loop 
resistance (RL), the minimum Loop voltage (VL) is 16 V DC. 

 

A.10 Hazardous area installations 

A.10.1 Intrinsically safe model 
Under the entity evaluation concept, SITRANS Probe LU240 has the following characteristics:  
 
(input voltage) Ui = 30 V DC (maximum) 
(input current) Ii = 120 mA DC (maximum) 
(input power) Pi = 0.8 W 

Definition:  

The Entity Concept allows interconnection of intrinsically safe apparatus to associated 
apparatus not specifically examined in such combination. The criteria for interconnection is 
that the voltage and current which intrinsically safe apparatus can receive and remain 
intrinsically safe, considering faults, must be equal to or greater than the output voltage (Uo) 
and output current (Io) levels which can be delivered by the associated apparatus, 
considering faults and applicable factors. In addition, the maximum unprotected capacitance 
(Ci) and Inductance (Li) of the intrinsically safe apparatus, including interconnecting wiring, 
must be equal to or less than the capacitance and inductance which can be safely connected 
to associated apparatus. 

FM/CCSAUS  

• Approved dust-tight and water-tight conduit seals are required for outdoor IP66 (TYPE 4X), 
and/or IP68 (TYPE 6) locations.  
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• The maximum voltage of the non-intrinsically safe apparatus must not exceed 250 V rms.  
 
Hazardous area 
Zone 0,1, or 2 

Non-hazardous area 

 
① Load 4...20 mA 
② Certified barrier 
③ PLC (active) 
④ HART handheld communicator 

EU equivalency  

Any zener diode safety barrier, certified by an EU approved certification body to [ EEx ia ] IIC, 
its output voltage (Uo) not exceeding 30 V and its output current (Io) limited by load 
resistance (Ro); such that Io = Uo / Ro, does not exceed 120 mA. 

IS safety barrier selection  

Selecting a suitable barrier or power supply requires knowledge about Intrinsic Safety and the 
application. It is the responsibility of the installer to ensure that the intrinsically safe 
installation complies with both the apparatus approval requirements and the relevant 
national code of practice.  
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How to select a passive barrier for SITRANS Probe LU240 

1. Make sure that the barrier safety description is suitable for the SITRANS Probe LU240 
Intrinsically Safe (IS) input parameters. 

2. Determine the maximum end-to-end resistance of the barrier (Re-e) from the data sheet. 

3. Determine other loop resistance (Rloop): for example, sense resistance, displays, and/or PLC 
inputs. 

4. Calculate Rworking = Re-e + Rloop. 

5. Determine any non-linear voltage drops due to the barrier (Vbarrier) from the barrier data 
sheet (for example, voltage drops due to diodes). 

6. Calculate Vworking = Vsupply – Vbarrier. 

7. Using Vworking and Rworking, confirm that operation is within the shaded area of the graph 
showing loop resistance versus loop voltage, under Loop power (Page 192). 

 



 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 196 

 HART communication B 
 

 

Specific device versions (6 m, 12 m) support HART communication protocol. 

Highway Addressable Remote Transducer (HART) is an industrial protocol that is 
superimposed on the 4 to 20 mA signal. It is an open standard and full details about HART 
can be obtained from: 

• HART Communication Foundation (https://fieldcommgroup.org/) 

SITRANS Probe LU240 can be configured over the HART network using the HART 
Communicator 375/475 by Emerson, or a software package. The recommended software 
package is the SIMATIC Process Device Manager (PDM) by Siemens. 

HART version 

SITRANS Probe LU240 conforms to HART revision 7.6. 

HART multi-drop mode  

HART multi-drop mode allows the connection of multiple field devices via HART. To setup 
multi-drop mode via a HART network, the polling address must be set. 

To set up multi-drop mode via the HMI: 

1. Set the polling address (Polling address (04.01) (Page 139)) 

2. Set the device mode (Loop current mode (02-04.01) (Page 113)) 

3. Set the mA value for multi-drop mode (Loop current value in multidrop mode (02-04.02) 
(Page 113)) 

SIMATIC PDM  

This software package is designed to permit easy configuration, monitoring, and 
troubleshooting of HART devices. The HART EDD for SITRANS Probe LU240 was written with 
SIMATIC PDM in mind and has been extensively tested with this software. For more 
information, see SIMATIC PDM (Page 199). 

HART Electronic Device Description (EDD)  

In order to configure a HART device, the configuration software requires the HART Electronic 
Device Description specific to the device. Download the HART EDD for SITRANS Probe LU240 
from the product page of our website: 

• Product page (www.siemens.com/sitransprobelu240) 

Click "Support > Software Downloads". Older versions of the library will have to be updated 
in order to use all the features of SITRANS Probe LU240.  

https://fieldcommgroup.org/
http://www.siemens.com/sitransprobelu240
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HART status  

Information on HART status is outlined in an application guide Working with HART 
networks, which can be downloaded from the product page of our website: 

• Product page (www.siemens.com/sitransprobelu240) 

Under More information, click Application guides. 

B.1 Communication connections 
The SITRANS Probe LU240 can be connected to a computer system via a HART modem 
(connected to the mA OUT/HART terminal block).  

Typical PLC/mA configuration with passive HART connection 

 
① Power supply ④ HART modem 
② PLC ⑤ HART communicator 
③ R= 250 Ω   

 

 Note 
HART configuration 
• Depending on the system design, the power supply may be separate from the PLC, or 

integral to it. 
• HART resistance [total loop resistance, that is, cable resistance plus 250 Ohm (resistor)] 

must be limited according to the allowable operating area as shown in graph under Loop 
power (Page 192). 

 

A HART network requires a polling address be configured. 

http://www.siemens.com/sitransprobelu240
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B.2 Configuring communication ports 
 

 Note 
HART modem 

It is recommended that only HCF registered modems be used. 
 

Polling address 

Polling address (04.01) (Page 139) (or poll ID) is a unique identifier for the device on a HART 
network. 
 
Setting 0 to 63 (Set within range of 0 to 15 if HART 5 master used.) 
Default 0 

Prior to HART 6, the polling address was set to 0 for point to point operation. For HART 
multidrop mode, the device was set to any value other than 0 within the range. (Setting a 
non-zero address forced the device into fixed current mode.)  

With HART 6 and above (version 7.6 supported by SITRANS Probe LU240), multidrop mode no 
longer depends on the polling address. However, it is recommended that a non-zero address 
be set to avoid confusion based on previous HART requirements.  

To put SITRANS Probe LU240 into multidrop mode, disable Loop current mode (02-04.01) 
(Page 113). When Loop current mode is disabled, a low fixed current is used, allowing for 
multiple devices to be connected. (A custom fixed current value can be entered in Loop 
current value in multidrop mode (02-04.02) (Page 113).) 

B.3 Communication troubleshooting 
For more information, refer to Communication troubleshooting (Page 155). 
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 Remote operation C 
C.1 SIMATIC PDM 
 

 Note 
Requirement for remote operation 

Specific device versions (6 m, 12 m) support HART communication protocol required for 
remote operation. 

 

SIMATIC PDM is a software package used to commission and maintain process devices. Please 
consult the operating instructions or online help for details on using SIMATIC PDM.  

Check the support page of our website to make sure you have the latest version of SIMATIC 
PDM, the most recent Service Pack (SP) and the most recent hot fix (HF). Go to: 

Software downloads (http://www.siemens.com/processinstrumentation/downloads) 

In the Product tree, navigate to: "Automation Technology > Process control systems > 
SIMATIC PCS 7 > System components > Plant Device Management > SIMATIC PDM". 

C.1.1 Initial setup 
To ensure that SIMATIC PDM connects properly, complete the following two processes: 

1. Deactivate buffers 

2. Update the Electronic Device Description (EDD) 

C.1.1.1 Deactivating buffers 
This deactivation is required to align SIMATIC PDM with the HART modem when using a 
Windows® operating systems. Windows® is a registered trademark of the Microsoft 
Corporation. 

 

 Note 
Connecting via serial port 
• Deactivating buffers is only necessary when connecting via RS232 (COM1) as opposed to 

USB. 
• You will need administrative rights on your operating system to deactivate buffers. 
• Check SIMATIC PDM installation documentation for hardware and software requirements. 

 

1. From the computer desktop, click "Start > Control Panel" to begin configuration. 

2. Click "System and Security", then select "Device Manager" under "System". 

http://www.siemens.com/processinstrumentation/downloads
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3. Open folder "Ports" and double click the COM Port used by the system to open the 
properties window. 

4. Select the tab "Port Settings" tab and click the "Advanced" button. 

5. If the "Use FIFO buffers" radio box is selected, click to deselect. 

 
① Deselect Use FIFO buffers radio box 

6. Click OK to close out. Close all screens and then restart the computer. 

C.1.2 Updating Electronic Device Description (EDD) 
You can locate the EDD in Device Catalog, under "Sensors > Level > Echo > Siemens AG > 
SITRANS Probe LU240". The EDD revision must match the Firmware revision in the device. 

To install a new EDD:  

1. Download the most current EDD from our website: Software downloads 
(http://www.siemens.com/processinstrumentation/downloads) 

2. Save files to your computer and extract the zipped file to an easily accessed location. 

3. Launch SIMATIC PDM – Device Integration Manager. From the File menu, click "Read 
device descriptions from compressed source...". 

4. Browse to the unzipped EDD file, select and open it. 

5. Use the "Integration" function to integrate the EDD into the device catalog. The EDD is now 
accessible via SIMATIC Manager. 

C.1.2.1 Configuring a new device 
 

 Note 
Configuring device via SIMATIC PDM 
• Clicking "Cancel" button during an upload from device to SIMATIC PDM will result in some 

parameters being updated. 
• Application guides for setting up HART devices with SIMATIC PDM are available. They can 

be found under Support. Go to:  
Product page (www.siemens.com/sitransprobelu240) 

 

http://www.siemens.com/processinstrumentation/downloads
http://www.siemens.com/sitransprobelu240
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1. Check that you have the most recent EDD, and if necessary update it. See Updating 
Electronic Device Description (EDD) (Page 200). 

2. Launch SIMATIC Manager and create a new project for the device. 

3. Open the menu "Device > Reset > Factory reset". Select "Yes" button and click "OK" to 
perform a reset to factory defaults. 

4. After the reset is complete upload parameters to the PC/PG. 

5. Configure the device via the quick start wizard. (See Wizard - Quick start... (Page 203).) 

C.1.3 Changing parameter settings using SIMATIC PDM 
SIMATIC PDM monitors the process values, alarms and status signals of the device. It allows 
you to display, compare, adjust, verify, and simulate process device data; also to set 
schedules for calibration and maintenance. 

Parameters in SIMATIC PDM are identified by name and organized into function groups, 
similar to the structure of the local display (HMI).  

Within SIMATIC PDM, parameters can be found in a structured view (which can be accessed 
when the device is offline), or in the PDM menus (when device is online): Device, View, 
Diagnostics.  

See: 

• Parameters via PDM structure view (Page 202) 

• Parameters and methods via PDM menus (Page 202) 

 

 Note 
• Clicking button "Cancel" during an upload from device to SIMATIC PDM will result in some 

parameters being updated. 
• While the device is in Edit view the output remains active and continues to respond to 

changes in the device. 
 

1. Launch SIMATIC PDM, connect to device, and upload data from device. 

2. Adjust parameter values in the parameter value field then press "Enter" key. The status fields 
read "Changed". 

3. Open the Device menu, click "Download to device...". When complete, use "File > Save" to 
save settings offline. The status fields are cleared. 
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C.1.4 Parameters via PDM structure view 
Many parameters accessible via SIMATIC PDM Structure view are also accessible via local 
operation. Others are accessible only via PDM.  

 

 Note 
Parameters accessible via HMI vs PDM 
• For details on parameters accessible via HMI see Parameter assignment - Local (Page 102). 
• For details on parameters accessible via PDM only see Parameter assignment - Remote 

(Page 142). 
 

If a parameter is not available in PDM Structure view, refer to the PDM menus: Parameters 
and methods via PDM menus (Page 202). 

 
① Structure view (offline table) 
② Value fields 

C.1.5 Parameters and methods via PDM menus 
Click on Device, View, or Diagnostics to open the associated PDM menu. 

 
① PDM menus 
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PDM menus 
 
Device View Diagnostics 
Download to device 
Upload to PC/PG 

Process values (Page 228) Update diagnostics 

Assign address and Tag... 
Value comparison... 
Object properties... 
Calibration log... 
Change Log... 

Start Life List... Diagnostics (Page 228) 
Device status (Page 229) 

Check configuration... 
Templates 

 Parameter change log 
(Page 229) 
Diagnostic log (Page 229) 
Trend log (Page 229) 

Set Address... 
HART communication 
Squawk 

  

Wizard - Quick start... (Page 203) 
Wizard - Auto false echo suppression 
(Page 204) 

  

Sensor offset wizard (Page 204) 
Auto sound velocity wizard (Page 205) 

  

DAC trim (Page 206)   
Simulation (Page 206) 
Loop test (Page 208) 

  

Scheduled maintenance (Page 208) 
Limit monitoring and event counter 
(Page 215) 
Trend log settings (Page 219) 
Echo profile utilities (Page 222) 

  

Security (Page 226)   
Reset (Page 227) 
Reset peak values (Page 227) 
Reset configuration flag (Page 228) 

  

Device restart (Page 228)   

C.1.5.1 Device menu 

Wizard - Quick start... 
Provides step-by-step procedure to set up common applications easily. 

A quick commissioning wizard is available in SIMATIC PDM. 

Launch PDM, open the menu "Device > Wizard - Quick start...", and follow the steps in the 
wizard. 
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 Note 
Update of process value on display when commissioning wizard run via EDD 

Process values shown in measurement view on local display will not automatically update to 
reflect a change made remotely via "Wizard - Quick start...". 
• To have device process values update when configured remotely, use local buttons to take 

device in and out of measurement view (i.e. go to parameter view then back to 
measurement view). 

 

Wizard - Auto false echo suppression 
Used to prevent false echo detection over a specified range. 

The Auto false echo suppression (AFES) wizard is available in SIMATIC PDM. 

Launch PDM, open the menu "Device > Wizard - Auto false echo suppression".  

Enter the auto false echo suppression range, then click "Apply" to run the wizard. 

Sensor offset wizard 
Used to calculate sensor offset, based on an actual measurement, to change the distance 
value. 

 

 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 

 

 

 Note 
Distance measurement used in calibration wizards is important 

To successfully calibrate using "Auto sound velocity wizard" and "Sensor offset wizard", the 
distance must be set correctly:  
• Wizards cannot be performed using the same distance for each 
• Distance set in "Auto sound velocity wizard" must be greater than distance set in the 

"Sensor offset wizard" 
• "Auto sound velocity wizard" must be performed outside of the short shot range (i.e. set 

distance greater than 1.0 meter). 
 

Via SIMATIC PDM, go to menu "Device > Sensor offset wizard". 

Enter value for the parameter "Sensor offset", then click "Apply" to run the wizard. 
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Auto sound velocity wizard 
Used to adjust the speed of sound, based on an actual measurement, to change the distance 
value. 

 

 Note 
Wizard operation requires high mA setting 

During wizard operation, the mA reading for device output will equal the setting for 
parameter "Upper fault current". When wizard completes, device output will return to normal 
behavior. 

 

 

 Note 
Distance measurement used in calibration wizards is important 

To successfully calibrate using "Auto sound velocity wizard" and "Sensor offset wizard", the 
distance must be set correctly:  
• Wizards cannot be performed using the same distance for each 
• Distance set in "Auto sound velocity wizard" must be greater than distance set in the 

"Sensor offset wizard" 
• "Auto sound velocity wizard" must be performed outside of the short shot range (i.e. set 

distance greater than 1.0 meter). 
 

Via SIMATIC PDM, go to menu "Device > Auto sound velocity wizard". 

Conditions for use of this feature: 

• The acoustic beam atmosphere is other than air 

• The acoustic temperature is unknown 

• The reading accuracy is acceptable at higher material levels only 

For best results, calibrate with the level at a known value near low calibration point. 

Using Auto sound velocity 

Start with a steady distance at a known high distance value (high distance value equates to a 
low level value). 

1. Review the distance measurement via local display for approximately 30 seconds to verify 
repeatability. 

2. Measure the actual distance (for example, with a tape measure). 

3. Enter the actual distance, defined in parameter "Units". 

Repeat this procedure if the atmosphere type, concentration, or temperature conditions are 
different from when the last sound velocity calibration was performed. 

The Auto sound velocity wizard can be found in PDM, in the menu "Device > Auto sound 
velocity wizard". 

Enter the actual distance measured, then click "Apply" to run the wizard. 
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DAC trim 
Used to calibrate the 4 mA and 20 mA end points of the analog output with an external 
reference (e.g. current measurement device). 

Open menu "Device > DAC trim". 

Connect the external device when prompted. Enter a new mA value and click button "Ok", or 
"Cancel" to exit without saving. 

Simulation 
Both process values and diagnostics can be simulated in SIMATIC PDM. For more details, see 
Simulation (Page 97). 

Process values 
Simulation of a process value is an iterative process whereby parameters are adjusted and 
corresponding results are displayed. 

Parameter assignment 

Simulation mode 
Displays status of simulation. 
 
Setting Disabled 

Enabled 
Ramp 

Default Disabled 

Set to "Enabled" to hold the simulation at a specific value. Set to "Ramp" to have the 
simulation continuously sweep through the measurement range. 

Simulation value 
Sets starting value for ramp or fixed simulation. 
 
Setting Not limited 
Default Not applicable 

PV status 
Sets status of the PV to simulate. 
 
Setting Good 

Bad 
Uncertain 

Default Good 
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Ramp end 
Sets end value for ramp simulation. 
 
Setting Not limited 
Default Not applicable 

Ramp steps 
Sets number of stair steps between ramp start (parameter "Simulation value") and end of 
ramp simulation. 
 
Setting 0 to 65535 
Default 10 

Ramp duration 
Sets total time from ramp start (parameter "Simulation value") to end of ramp simulation. 
 
Setting 0 to 65535 
Default 5 

Diagnostics 
Diagnostics can be simulated via SIMATIC PDM. 

For more information, see Simulation (Page 97). 

Parameter assignment 

Diagnostics 
Sets diagnostic from select list to simulate. 
 
Setting All available Device and HART status codes, and all process alarms and warn-

ings available to "Limit monitoring" function. 
Default Not applicable 

Action 
Enables/disables simulation for a specific diagnostic value. 
 
Setting On 

Off 
Default Not applicable 
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Loop test 
Provides step-by-step procedure to simulate the loop current. 

A loop test can be initiated via local operation (with any errors reported through diagnostic 
icons on the local display), or remotely, using an engineering system such as SIMATIC PDM. 

 

 Note 
Simulated current output 

The simulated current output value influences output to the control system. 
 

A simulated value can be set to test the functioning of the mA connections during 
commissioning or maintenance of the device. 
 
Setting 4.0 mA 

20.0 mA 
Other (set any mA value between 3.55 and 22.8) 
End 

Default 4.0 mA 

Select a preset mA value, or enter a custom value (under option "Other") to run the wizard. 
Select option "End" to stop the loop test. 

For more information, see mA control (Page 71). 

Scheduled maintenance 
Three sets of parameters allow you to monitor the Device lifetimes and set up Service and 
Calibration schedules, based on operating hours instead of a calendar-based schedule. See 
Device (Page 209), Service (Page 211), and Calibration (Page 213). 

The Scheduled maintenance feature is available through HART communications. This 
information can be integrated into an Asset Management system. For optimal use, we 
recommend that you use SIMATIC PCS7 Asset Management Software in conjunction with 
SIMATIC PDM. 

 

 Note 
Maintenance reminders 
• Any active maintenance reminders can be seen in "Diagnostics > Device status". 
• Click button Reset elapsed time to reset the elapsed time to zero, and clear any active 

diagnostic alarms. 
 

 Note 
Factory reset 

Performing a reset to factory defaults will reset all Scheduled maintenance parameters to 
their factory defaults. 
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Device 
The device tracks itself based on operating time and monitors its predicted life expectancy. 
Operating time can be modified, Elapsed time can be reset, and schedules can be set up for 
maintenance reminders. 

Via PDM: Go to menu "Device > Scheduled maintenance", and select the tab "Device 
maintenance". 

Parameter assignment 

Time units 
Sets units for maintenance parameters. 
 
Setting Years 

Days 
Hours 

Default Hours 

If time units are changed after device has been in operation, values for parameters 
"Operating time", "Maintenance required", and "Maintenance demanded" must also be 
adjusted to reflect the new time units. 

Operating time 
Shows Operating time of device since last power up. 

Can be modified after performing a service. If device Operating time is modified, Elapsed time 
and Remaining time will automatically recalculate. 
 
Setting Not limited 

Recommended setting: 87659 hours (10 years) 
Default 0 hours 

Elapsed time 
Displays elapsed time since timer was reset. Parameter "Monitoring" must be enabled. 

If value for parameter "Elapsed time" reaches limits set in parameters "Maintenance 
demanded" or "Maintenance required", a diagnostic message is generated. 

Remaining time 
Displays remaining hours of operation. 

Monitoring 
Sets operation mode for timer function. 
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The setting "Off" stops timer. When set to "Only timer on", elapsed time runs, but when 
thresholds are reached no diagnostic message is generated. 
 
Setting Off 

Only timer on 
Maintenance required 
Maintenance demanded 
Maintenance required and demanded 

Default Off 

1. First, set values in Maintenance required and/or Maintenance demanded. 

2. Set Monitoring to the desired option. 

Maintenance required 
Sets Maintenance required reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 86315 hours (9.846 years)  
(Default value for parameter "Operating time" less 8 weeks) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 

 

 Note 
Maintenance parameter settings  
• Parameter "Maintenance demanded" must always be set to a value higher than the value 

set for parameter "Maintenance required" 
• Both parameters "Maintenance demanded" and "Maintenance required" must be set, even 

if monitoring only "Maintenance required" 
 

Maintenance demanded 
Sets Maintenance demanded reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 87491 hours (9.981 years)  
(Default value for parameter "Operating time" less 1 week) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 
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Service 
The device tracks service intervals based on operating hours and monitors the predicted time 
until the next service. Service interval can be modified, Elapsed time can be reset, and 
schedules can be set up for maintenance reminders. 

Via PDM: Go to menu "Device > Scheduled maintenance", and select the tab "Service". 

Parameter assignment 

Time units 
Sets units for maintenance parameters. 
 
Setting Years 

Days 
Hours 

Default Hours 

If time units are changed after device has been in operation, values for parameters "Service 
interval", "Maintenance required", and "Maintenance demanded" must also be adjusted to 
reflect the new time units. 

Service interval 
Sets time between device inspections. 

Can be modified after performing a service. If Service interval is modified, Elapsed time and 
Remaining time will automatically recalculate. 
 
Setting Not limited 

Recommended setting: 8766 hours (1 year) 
Default 0 hours 

Elapsed time 
Displays elapsed time since timer was reset. Parameter "Monitoring" must be enabled. 

If value for parameter "Elapsed time" reaches limits set in parameters "Maintenance 
demanded" or "Maintenance required", a diagnostic message is generated. 

Remaining time 
Displays remaining hours of operation. 



Remote operation  
C.1 SIMATIC PDM 

 SITRANS Probe LU240 with mA/HART 

212 Operating Instructions, 03/2021, A5E42673511-AC 

Monitoring 
Sets operation mode for timer function. 

The setting "Off" stops timer. When set to "Only timer on", elapsed time runs, but when 
thresholds are reached no diagnostic message is generated. 
 
Setting Off 

Only timer on 
Maintenance required 
Maintenance demanded 
Maintenance required and demanded 

Default Off 

1. First, set values in Maintenance required and/or Maintenance demanded. 

2. Set Monitoring to the desired option. 

Maintenance required 
Sets Maintenance required reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 7422 hours (0.847 years)  
(Default value for parameter "Service interval" less 8 weeks) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 

 

 Note 
Maintenance parameter settings  
• Parameter "Maintenance demanded" must always be set to a value higher than the value 

set for parameter "Maintenance required" 
• Both parameters "Maintenance demanded" and "Maintenance required" must be set, even 

if monitoring only "Maintenance required" 
 

Maintenance demanded 
Sets Maintenance demanded reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 8598 hours (0.981 years)  
(Default value for parameter "Service interval" less 8 weeks) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 
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Calibration 
The device tracks calibration intervals based on operating hours and monitors the predicted 
time until the next calibration. Calibration interval can be modified, Elapsed time can be 
reset, and schedules can be set up for maintenance reminders. 

Via PDM: Go to menu "Device > Scheduled maintenance", and select the "Calibration" tab. 

Parameter assignment 

Time units 
Sets units for maintenance parameters. 
 
Setting Years 

Days 
Hours 

Default Hours 

If time units are changed after device has been in operation, values for parameters 
"Calibration interval", "Maintenance required", and "Maintenance demanded" must also be 
adjusted to reflect the new time units. 

Calibration interval 
Sets time between device calibrations. 

Can be modified after performing a calibration. If "Calibration interval" is modified, "Elapsed 
time" and "Remaining time" will automatically recalculate. 
 
Setting Not limited 

Recommended setting: 8766 hours (1 year) 
Default 0 hours 

Elapsed time 
Displays elapsed time since timer was reset. Parameter "Monitoring" must be enabled. 

If value for parameter "Elapsed time" reaches limits set in parameters "Maintenance 
demanded" or "Maintenance required", a diagnostic message is generated. 

Remaining time 
Displays remaining hours of operation. 
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Monitoring 
Sets operation mode for timer function. 

The setting "Off" stops timer. When set to "Only timer on", elapsed time runs, but when 
thresholds are reached no diagnostic message is generated. 
 
Setting Off 

Only timer on 
Maintenance required 
Maintenance demanded 
Maintenance required and demanded 

Default Off 

1. First, set values in Maintenance required and/or Maintenance demanded. 

2. Set Monitoring to the desired option. 

Maintenance required 
Sets Maintenance required reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 7422 hours (0.847 years)  
(Default value for parameter "Calibration interval" less 8 weeks) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 

 

 Note 
Maintenance parameter settings  
• Parameter "Maintenance demanded" must always be set to a value higher than the value 

set for parameter "Maintenance required" 
• Both parameters "Maintenance demanded" and "Maintenance required" must be set, even 

if monitoring only "Maintenance required" 
 

Maintenance demanded 
Sets Maintenance demanded reminder if Elapsed time is equal to or greater than this value. 
 
Setting Not limited 

Recommended setting: 8598 hours (0.981 years)  
(Default value for parameter "Calibration interval" less 1 week) 

Default 0 hours 

1. Modify values as required. 

2. Set Monitoring to the desired option. 
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Limit monitoring and event counter 
Used to monitor select process values, count associated events based on configured limits, 
and trigger, acknowledge, and reset process alarms and warnings. 

Configure variables for monitoring 

Configure one process value per Limit monitoring tab. Select the process value to monitor 
from the Monitored value drop-down list. Enter Upper limit, Lower limit, and Hysteresis 
values that will trigger an event. 

Limits 

Limits are assigned to each process value (Monitored value). The following limit parameters 
are available: 

• Upper limit 

• Lower limit 

• Hysteresis 

Hysteresis 

Hysteresis functions as follows: 
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A: Upper limit with Hysteresis 
An Overrun event is counted when the process value rises above the Upper limit (1). The next 
Overrun event is counted when the process value first falls below the Upper limit minus 
Hysteresis (2), then rises above the Upper limit (3).  
With Hysteresis enabled (non-zero value entered), two events will be counted within the 
timeframe depicted by 'A'.  

B: Lower limit with Hysteresis 
An Underrun event is counted when the process value falls below the Lower limit (1). The 
next Underrun event is counted when the process value first rises above the Lower limit plus 
Hysteresis (2), then falls below the Lower limit (3). 

C: Lower limit without Hysteresis 
An Underrun event is counted when the process value falls below the Lower limit (1). The 
next Underrun event is counted when the process value rises above the Lower limit (2) by 
any amount (as Hysteresis is set to zero), then falls below the Lower limit (2). 
With Hysteresis disabled (zero value entered), three events will be counted within the 
timeframe depicted by 'C'. 

D: Upper limit without Hysteresis 
An Overrun event is counted when the process value rises above the Upper limit (1). The next 
Overrun event is counted when the process value falls below the Upper limit (2) by any 
amount (as Hysteresis is set to zero), then rises above the Upper limit (2). 

Events and actions 

When the process value exceeds the Upper limit (Overrun) or falls below the Lower limit 
(Underrun), adjusting for any Hysteresis, an event is counted. 

Set a Threshold value for the number of Underrun and Overrun events that must occur for 
the selected Action to trigger. (Setting either threshold to a non-zero value will automatically 
set Limit monitoring to Enabled. Conversely, when Limit monitoring is set to Disabled, 
threshold values will be reset to zero.) 

The Action can be disabled, or set to trigger process alarms, or warnings such as Maintenance 
demanded and Maintenance required. Process alarms and warnings are displayed on the 
Device status dialogue in the engineering system, and on the device display as status 
symbols.  

Any alarms or warnings triggered prior to setting Action to Disabled will remain present until 
the event counter is reset. Disabling the Action means no new alarms or warnings will be 
triggered for the set limits, although the counter remains in operation. 

Actions and Fail-safe mode 

Process alarms can trigger fail-safe behavior on the signal output, whereas process warnings 
are only used as information, available through local operation and in the engineering 
system. Process values will bring the signal output to fail-safe mode if: 

- Specific fault (designed to put mA output into fail-safe mode) occurs. (See Fault codes and 
corrective actions (Page 158).) 

- Maintenance alarm occurs on a process value selected on the output. 
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Enable monitoring 

Once monitored variable is configured, ensure Limit monitoring is set to Enabled, and 
Transfer to device. Repeat steps on separate limit monitoring tab to monitor another process 
value. 

View and reset event counter 

If process alarms or warnings are triggered during device operation, return to this dialogue to 
Reset and acknowledge. The event counter is reset, and process alarms and warnings are 
acknowledged and cleared. 

 

Parameter assignment 

Limit monitoring 
Used to monitor select process values, count associated events based on configured limits, 
and trigger, acknowledge, and reset process alarms and warnings. 

 

 Note 
Number of monitored values 

In SITRANS LU240, up to three values can individually monitored. 
 

 

 
Setting Enabled 

Disabled 
Default Disabled 

Monitored value 
Sets process value to monitor. 
 
Setting Distance 

Space 
Level 
Volume 
Volume flow 
Custom 
Sensor temperature 

Default Limit monitoring 1 = Primary variable 
Limit monitoring 2 = Distance 
Limit monitoring 3 = Sensor temperature 
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Upper limit 
Sets Upper limit for a select process value being monitored. 
 
Setting -999999.0 to 999999.0 
Default 999999.0 

Lower limit 
Sets Lower limit for a select process value being monitored. 
 
Setting  -999999.0 to 999999.0 
Default -999999.0 

Hysteresis 
Sets difference between Upper Limit and Lower Limit for a select process value being 
monitored, that must occur before an Event is counted. 

The Action state (enabled/disabled) lags behind the measurement. If the measurement is 
larger than the limit, the configured Action is triggered. The Action is only cleared if the 
measurement falls below the limit minus the hysteresis. 
 
Setting -999999.0 to 999999.0 
Default Limit monitoring 1 = 0.25 m 

Limit monitoring 2 = 0.25 m 
Limit monitoring 3 = 5 °C 

Action 
Sets the diagnostic state reported when threshold is reached. For error (NE107) or 
maintenance alarm (PCS7), fault current is generated. 
 
Setting Disabled 

Process alarms 
Maintenance required 
Maintenance alarm 

Default Maintenance alarm 

Events 
Displays number of times the monitored value reaches the upper limit and/or the lower limit 
(overrun and/or underrun events). 
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Threshold 
Sets number of times the value passes the threshold before the diagnostic message 
configured in parameter "Action" is generated. 
 
Setting 0 to 65535 
Default 3 

Trend log settings 
The trend log can be configured in SIMATIC PDM, under menu "Device > Trend log settings". 

1. Enable logging by setting a number of values to log in parameter "Number of logging 
values". 

2. Enter the number of points to log in parameter "Number of logged points". 

3. Set the interval in seconds between log entries in parameter "Logging interval". 

4. Define the buffer behavior when log is full in parameter "Logging behavior". 

5. Set specific process value to log in parameters "Logging value 1", "Logging value 2", and 
"Logging value 3". 

6. Click "Transfer" button to write log settings to device. 

View the trend log under menu "Diagnostics > Trend log". 

Parameter assignment 

Number of logging values 
Sets number of process values to log. 
 
Setting Disabled 

1 
2 
3 

Default Disabled 

Number of logged points 
Sets number of data points to capture. 
 
Setting 10 to 2010 
Default 300 

A minimum of 10 points must be logged. The maximum number of points that can be logged 
is based on the number of inputs (parameters "Logging value 1", "Logging value 2", "Logging 
value 3"), i.e. 2010 points can be logged for one input, 1005 points for two inputs, and 670 
points for three inputs. 
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Logging interval 
Sets interval in seconds between log entries. 
 
Setting 10 to 600 
Default 60 

Logging behavior 
Defines behavior when log is full. 
 
Setting Overwrite oldest 

Fill and stop 
Default Overwrite oldest 

 

 

 Note 
Log entries not immediately visible using "Overwrite oldest" 

When setting "Overwrite oldest" is used, 30 log entries must be stored internally before any 
are visible in the Trend log. 

For example, to log Level and Sensor temperature every 10 minutes, it will take 2.5 hours for 
the first log entries to appear. 

 Number of logging values = 2 

 Logging interval = 600 

 Logging behavior = Overwrite oldest 

 Logging value 1 = Level 

 Logging value 2 = Sensor temperature 

The Trend log will appear empty until the first 30 entries (15 Level + 15 Sensor temperature) 
are stored internally, then written to the log: 
• A total of 30 log entries required, divided by the Number of logging values (2), stored at a 

Logging interval of 600 seconds (10 minutes) 
30/2 * 10 = 150 minutes or 2.5 hours 
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Logging value 1 
Sets value to log. 
 
Setting Distance 

Space 
Level 
Volume 
Volume flow 
Custom 
Loop current 
Sensor temperature 

Default Distance 

Logging value 2 
Sets value to log. 
 
Setting Distance 

Space 
Level 
Volume 
Volume flow 
Custom 
Loop current 
Sensor temperature 

Default Distance 

Logging value 3 
Sets value to log. 
 
Setting Distance 

Space 
Level 
Volume 
Volume flow 
Custom 
Loop current 
Sensor temperature 

Default Distance 
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Echo profile utilities 
Open the menu "Device > Echo profile utilities" and click on the appropriate tab for easy 
access to: 

• Echo profile (Page 222) 

• View saved echo profiles (Page 223) 

• Custom TVT breakpoints (Page 223) 

• Auto false echo suppression (Page 226) 

• Echo profile setup (Page 226) 

Echo profile 
1. In the Echo profile utilities window, click the "Echo profile" tab. 

2. Click "Measure" to update the profile. (The Initial profile graph is blank upon entry to dialog.) 

3. Use the Detailed resolution view of the echo profile for troubleshooting. For faster and 
more coarse views, the Standard resolution may be used. 

4. Edit the profile: 

– To see the X scale and data scale values, double click on each axis. 

– To zoom in to a section of the profile, left-click and drag a marquee around it. Right 
click inside the window to zoom out. 

– To expand or compress the x and/or y axes 

- Left-click the axis and drag in either direction to reposition the low end of the scale. 

- Right-click the axis and drag in either direction to reposition the high end of the scale. 

5. Click the "Save" button and in the new window, enter a name, and click "Yes". 

6. Click "OK" button to exit. (Do not click the "x" button to close the Echo profile utilities 
window, the profile will not be saved.) 

Parameter assignment 

Signal parameters 
For details on respective signal parameters, see Parameter assignment - Local (Page 102).  

Under the "Echo profile" tab, "Echo confidence" and "Signal strength" will display the 
corresponding parameter values, dependent on whether a short shot or long shot transmit 
pulse is used. (Refer to parameters: "Short shot confidence" / "Confidence", "Short shot echo 
signal strength" / "Echo signal strength".) 
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Logging interval 
Sets interval in minutes between echo profile log entries. 
 
Setting 0 to 60 
Default 10 minutes 

Number of profiles 
Sets number of echo profiles to store. 
 
Setting 1 to 60 
Default 5 

View saved echo profiles 

Echo profile storage 

You can store up to 60 profiles at a selected interval (maximum 60 minutes). Within the 
"Echo profile" tab, in the "Echo profile time based storage" window: 

• Enter the desired interval between stored profiles in parameter "Logging interval". 

• Enter the maximum number of profiles to be stored (maximum 60) in parameter "Number 
of profiles". 

• Click the "Start" button. A message appears warning of the time delay and warning that all 
previous saved profiles will be overwritten. Click the "OK" button to proceed. The new 
profiles will be saved with their date and time. 

Within menu "Echo profile utilities", click the tab "View saved echo profiles" to view the stored 
profiles. 

Custom TVT breakpoints 
 

 Note 

Double click on each axis to see the X scale and data scale values. Right-click or left-click on 
the axis and drag to reposition the scale. 

 

This feature allows you to manually adjust the TVT to avoid false echoes caused by 
obstructions. For an explanation see Auto false echo suppression (Page 226). 

Open the menu "Device > Echo profile utilities" and click the tab "Custom TVT breakpoints". 
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Before TVT adjusted 

 
① TVT 
② Echo profile 

 

 Note 
Profile display 

If a communication error exists, the profile will not display. 
 

• Initial profile graph is blank upon entry to dialog. Click the "Measure" button  to view and 
upload the current TVT from device. 

• Change the position of the cursor on the TVT using the "TVT Point +" and "TVT Point –" 
buttons: raise and lower the TVT using the "Offset +" and "Offset –" buttons. 

• Alternatively, enter values for "TVT Point" and "Offset" directly into the dialog boxes. 

• Click button "Download to device". 
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After TVT adjusted 

 
① TVT 
② Cursor 
③ Echo profile 

 

 Note 
Download to device 

If steps are repeated (measurement taken a second time) without first downloading shaping 
adjustments to the device, initial shaping will be lost. 

 

Parameter assignment 

Custom TVT shaper mode 
Sets operation mode of custom TVT shaper. 
 
Setting Enabled  

Disabled 
Default Disabled 

Breakpoint 1 to Breakpoint 40 
Sets TVT offset for breakpoint on TVT. Shaping points can be raised (positive number) or 
lowered (negative number). 
 
Setting Offset -50 to +50 dB 
Default 0 dB 
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Auto false echo suppression 
For detailed information about auto false echo suppression see Auto false echo suppression 
and Custom TVT (Page 182). 

For respective parameter details, see Parameter assignment - Local (Page 102). 

To use this feature in SIMATIC PDM: 

1. Ensure the material level is below all known obstructions. 

2. Determine the auto false echo suppression range by measuring the actual distance from the 
sensor reference point to the material surface using a rope or tape measure. Subtract 0.5 m 
(20") from this distance, and use the resulting value. 

3. Open the menu "Device > Echo profile utilities" and click the tab "Auto false echo 
suppression". 

4. Set parameter "Auto false echo suppression" to "Enabled". 

5. For parameter "Auto false echo suppression range", enter the value determined above. 

6. Click button "Wizard - Auto false echo suppression" to learn the TVT. The wizard dialogue will 
open. Click the button "Apply".  
Once the wizard completes successfully, parameter "Auto false echo suppression" is set to 
"Enabled" and the learned TVT will be used. 

7. Click button "Download to device". Click button "OK" to exit. 

 

Echo profile setup 
Provides quick access to allow configuration of echo processing related parameters. 

Open the menu "Device > Echo profile utilities" and click tab "Echo profile setup". 

For respective parameter details, see Parameter assignment - Local (Page 102). 

Security 
From the menu "Device > Security" in PDM, you can enable or disable the user PIN used to 
lock/unlock the device, change the existing user PIN, or set a new user PIN if the existing one 
is forgotten. 
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Enable/Disable user PIN 

The button "Enable user PIN"/"Disable user PIN" toggles between the two options, based on 
the current device setting. The device is shipped unlocked (user PIN disabled). 

• Click button "Enable user PIN" to lock the device. Message appears that the device is now 
write protected. 

• Click button "Disable user PIN" to unlock the device. If the default user PIN (factory setting) 
has not been changed (using "Change user PIN" wizard), enter the default PIN (2457) to 
unlock the device. 

Change user PIN 

Button appears when user PIN is disabled. 

Click button "Change user PIN". 

• Enter the existing user PIN. 

• Enter a new user PIN (0 to 65535), and repeat entry of new user PIN. 

Click button "OK". Message appears that new user PIN is set. 

Reset forgotten user PIN 

Button appears when user PIN is enabled. 

Click button "PIN recovery" if you have forgotten your user PIN. 

• A recovery ID and serial number will display. Make note of these entries and contact 
Siemens Technical Support. 

• You will be supplied with a PIN unlock key (PUK). 

• Enter the PUK on this dialogue 

Click button "OK". Message appears that new user PIN is set. 

Reset 
Open menu "Device > Reset" to access various restore/reset options: 

• Restore ordered configuration -  restores device to customer-ordered default settings 

• Restore to factory DAC calibration - restores DAC trim (digital-to-analog converter trim) to 
factory default settings 

• Factory reset - resets device to factory default settings. 

Click button "Yes" to continue with restore/reset, or click button "Abort" to cancel. 

After performing a "Factory reset", a complete re-programming is required.  

A "Restore to factory DAC calibration" is available only over remote operation. 

Reset peak values 
Resets all recorded Peak values. 
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Open menu Device > Reset peak values to reset recorded peak values to zero. Choose from 
various reset options: 

• Primary variable - reset minimum and maximum values for PV 

• Distance - reset minimum and maximum values for distance 

• Sensor temperature - reset minimum and maximum values for sensor temperature 

• Peak values - reset minimum and maximum values for PV, distance, and sensor 
temperature 

Click button "Ok" to continue with reset, or click button "Cancel" to exit without a reset. 

Reset configuration flag 
Open menu "Device > Reset configuration flag" to reset the configuration flag to zero. 

Device restart 
Open menu "Device > Device restart" to restart device without disconnecting power.  

Simulation will be terminated. Stored configurations are not reset. 

C.1.5.2 View menu 

Process values 
Open the menu "View > Process values" to view and compare outputs in real time, and view 
trend lines. 

• Click the "Overview" tab to see measurements (distance, level, loop current), device 
status, and data quality. 

• Click the "Dashboard" to display respective PV and SV measurements, range, loop current, 
and sensor temperature. (PV is set in parameter "PV selection". SV is set in parameter "SV 
selection".) 

• Click the "Trend" tab to view trend lines. Four trend lines can be monitored (distinguished 
by color in PDM). 

Trend 
Displays Trend line. 

C.1.5.3 Diagnostics menu 

Diagnostics 
Open the menu "Diagnostics > Diagnostics" to view communication status and device 
status. 
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Click the "Update diagnostics" button to update the diagnostic information and refresh the 
related status symbols. 

Device status 
Open the menu "Diagnostics > Device status" to view standard and device-specific status. 

Device "Operating time" is also shown. 

Parameter change log 
Open the menu "Diagnostics > Parameter change log" to view log of parameter changes 
made to device. 

Up to 100 entries can be logged with the oldest entry being overwritten when log becomes 
full. 

Click the "Read" button to update the log, then select the number of entries to read (10 to 
100). 

Diagnostic log 
Open the menu "Diagnostics > Diagnostic log" to view log of diagnostics events and when 
they occurred. 

Up to 250 entries can be logged with the oldest entry being overwritten when log becomes 
full. 

Click the "Read" button to update the log. 

Trend log 
Open the menu "Diagnostics > Trend log" to view trends. (The trend log must first be 
configured and enabled. See Trend log settings (Page 219).) 

The PV and SV (set in parameter "PV selection" and parameter "SV selection) are logged at a 
specified interval, and the trend log displays up to 670 data points since last device power up. 

The number of points already collected, and the start time are shown. (Click the "Reset" 
button to reset the log in the device.) 

Click the "Read" button to update the log. A dialogue appears on which you can set the 
number of points to read, the point density, and the start time to read. (An example setting 
for point density: if point density is set to 2, every second value will show.) 

When settings are complete, click the "Transfer" button. 

Trend lines can be viewed in menu "View > Process values", on the "Trend" tab. 
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C.2 AMS device manager 
 

 Note 
Requirement for remote operation 

Specific device versions (6 m, 12 m) support HART communication protocol required for 
remote operation. 

 

AMS Device Manager is a software package used to commission and maintain SITRANS Probe 
LU240 and other process devices. AMS Device Manager monitors the process values, alarms 
and status signals of the device. It allows you to display, compare, adjust, verify, and simulate 
process device data. Please consult the operating instructions or online help for details on 
using AMS Device Manager. (You can find more information at: Emerson 
(http://www.emersonprocess.com/AMS/)) 

AMS Device Manager features a Quick start wizard to easily configure the SITRANS Probe 
LU240. Other features include Echo profile viewing, Custom TVT setup, Process values 
monitoring, and Security. 

Parameters organized into three main function groups allow you to configure and monitor 
the device: 

• Configure/Setup 

• Device diagnostics (read only) 

• Process values (read only) 

The menu structure for AMS Device Manager is almost identical to that for SIMATIC PDM. 

Startup and configuration 

To start up the SITRANS ProbeLU240 using AMS Device Manager, you must first install the 
EDD (see below). You can then configure the device using the Quick start wizard in AMS.  

Electronic device description (EDD) 

SITRANS Probe LU240 requires the EDD for AMS Device Manager version 13.5. 

You can locate the EDD in Device Catalog, under "Sensors > Level > Echo > Siemens AG > 
SITRANS Probe LU240". Check the product page of our website: 

Product page (www.siemens.com/sitransprobelu240) 

Look under "Support > Software Downloads", to make sure you have the latest version of 
the EDD for AMS Device Manager. 

Configuring a new device 

1. Check that you have the most recent EDD, and if necessary download it from the product 
page listed above. 

2. Save the files to your computer, and extract the zipped file to an easily accessed location. 

3. Launch "AMS Device Manager – Add Device Type", browse to the unzipped EDD file, select 
and open it. 

http://www.emersonprocess.com/AMS/
http://www.siemens.com/sitransprobelu240
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4. Launch AMS Device Manager.  
(Application guides for setting up HART devices with AMS Device Manager can be 
downloaded from product page of our website.) 

5. In Device Connection View, right-click on the device icon and select Scan Device to upload 
parameters from the device. 

6. Double click the device icon to open the startup screen. The startup screen shows device 
identification details, and a navigation window on the left-hand side of the screen. 

7. Configure the device using the Quick start wizard. 

 

 Note 
Set units before running quick start wizard 
• With this engineering system, you must first set units in the "Quick start units" wizard 

before running the quick start wizard. 
• Set linear "Units", and if applicable set unit type that relates to your application. 

 

 

 Note 
Set linearization for custom application after running quick start wizard 
• With this engineering system, you must setup the "Customized characteristic curve" (from 

the "Custom" menu) after running the quick start wizard for a custom application.  
(If the "Custom" menu is not visible, ensure the wizard settings have been updated from 
the device.) 

 

C.3 Field Communicator (FC) 375/475 
 

 Note 
Requirement for remote operation 

Specific device versions (6 m, 12 m) support HART communication protocol required for 
remote operation. 

 

The FC375/FC475 HART Communicator is a handheld communication device that is easy to 
use, and provides universal support for other HART devices, such as SITRANS Probe LU240. 

The menu structure for FC375/FC475 is almost identical to that for AMS Device Manager. 

Startup and configuration 

In order to configure this HART device, just as with AMS, the configuration software requires 
the HART Electronic Device Description (EDD) for the instrument. Once the EDD is installed, 
you can configure the device using the Quick start wizard within FC375/475.  
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Electronic device description (EDD) 

You can locate the EDD in Device Catalog, under "Sensors > Level > Echo > Siemens AG > 
SITRANS Probe LU240". Check the product page of our website: 

Product page (www.siemens.com/sitransprobelu240) 

Look under "Support > Software Downloads", to make sure you have the latest version of 
the EDD for FC375/FC475. 

Configuring a new device 

1. Check that you have the most recent EDD, and if necessary download it from the product 
page listed above. 

2. Save the files to your computer, and extract the zipped file to an easily accessed location. 

3. To install the EDD, run Emerson’s Field Communicator Easy Upgrade Utility. 

4. Configure the device using the Quick start wizard. 

 

 Note 
Set units before running quick start wizard 
• With this engineering system, you must first set units in the "Quick start units" wizard 

before running the quick start wizard. 
• Set linear "Units", and if applicable set unit type that relates to your application. 

 

 

 Note 
Set linearization for custom application after running quick start wizard 
• With this engineering system, you must setup the "Customized characteristic curve" (from 

the "Custom" menu) after running the quick start wizard for a custom application.  
(If the "Custom" menu is not visible, ensure the wizard settings have been updated from 
the device.) 

 

C.4 FDT (Field Device Tool) 
 

 Note 
Requirement for remote operation 

Specific device versions (6 m, 12 m) support HART communication protocol required for 
remote operation. 

 

FDT is a standard used in several software packages designed to commission and maintain 
field devices. Two commercially available FDTs are PACTware and Fieldcare. 

http://www.siemens.com/sitransprobelu240
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FDT is very similar to PDM: 

• To configure a field device via FDT, you need the DTM (Device Type Manager) for the 
device. 

• To configure a field device via SIMATIC PDM, you need the EDD (Electronic Data 
Description) for the device. 

Startup and configuration 

To start up the device using an FDT, you must first install the DTM (see below). You can then 
configure the device using the parameters available with the FDT. 

 

 Note 
Set linearization for custom application after running quick start wizard 
• With this engineering system, you must setup the "Customized characteristic curve" (from 

the "Custom" menu) after running the quick start wizard for a custom application.  
(If the "Custom" menu is not visible, ensure the wizard settings have been updated from 
the device.) 

 

Device Type Manager (DTM) 

A DTM is a type of software that plugs into FDT. It contains the same information as an EDD 
but an EDD is independent of the operating system. 

SITRANS DTM 

• SITRANS DTM is an EDDL interpreter developed by Siemens to interpret the EDD for that 
device. 

• To use SITRANS DTM to connect to a device, you must first install SITRANS DTM on your 
system and then install the device EDD written for SITRANS DTM. 

• You can download SITRANS DTM from our website. Go to website 
(http://www.siemens.com/sitransdtm) and click "Support > Software downloads". 

Electronic Device Description (EDD) 

The device HART EDD for SITRANS DTM can be downloaded from the product page of our 
website. Go to Product page (www.siemens.com/sitransprobelu240) and click "Support > 
Software downloads".  

Configuring a new device  

The full process to configure a field device via FDT is outlined in an application guide for 
SITRANS DTM, which can be downloaded from the product page of our website. Go to 
Product page (www.siemens.com/sitransprobelu240) and click "Support > Application 
guides". 

http://www.siemens.com/sitransdtm
http://www.siemens.com/sitransprobelu240
http://www.siemens.com/sitransprobelu240
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C.5 Bluetooth 

C.5.1 Connecting field device and SITRANS AW050 Bluetooth adapter 
Connect the blue cable to the display. 

Connect the red cable to the device. 

 
① Connector 
② Red 
③ Blue 
④ To SITRANS Probe LU240 display 
⑤ To SITRANS Probe LU240 electronics 

The cables are best run separately inside the enclosure as shown in the figure following. Care 
must be taken when installing the display to be sure that the ribbon cables are not pinched or 
torn. Excessive force should not be necessary for installation of the display mounting. 
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① To display 

Use of the display while the AW050 is installed 

When power is applied to the device, the display will activate for approximately 15 seconds, 
and then deactivate for 5 seconds as the AW050 integrates.  

When the AW050 connection is made through SITRANS mobile IQ, the display will not be 
accessible. When the AW050 Bluetooth connection is severed, the display will activate again.  

 

 Note 

Connecting a SITRANS LU240 display after a connected and functioning AW050 will require a 
power cycle of the LU240 for the display to function properly.  

 

C.5.2 Connecting field device with SITRANS mobile IQ App 
SITRANS mobile IQ is an app for mobile devices that enables authorized service technicians to 
monitor and configure compatible field instrumentation over a Bluetooth interface. You can 
find information and the app for download at: Mobile app "Industry Online Support" 
(https://support.industry.siemens.com/cs/ww/en/sc/2067) 

https://support.industry.siemens.com/cs/ww/en/sc/2067
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Requirements for establishing the first connection 
1. Field device is in operation. 

2. There is a line of sight to the field device. 

3. You are less than 10 meters away from the field device. 

4. LED on the SITRANS AW050 Bluetooth adapter flashes every 2 seconds. 

Requirements for connection setup 
1. Android: "Location" access is enabled in the mobile device. 

2. SITRANS mobile IQ is authorized to acces the location. 

Procedure 
 

 NOTICE 
Unauthorized access 

It is your responsibility to prevent unauthorized access to the field device. 
 

1. Start the SITRANS mobile IQ app. 

The smartphone or tablet automatically searches for Bluetooth field devices in the vicinity. 
The field devices found are listed. Select the desired field device in the device list. 

2. Enter the delivery password "Sitrans AW050!". The delivery password has to be changed for 
first connection setup. 

3. Assign a new password. 

– Before assigning a password, make sure that no 2 field devices with the same serial 
number are displayed in the selection list. 

– Assign a new password that is not the same as the default password. The new 
password must consist of at least 12 characters. 

– If the mobile end device, e. g. Smartphone or tablet, has access protection, the 
SITRANS mobile IQ automatically saves the passwords of connected field devices. You 
can delete individual, stored device passwords in the app. 

When the connection is established, the LED on the SITRANS AW050 Bluetooth adapter 
flashes every second. 
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C.5.3 Reset Password 

Reset password 
1. Select "Reset password". 

2. Once you have selected "Reset password", disconnect the ribbon cable between the 
SITRANS AW050 and the device within 60 seconds. 

3. Wait for 30 seconds. 

4. Insert the ribbon cable again. 

The password is reset to the default password. 

C.5.4 Technical data: SITRANS mobile IQ 
 

Software requirements  
Required Android version 7.0 or higher 
Required iOS version 12.0 or higher 
Bluetooth BLE 4.2 or higher 

C.5.5 Technical data: SITRANS AW050 Bluetooth adapter 
 

Operating conditions and structural design  
Ambient conditions For use indoors and outdoors. 
Ambient temperature Observe the maximum permissible ambient temperature 

of the connected field device. 

• Permissible ambient temperature for operation -40 ... +80 °C (-40 ... +176 °F) 

• Relative humidity 0 ... 100% 

Degree of pollution 2 
Overvoltage category II 
Weight  

• With cable gland 24 g 

• Without cable gland 13 g 

Degree of protection • Type 4X, Type 6 in accordance with UL 50E 
• IP66, IP68 in accordance with IEC 60529 

EMC EN 61326 
Input voltage range 2.2 ... 3.4 V DC 
Maximum current consumption 2.5 mA 
Material Polycarbonate 
Torque for cable gland 10 Nm (7.38 ft lb) 
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Operating conditions and structural design  
Communication, interface Bluetooth 4.2 
Range Class 2; approx. 10 m 
Radio approvals Contains FCC ID: RYYEYSHJN 

Contains IC ID: 4389B-EYSHJN 
CMIIT ID: 2020DJ15120ens 

C.5.6 Dimensions SITRANS AW050 Bluetooth adapter 7MP3210-0AA00 

 

Figure C-1 Dimension drawing SITRANS AW050 Bluetooth adapter, dimensions in mm (inch) 

C.5.7 Information for radio approval FCC and IC 

Canada Regulatory Information 
1. This device complies with Industry Canada’s applicable licence-exempt RSSs. Operation is 

subject to the following two conditions:  
(1) This device may not cause interference; and  
(2) This device must accept any interference, including interference that may cause 
undesired operation of thedevice. 

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils 
radio exempts de licence.L’exploitation est autorisée aux deux conditions suivantes :  
(1) l’appareil ne doit pas produire de brouillage;  
(2) l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le 
brouillage est susceptibled’en compromettre le fonctionnement. 

2. This product is certified as type of the portable device with Industry Canada Rules. To 
maintain compliance with RF Exposure requirement, please use within specification of this 
product. 

Ce produit est certifié comme type de l'appareil portable avec Industrie Règles de Canada. 
Pour maintenir l'acquiescement avec exigence Expositionde RF, veuillez utiliser dans 
spécification de ce produit. -IC: 4389B-EYSHJN 

3. Please notify certified ID by either one of the following method on your product.  
-Contains IC: 4389B-EYSHJN 

Specifiez ID certifiée dans votre produit par une de méthode suivante.  
-Contains IC: 4389B-EYSHJN 
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FCC Regulatory Information 
1. This device complies with part 15 of the FCC Rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation. 

2. Please notify certified ID by either one of the following methods on your product.  
-Contains Transmitter Module FCC ID: RYYEYSHJN  
-Contains FCC ID: RYYEYSHJN 

3. CAUTION: Changes or modifications not expressly approved by the party responsible for 
compliance could void the use’s authority to operate the equipment. 

4. This product is certified as type of the portable device with FCC Rules. To maintain 
compliance with RF Exposure requirement, please use within specification of this product. 

5. The antenna used for this transmitter must not be co-located or operating in conjunction 
with any other antenna or transmitter. 

6. This module can change the output power depending on the circumstances by the 
application software which is developed by module installer. Any end user cannot change 
the output power. 
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 Product documentation and support D 
D.1 Product documentation 

Process instrumentation product documentation is available in the following formats:  

• Certificates (http://www.siemens.com/processinstrumentation/certificates)   

• Downloads (firmware, EDDs, software) 
(http://www.siemens.com/processinstrumentation/downloads)  

• Catalog and catalog sheets (http://www.siemens.com/processinstrumentation/catalogs)  

• Manuals (http://www.siemens.com/processinstrumentation/documentation)  

You have the option to show, open, save, or configure the manual. 

– "Display": Open the manual in HTML5 format 

– "Configure": Register and configure the documentation specific to your plant 

– "Download": Open or save the manual in PDF format 

– "Download as html5, only PC": Open or save the manual in the HTML5 view on your PC 

You can also find manuals with the Mobile app at Industry Online Support 
(https://support.industry.siemens.com/cs/ww/en/sc/2067). Download the app to your mobile 
device and scan the device QR code. 

Product documentation by serial number 
Using the PIA Life Cycle Portal, you can access the serial number-specific product information 
including technical specifications, spare parts, calibration data, or factory certificates. 

Entering a serial number 

1. Open the PIA Life Cycle Portal (https://www.pia-portal.automation.siemens.com). 

2. Select the desired language. 

3. Enter the serial number of your device. The product documentation relevant for your device 
is displayed and can be downloaded. 

To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register. 

Scanning a QR code 

1. Scan the QR code on your device with a mobile device. 

2. Click "PIA Portal". 

To display factory certificates, if available, log in to the PIA Life Cycle Portal using your login 
or register. 

http://www.siemens.com/processinstrumentation/certificates
http://www.siemens.com/processinstrumentation/downloads
http://www.siemens.com/processinstrumentation/catalogs
http://www.siemens.com/processinstrumentation/documentation
https://support.industry.siemens.com/cs/ww/en/sc/2067
https://www.pia-portal.automation.siemens.com/
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D.2 Technical Support 

Technical support 
If this documentation does not completely answer your technical questions, you can enter a 
Support Request (http://www.siemens.com/automation/support-request).  

Additional information on our technical support can be found at Technical Support 
(http://www.siemens.com/automation/csi/service).   

Service & support on the Internet  
In addition to our technical support, Siemens offers comprehensive online services at Service 
& Support (http://www.siemens.com/automation/service&support). 

Contact  
If you have further questions about the device, contact your local Siemens representative at 
Personal Contact (http://www.automation.siemens.com/partner). 

To find the contact for your product, go to "all products and branches" and select "Products & 
Services > Industrial automation > Process instrumentation". 

Contact address for business unit:  
Siemens AG 
Digital Industries 
Process Automation 
Östliche Rheinbrückenstr. 50  
76187 Karlsruhe, Germany 

See also 
Video for Support Request (www.siemens.com/opensr) 

D.3 QR code label 
A QR code label can be found on the device. With the use of a smart phone, the QR code 
provides a direct link to a website with information specific to the device, such as manuals, 
FAQs, certificates, etc. 

Example QR code 

The QR code that follows is an example only. The QR code found on your device is unique to 
that device and serial number. 

 

http://www.siemens.com/automation/support-request
http://www.siemens.com/automation/csi/service
http://www.siemens.com/automation/service&support
http://www.automation.siemens.com/partner
http://www.siemens.com/opensr
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 HMI menu structure E 
 

 
 

 Note 
Three-level menu structure  

For the purpose of documenting, items in the following menu structure are not exactly as 
they appear on the device.  
• Parameter IDs are a combination of menu number and parameter number, shown in 

separate fields on the device. See example below. 
• Menus begin with letter "M" 
• Wizards begin with letter "W" 
• Menu levels are separated by a dash ( - ) 
• Parameter numbers include their respective menu number, and the specific parameter 

number is prefixed by a period ( . ) 
 

 
① + ② 02-01.01 = Parameter "PV SELECT" (showing current setting of "LEVEL"): 

 - the first parameter (.01), in the first menu "SELECT OUT" (-01),  
under the second top-level menu "SETUP" (02) 
 
M 02 SETUP 
 M 02-01 SELECT OUT 
 02-01.01 PV SELECT 

 

 Note 
Show menu numbers on local display 

To view menu numbers on the device, parameter "Service view" must be enabled. (Go to 
menu "Setup > Local display".) 
• The item number of the current selection appears in the info field. 
• The menu number in which the current selection resides, appears on the title line (thus 

no menu numbers appear for top-level menu items, such as "QUICK START", "SETUP", etc.). 

Refer to full device menu that follows. 
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 Note 
Parameter visibility on device 

All available device menus and parameters are included in the following HMI menu structure, 
each with its own identifying number. The menu/parameter number shown in the HMI menu 
structure will match the menu/parameter number that appears on the device. However, note 
that some menus and parameters are only visible on the device based on configuration 
settings and ordered option. 
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 Abbreviations F 
 

 
 
Short form Long form Description Units 
3-A 3-A Sanitary Standards, Inc.   
AFES Auto False Echo Suppression   
BS-3680 Flow standards from the British Stand-

ards Institute 
  

CE / FM / CSA Conformité Européene / Factory Mutual 
/ Canadian Standards Association 

safety approval  

Ci Internal capacitance  F 
DAC Digital to Analog Conversion   
dB Decibel  dB 
DCS Distributed Control System control room apparatus  
DC Direct current   
dK dielectric constant   
DTM device type manager   
EDD Electronic Device Description   
EMC Electromagnetic compatibility   
FDT Field Device Tool   
HART Highway Addressable Remote Trans-

ducer 
  

HFC HART Communication Foundation   
Hz Hertz  Hz 
Ii Input current   mA 
Io Output current  mA 
IS Intrinsically Safe safety approval  
Li Internal inductance  mH 
LOE loss of echo   
mH milliHenry 10-3 H 
μF microFarad 10-6 F 
μs microsecond 10-6 s 
NE NAMUR "Empfehlung" (recommenda-

tion) 
  

NPS Nominal Pipe Size   
OCM Open channel monitoring   
(SIMATIC) PDM Process device manager   
pF pico Farads 10-12 F 
PLC Programmable logic controller   
PMD Primary measuring device   
ppm parts per million   
PV Primary Variable measured value  
PVDF Polyvinylidene fluoride   
SCADA Supervisory Control and Data Acquisi-

tion 
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Short form Long form Description Units 
SV Secondary Variable equivalent value  
TVT Time Varying Threshold sensitivity threshold  
TFM1600 PTFE  Modified PTFE  polytetrafluoroethylene 

with perfluoropropyl 
vinyl ether (PPVE) modi-
fier 

 

Ui Input voltage  V 
Uo Output voltage  V 



 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 248 

Glossary  
 

accuracy 
degree of conformity of a measure to a standard or a true value. 

acoustic noise 
any undesired audible sound. 

agitator 
mechanical apparatus for mixing or aerating. A device for creating turbulence. 

algorithm 
a prescribed set of well-defined rules or processes for the solution of a problem in a finite 
number of steps. 

ambient temperature 
the temperature of the surrounding air that comes in contact with the enclosure of the 
device. 

Auto false echo suppression 
a technique used to adjust the level of a TVT curve to avoid the reading of false echoes. 

Auto false echo suppression range 
defines the end point of the TVT distance. This is used in conjunction with auto false echo 
suppression. 

beam angle 
the angle diametrically subtended by the one-half power limits (-3 dB) of the sound beam. 

beam spreading 
the divergence of a beam as it travels through a medium. 
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blanking 
a blind zone extending away from the reference point. The device is programmed to ignore 
this zone. 

confidence 
describes the quality of an echo. Higher values represent higher quality. Confidence 
threshold defines the minimum value. 

damping 
term applied to the performance of a device to denote the manner in which the 
measurement settles to its steady indication after a change in the value of the level. 

decibel (dB) 
a unit used to measure the amplitude of signals. 

dielectric 
a nonconductor of direct electric current. 

display cable connector 
male four-pin connector within wiring compartment used to connect display cable. 

echo 
a signal that has been reflected with sufficient magnitude and delay to be perceived in some 
manner as a signal distinct from that directly transmitted. Echoes are frequently measured in 
decibels relative to the directly transmitted signal. 

echo confidence 
the recognition of the validity of the echo. A measure of echo reliability. 

echo lock window 
a window centered on an echo in order to locate and display the echo’s position and true 
reading. Echoes outside the window are not immediately processed. 

echo marker 
a marker that points to the processed echo. 
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echo processing 
the process by which the device determines echoes. 

echo profile 
a graphical display of a processed echo. 

echo strength 
describes the strength of the selected echo in dB referred to 1 μV rms. 

electrical noise 
unwanted electrical signals that produce undesirable effects in the circuits of the control 
systems in which they occur. 

false echo 
any echo which is not the echo from the desired target. Generally, false echoes are created 
by vessel obstructions. 

far range 
the distance below the zero percent or empty point in a vessel. 

frequency 
the number of periods occurring per unit time. Frequency may be stated in cycles per second. 

HART 
Highway Addressable Remote Transducer. An open communication protocol used to address 
field devices. 

Hertz (Hz) 
unit of frequency, one cycle per second. 1 Gigahertz (GHz) is equal to 109 Hz. 

inductance 
the property of an electric circuit by virtue of which a varying current induces an 
electromotive force in that circuit or in a neighboring circuit. The unit is a Henry. 

multiple echoes 
secondary echoes that appear as double, triple, or quadruple echoes in the distance from the 
target echo. 



 Glossary 
 

SITRANS Probe LU240 with mA/HART 

Operating Instructions, 03/2021, A5E42673511-AC 251 

near blanking 
see Blanking 

nozzle 
a length of pipe mounted onto a vessel that supports the flange. 

parameters 
in programming, variables that are given constant values for specific purposes or processes. 

pulse 
a wave that departs from an initial level for a limited duration of time, and returns to the 
initial level. 

range 
distance between a transducer and a target. 

repeatability 
the closeness of agreement among repeated measurements of the same variable under the 
same conditions. 

shot 
one transmit pulse or measurement. 

speed of sound 
the speed at which sound is propagated through some medium under specified conditions. 

TVT (time varying threshold) 
a time-varying curve that determines the threshold level above which echoes are determined 
to be valid. 

ultrasonic 
having a frequency above the human ear’s audibility limit: about 20,000 hertz. 
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 Index  
 

A 
Abbreviations and identifications list, 246 
Algorithm, 181 
Application example 

level, 66 
volume flow, 67 

Approvals, 32 
specifications, 176 

Auto false echo suppression, 182 
disabled, 134, 183 
range, 182 

Auto False Echo Suppression 
TVT Shaper adjustment, 223 
via PDM, 222 

B 
Breakpoints 

level, 188 
volume, 188 
volume flow, 189 

C 
Catalog 

catalog sheets, 240 
Certificates, 17, 240 
Cleaning, 150 
Communication protocol 

HART communication foundation, 196 
HART electronic device description, 196 

conduits 
requirements, 29 

Configuration 
HART modem, 22 

Custom TVT shaper mode 
manual adjustment via PDM, 224 

Customer Support, (Refer to Technical support) 

D 
Damping, 185 
Data logging 

time-based echo profile storage, 223 

Device Description (DD) 
see EDD, 200 

Dimensions 
drawing, 177 
optional flange adaptor, 178 

Disassembly, 28 
Disposal, 154, 154 
Document history, 12 
Downloads, 240 

E 
Echo processing, 180 
Echo profile 

data logging, 223 
quick access via PDM, 226 
view via PDM, 222 

Echo profile utilities 
auto false echo suppression, 226 
custom TVT breakpoints, 223 

Electronic Device Description (EDD), 199 
required for PROFIBUS PA, 200 
updating, 200 

F 
Fail-safe, 187 
Firmware revision, 36 
Flange adaptor, 178 
Flume 

cut throat, 80 
examples, 94 
Khafagi Venturi, 81 
Leopold Lagco, 79 
Parshall, 78 
rectangular, 82 
trapezoidal, 84 
U-flume, 85 

H 
HART communication foundation 

downloading the electronic device description 
(EDD), 196 

HART modem 
system configuration, 22 
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Hazardous area 
Laws and directives, 17 
Laws and directives for Korea, 17 
Qualified personnel, 19 

hazardous area installations device nameplate, 32 
HMI 

activating, 36 
menu structure, 242 
operating the display, 36 

Hotline, (Refer to Support request) 

I 
Icons, (see Symbol), (see Symbol) 
Identifications and abbreviations 

list, 246 

L 
Laws and directives, 17 
Loss of echo, 187 

M 
Maintenance, 149 

device information symbols, 158 
device status symbols, 156 
via SIMATIC PDM, 208 

Manuals, 240 
Material adapter 

Technical data, 237 
Mechanical construction 

Technical data, 237 
Modifications 

correct usage, 17 
improper, 17 

N 
Near range (blanking), 184 

O 
Open channel monitoring (OCM) 
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Operating conditions, 175 
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current output, 186 
specifications, 174 
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Password 

Reset, 237 
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specification, 172 
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Restart, 137 
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S 
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Service, 241 
Service and support 

Internet, 241 
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